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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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https://community.oracle.com/customerconnect/categories/idealab-guidelines
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1  Overview

Overview of Transactional Business Intelligence  
You use Oracle Transactional Business Intelligence (OTBI) to analyze your business and take action with embedded and
ad-hoc analysis of your transactional data.

Key metrics and attributes of your business and organization are organized into subject areas of data you use as
building blocks to answer your business questions.

• Use embedded analyses and reports to gain insights and report on key business metrics

• Build ad-hoc analyses, reports, and dashboards.

• Create catalog folders and define who has access to what in the catalog.

• Organize your analytics in dashboards and embed them in your work areas.

Architecture
OTBI integrates with Application Development Framework (ADF) to run your real-time analysis of your business subject
areas.

The BI Server creates physical queries based on metadata mappings between the subject areas you work with in your
analysis and ADF view objects and their underlying database tables. The Presentation Server compiles and formats the
results in the client or as embedded analytics.

Here's the OTBI architecture. 
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BI Objects and Tools
Here are some of the components and the objects they support.

Catalog Object Description Component or Tool

Analysis
 

Analyses are a selection of data displayed in
one or more views, such as a table or chart, to
provide answers to business questions.
 

Analytics Answers
 

Dashboard
 

Dashboards organize analytical content
and catalog objects, and present them in a
meaningful way.
 

Dashboard Builder
 

Dashboard Prompt
 

Dashboard prompts allow users to filter
dashboard content by selecting from provided
values.
 

Analytics Answers and Dashboard Builder
 

Filter
 

Filters limit the results that are displayed when
an analysis is run.
 

Analytics Publisher
 

Agent
 

Agents deliver scheduled analytics and other
content and notifications.
 

Delivers
 

Report
 

Reports present data in pixel-perfect printable
format for distribution.
 

Analytics Publisher
 

Data Model
 

Data models define the data source for reports.
 

Analytics Publisher
 

Subtemplate
 

Subtemplates are reusable formatting
definitions for reports.
 

RTF or XSL editor
 

Note:  You can't change privileges for the components, for example by changing which roles are assigned to access
Dashboards or Analytics Publisher. Any changes made to privileges in the Administration Manage Privileges page
aren't preserved during any upgrade.

The catalog stores the objects in a folder structure of individual files, organized hierarchically by product family.

• Shared folders (parent)

• Product family, for example, Financials

• Product, for example, Payables

• Report groups, for example, Invoices

• Dashboard reports

• Data models

• Report components

• Analytics Publisher reports

2
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• Prompts

Some Oracle Transactional Business Intelligence components aren't available in Oracle Applications Cloud:

• BI Server: Processes user requests and queries in underlying data sources.

• Catalog Manager: Manages catalog and objects.

• Administration Tool: Manages metadata repository that defines the logical structure and physical data sources
for analytic subject areas.

Related Topics
• More About Oracle Transactional Business Intelligence Components

More About Oracle Transactional Business Intelligence
Components  
If you want to know more about Oracle Transactional Business Intelligence components, here's what we have.

Oracle Transactional Business Intelligence
Here's the information about the parts of Oracle Transactional Business Intelligence (OTBI) that support analysis against
your transactional data.

• Create and work with analyses, dashboards, and advanced analytical content, including dashboard prompts,
conditions, actions, and key performance indicators.

Creating Analyses and Dashboards in Oracle Transactional Business Intelligence

• Administer analyses, dashboards, and other content.

Administering Oracle Transactional Business Intelligence

Oracle Analytics Publisher
Analytics Publisher is the part of OTBI you use for reports.

• Run and view reports.

Using Oracle Analytics Publisher in Oracle Transactional Business Intelligence

• Create and edit reports, data models, layouts, templates, subtemplates.

Designing Pixel-Perfect Reports in Oracle Transactional Business Intelligence

• Administer Analytics Publisher, set up data sources and delivery destinations, manage security, and move
catalog objects.

Administering Oracle Analytics Publisher in Oracle Transactional Business Intelligence

3
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View Analytics, Reports, and Dashboards  

Watch video
 

There are different ways to view and work with your analytics and reports. You can view analyses, dashboards, and
reports in the course of your work, on your usual pages and infolets. Or you can find them in the business intelligence
catalog with the Reports and Analytics work area and the Reports and Analytics panel tab.

View Analytics in Infolets
Use your favorite infolet pages to find analytics.

1. Use the page controls and Previous and Next icons to explore infolet pages in the home page, where they may
appear in infolets with summaries and aggregations or performance metrics. You may also find infolets in some
work areas.

2. Click an infolet to open a detailed analysis. So for example, if an infolet has transactions summed to a total, click
it to view details of the underlying transactions.

3. Click Done.

View Objects in Familiar Work Areas and Pages
Use analyses, dashboards, and reports available in your usual pages and work areas.

1. Explore your pages. Some may include analysis and report links or embedded objects, sometimes in tabs or
panel tabs.

2. Some work areas have a Reports and Analytics panel tab, where you explore catalog folders for relevant
analyses and reports for the work area. And if you have permission, you can map more objects to the work area
if they're appropriate.

a. Open the panel tab.
b. Expand the Shared Reports and Analytics folder and explore the available content.
c. Click the link for any object and see its type to determine whether it's an analysis, a report, or a

dashboard.
d. Click View to open the object.

View Objects in the Reports and Analytics Work Area
Use the Reports and Analytics work area to search or browse the catalog and view any analysis, dashboard, or report
you have access to. It opens at the highest level of the catalog's folder hierarchy with all objects you have marked as
favorites.

Here are some things you can do in the Reports and Analytics work area.

1. Click Navigator > Tools > Reports and Analytics.

4
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2. Filter and search for objects:

a. From the Filter list, select what you want to find.
b. To view objects you have marked as favorites, select Favorites in the list. Or select Recent Items to view

objects you recently worked with, or a recent search to run it again. Enter a name or part of a name and
click the Search icon.

c. In the search results, use the icons to identify what the objects are.
d. Click the name of an object to open it, or click More and select an action.

3. In the breadcrumbs, browse the catalog folders for analytics and reports. Click any Hierarchical Selector icon
to select a different node for the next level in the hierarchy.

4. Mark objects as favorites.

◦ Select Favorites in the Saved Searches to display your favorite objects.

◦ Click the Add Favorites icon for an object to mark it as a favorite.

◦ Click the Remove from Favorites icon to remove an object from your favorites.

5. Create and edit analyses and reports.

a. Click Create and select Report or Analysis.
b. Use wizards to create your analysis or report.

6. Click the Browse Catalog button (or click the More icon for a specific report, dashboard, or analysis) to use
more features.

Note:  If you don't see an analysis in the work area, browse the catalog for it. In the Catalog, select Show
Hidden Items to display any hidden analyses.

View Analyses
An analysis queries against your company's data and answers business questions with visualizations, such as charts
and tables. They may appear on your pages, or as parts of a dashboard.

1. From the catalog folders or search results, open an analysis to view.
2. Click Refresh to rerun the analysis and refresh its data.
3. Click Print and select either Printable PDF or Printable HTML to open a printable version.
4. Click Export to get analysis data in various formats, for example PDF, Excel, PowerPoint, comma-separated

value (CSV), and XML.

Note:  When you export data in a CSV format, dates are exported in raw format and converted to UTC time
zone.

View Grouped Analyses in Dashboards
Some analyses are grouped in dashboards to give you meaningful related information. A dashboard contains pages of
analyses, prompts that filter information, and other objects.

1. From the catalog folders or search results, open a dashboard to view.
2. Select values for any dashboard prompts to filter the dashboard.
3. Click Apply to refine the results of all of the analyses in the dashboard.

5
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View Reports
Reports show data in a predefined format that's optimized for printing.

1. From the catalog folders or search results, open a report.
2. Click the View Report icon if you want a different format.

◦ Choose HTML or PDF to display the report in a format for printing. Because it's optimized for printing,
PDF often provides the best results.

◦ You can also export the report as RTF for editing in a word processor, or as Excel or PowerPoint.

3. From the catalog folders or search results, you can also do these tasks:

◦ Click Edit to edit the report properties, layout, and data model.

◦ Click Report History to see details about past submissions of the report.

◦ Click Schedule to schedule the report to be run.

How You Use the Analytics Page  
The Analytics page shows up to five of your favorite analyses for easy access. To add an analytic to your page, mark it as
a favorite in the panel tab.

• The Analytics page is available only for some product families. See the Analyze and Report page for these cloud
services in the Oracle Help Center (http://docs.oracle.com).

◦ Oracle Fusion Cloud Sales Automation

See: Oracle Sales Automation Analyze and Report

◦ Oracle Fusion Cloud Human Resources

See: Oracle Human Resources Analyze and Report

• On these Help Center pages, you can review lists of predefined analytics that you might be able to add to your
Analytics page. You can also find guides and other resources for using and creating analytics and reports.

6
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2  Setup and Management

Set Up Financial Reporting Center and Smart View  
The Financial Reporting Center is a powerful tool for reviewing, designing, and presenting financial reports and analytic
data. The critical choices required to configure and install the components in Financial Reporting Center consist of:

• Configuring the Financial Reporting Center

• Installing Smart View, performed by your end users

• Configuring Workspace Database Connection, performed by your administrator

Configuring Financial Reporting Center
You have access to the reports in the Financial Reporting Center and Workspace installed with Oracle Fusion Cloud
Financials. Your Oracle Fusion Business Intelligence (BI) administrator defines the folder structure in Workspace. The
administrator considers your company's security requirements for folders and reports, as well as report distribution
requirements for financial reporting batches.

• Security can be set on folders and reports from Workspace.

• You are granted access to the folders and reports you want to view by your BI administrator.

Installing Smart View
Smart View is an Excel add-in that must be loaded on each client. To download Smart View, click Navigator  > Financial
Reporting Center > Tasks panel drawer > Open Workspace for Financial Reports. Once the workspace is started, click
Tools > Install > Smart View.

Note:  Since Smart View is an add-in to Microsoft Office products, you can install Smart View only on a Windows
operating system.

Once Smart View is installed, you must configure the connection using the Smart View Shared Connections URL. You
can derive the Shared Connections URL by following these steps:

1. From the Financial Reporting Center task panel, select Open Workspace for Financial Reporting.
2. Edit the workspace URL by removing index.jsp and adding SmartViewProviders at the end.

Note:  The following URL is an example for a Cloud-based environment. If the workspace URL is https://
efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/index.jsp, the Shared
Connections URL is https://efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/
SmartViewProviders.

3. Copy the URL.
4. Open Excel.
5. From the Smart View menu, click Options > Advanced.
6. Paste the URL in the Shared Connections URL field.
7. Click OK.

7
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To connect Oracle General Ledger balances cubes in Smart View:

1. Open Smart View from your Start menu > Programs > Microsoft Office > Microsoft Excel 2007.
2. Navigate to the Smart View menu > Open. On the Start on the ribbon, click Smart View Panel that appears in

the list of values from the ribbon. The task pane opens.
3. Click Shared Connections on the task pane.
4. Sign in with your user name and password.
5. Click the  Select Server to proceed list of values.

Note:  If the Essbase Server isn't there, then it has to be added. Use the following steps:
a. Click the Add Essbase Server link.
b. Specify the Essbase Server login and password.
c. Expand the Essbase server and locate the cube in it.

6. Select Oracle Essbase from the list of shared connections.
7. Click the Expand to expand the list of cubes.
8. Expand your cube (name of your chart of accounts).
9. Click db.

10. Click the analysis link.

Note:  You must perform these steps only once for a new server and database.

To set how the name and alias of the Essbase database appears:

1. Click Options on the ribbon > select the Member Options > select Member Name Display.
2. Set one of these three options:

◦ Distinct Member Name. Only shows the full Essbase distinct path.

◦ Member Name and Alias: Shows both the member name and the alias.

◦ Member Name Only. Shows only the member name.

Note:  The Smart Slice feature isn't supported in General Ledger. For all other documentation, refer to the Oracle
Smart View for Office User's Guide.

Configuring Workspace Database Connections
Administrators must create database connections from Workspace so users can access the cubes from Workspace and
Financial Reporting Web Studio.

Note:  Ledger setup has to be completed before the database connection can be created. General Ledger balances
cubes are created as part of ledger setup. A separate cube is created for each combination of chart of accounts and
accounting calendar. A database connection is needed for each cube.

Steps to define a database connection are:

1. Start at the Navigator by selecting Financial Reporting Center.
2. From the Financial Reporting Center task panel, select Open Workspace for Financial Reporting.

8
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3. From within Workspace select the Navigator menu > Applications >BI Catalog.
4. Select Tools menu > Database Connection Manager.
5. Select New button.
6. Enter a user-friendly name for the Database Connection Name.
7. Enter Essbase as the Type, your server, user name, and password.
8. Select Application (cube) and Database from the list of values. Expand the Application name to see the

related Database.
9. Click the OK button twice to save your selections.

10. Click Close button in the Database Connection Manager window to save your connection.

Note:  The database connection is available in both Workspace and Financial Reporting Web Studio. Optionally, it
can be set up in Financial Reporting Web Studio when putting grids on a report. This should only be done by an
administrator.

For more detailed information about Smart View and Financial Reporting Web Studio, refer to the Using EPM with
Oracle Fusion Cloud Financials link on the Oracle Financials All Books page of the Oracle Help Center at https://
docs.oracle.com.

Set up Currency  

Currency and Exchange Rate Settings for Analytics  
CX Sales applications let you to decide how currency is shown in the application and set preferences for how analytics
show currency for different regions and calculate exchange rates.

Currency can be set in different regional currency types, depending on where you do business and what currency types
you want to see.

There are three ways you set up currency:

• User Currency - Set by the business user in Regional settings. This setting applies to the entire application
interface for that user only. The available currency options are set by your application administrator.

• Analytics Currency - Set by the business user in BI in My Account settings in the Reports area. The setting
applies to that user only and is only relevant for analyses.

• Corporate Currency - Set by the application administrator. This setting applies to all users in that company.

Note:  The time zone preferences that you set in your fuse simplified user interface are inherited and used as the time
zone setting for your existing and new analytics.

Set General User Currency  
User currency settings determine the currency used as the default for what you see in your application. User currency
applies to your entire interface for your signed-in session.

9
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1. Navigate to Tools, Set Preferences.
2. Select General Preferences > Regional.
3. Select the preferred currency to be used. Available currencies include those set up for your company by your

application administrator.

Set Analytics Currency
The analytics currency settings determine the currency type that's displayed in all your analytics. It also determines how
and when your currency conversion rates are calculated.

1. Click Navigator Tools Reports and Analytics.
2. Click Browse Catalog.
3. Click My Profile and select  My Account.
4. In the Preference tab, select your choice in Currency.

This shows the currency display options for users:

Currency Display Type Description

Entered Currency
 

Currency used on a transaction.
 

<Application> Currency
 

Currency set up in each respective Cloud application as the common Corporate currency used
company-wide.
 

User Preferred Currency using Simple
Currency Management
 

Conversion to User Preferred Currency is performed at the time your run the report, and is calculated
from the Corporate currency based on the last time the record was updated and saved or closed.
 

User Preferred Currency using Advanced
Currency Management
 

Conversion to User Preferred Currency happens on the date your run the report, and uses the currency
indicated on the record.
 

Set a Default Currency Conversion Option for All Users  
By default your currency is converted to the corporate currency with a method we call "User Preferred Currency Using
Simple Currency Management".

The simple "User Preferred Currency Using Simple Currency Management" setting provides the best run-time
performance because when you run a report, the application doesn't have to look up the rate for each transaction. The
currency is converted to your corporate currency at that day's rate when you update and save a record. Otherwise, the
application cycles through each record at run-time and converts the currency one record at a time to the exchange rate
in effect at the time the report is run. For more information see, How User Preferred Currency Exchange Works.

But you can also standardize the setting for all system users, by setting the default preference to another option, such
as CRM Currency or User Preferred Currency Using Advanced Currency Management.

To change the default currency setting for all users, administrators need to add a profile option and a corresponding
value. Note that when administrators change the default currency setting for users in their organization, individual users
can still override that setting and select their preferred currency in My Account.

The following table shows the profile option code parameters to override the default currency setting.

10
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Profile Code Profile Value Description

BI_DEFAULT_CURRENCY_CONVERSION_
METHOD
 

CRM Currency - Defaults to Application Currency.
 

BI_DEFAULT_CURRENCY_CONVERSION_
METHOD
 

User Preferred Currency 1 - Defaults to User Preferred Currency Simple Currency Management.
 

BI_DEFAULT_CURRENCY_CONVERSION_
METHOD
 

User Preferred Currency 2 - Defaults to User Preferred Currency Advanced Currency Management.
 

Set a Global Currency Conversion Profile  
Set a global currency conversion method for all your users by creating a currency profile. Only administrators can create
currency profiles.

1. In Setup and Maintenance, go to  Manage Administrator Profile Values.
2. Enter the following values:

◦ Profile Option Code : BI_DEFAULT_CURRENCY_CONVERSION_METHOD

◦ Profile Display Name : BI Default Currency Conversion Method

◦ Application

◦ Module

◦ Start Date : Provide previous day's date to proceed to next step to define values.

3. Click Save and Close.
4. In the Manage Profile Options dialog box, you see your new profile. Check the Enabled box for Site.
5. Click Save and Close.

Related Topics
• Update Existing Setup Data

Define Currency Profile Values  
After you create your currency profile, the last step is to define the profile value. This step defines which currency
management option is assigned to that profile.

1. In the Setup and Maintenance work area, use  Manage Administrator Profile Values.
2. In Profile Option Code search for your profile: BI_DEFAULT_CURRENCY_CONVERSION_METHOD.
3. In Manage Administrator Profile Values, Click Add (+ icon).
4. Select Site as the Profile level.
5. Enter "User Preferred Currency 2" in Profile Value.
6. Click Save and Close.

11
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How User Preferred Currency Exchange Works  
The simple and advanced user-preferred currency choices determine how and when your currency exchange rates are
calculated. For both simple and advanced currency management, when you save or close a report, the exchange rate is
set at that time.

The option you choose impacts how quickly your reports are generated at run time. Each case includes trade-offs, as
detailed in the examples.

User Preferred Currency using Simple Currency Management
The advantage of this option is performance - the application doesn't have to look up the rate for each transaction
because when you close or save a record, the application converts it to your corporate currency at that day's rate. When
you run the opportunity report, the application multiplies that value by your preferred currency exchange rate for the
date you run the report. This eliminates the need for the application to cycle through each record, and calculate the
corresponding exchange rate to your preferred exchange rate at the time that record was closed or last saved. It simply
takes the value on record for the original transaction exchange to corporate currency, and multiplies it by your preferred
currency exchange rate at the time your run the report.

As an example of user preferred currency using simple currency management, a user updates and saves or closes an
opportunity record with associated revenue of one million Indian Rupees on January 31st with an exchange rate of
0.01401 Rupees to one US Dollar. The user then runs an opportunity report in US Dollars on March 31st. In the report,
the US Dollar Corporate Currency is set at the January 31st rate it was saved at, in this case reporting as $14,010, or one
million multiplied by 0.01401. Finally, an opportunity report on March 31st in Euros uses the March 31st conversion rate
for US Dollars to Euros of 0.75017 to convert the recorded US Dollar amount into Euros, in this example one million
multiplied by 0.01401, which is the January 31st Rupee to US Dollar exchange rate, multiplied by 0.75013, which is the
March 31st rate for Euros. This requires less processing, because the January 31st Rupee to US Dollar exchange rate,
while not exact on March 31st, is used as the basis for the calculation of the March 31st opportunity revenue conversion
to Euros at the later exchange rate.

The following figure describes an example of user preferred currency using simple currency management.
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User Preferred Currency using Advanced Currency Management
This option provides a more precise exchange rate, since it goes through each record to determine the rate on the date
the record was updated or closed. The downside of this option is performance. Your reports will take longer to run. The
application has to cycle through each record and match currency exchange rates to the date the record was closed or
updated and saved.

As an example of user preferred currency using advanced currency management, a user updates and saves or closes
an opportunity record with associated revenue of one million Indian Rupees on January 31st, when an exchange rate
of 0.01050 Rupees to one Euro applies. The user then runs an opportunity report on March 31st. In the report, the User
Preferred Currency of Euros is applied, using the January 31st Rupee to Euro rate of 0.01050, requiring calculation
during report processing to resolve the opportunity to 10,500 Euros. Note that running the opportunity report on March
31st doesn't change the calculation and the close date of January 31st is used.

The following figure describes an example of user preferred currency using advanced currency management.

Why do I see amounts of zero in analyses?  
Currency exchange rates might not be set up correctly. For example, you set EUR as your preferred currency in general
preferences, and corporate currency is USD. Amounts are displayed in EUR after conversion from USD at the current
exchange rate.

Map to Work Areas  

Set Up the Reports and Analytics Panel Tab  
The Reports and Analytics panel tab appears in many work areas, and shows analytics and reports related to the work
areas. You map and unmap the objects for a specific work area from the business intelligence (BI) catalog.

Your mapping changes for a work area apply to all users who have access to it.
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Map and Remove Objects from Your Work Area

1. Expand the Reports and Analytics panel tab.
2. Click the Edit Settings icon.

You see all the analytics and reports that are currently mapped to your work area.
3. Click Select and Add.
4. Select the object in the catalog.
5. Click OK.
6. To remove any mapping, select the object and click Remove.
7. Click Save.

Map and Remove Objects from Any Work Area

1. In the Setup and Maintenance work area, go to the Map Reports to Work Areas task.
2. Select the application of the work area you want to map to.
3. Select the work area.
4. Click Search and see all the reports that are currently mapped to that work area.
5. Click Select and Add.
6. Select the object in the catalog.
7. Click OK.
8. To remove any mapping, select the object and click Remove.

Tip:  Click Synchronize to remove all mappings to any objects that are no longer in the catalog. You
synchronize all work areas, not just the one you're mapping.

9. Click Save.

Related Topics
• Why can't I see analytics and reports when I edit settings for the Reports and Analytics panel tab?

• Why can't I see analytics and reports when mapping to work areas for the Reports and Analytics panel tab?

• Set Up Reports for Scheduling

• Update Existing Setup Data

Why can't I see analytics and reports when mapping to work areas
for the Reports and Analytics panel tab?  
Either no analytics and reports are mapped to the work area you select on the Map Reports to Work Areas page, or you
don't have access to the mapped objects.

Similarly, when you're selecting an object to map, you can only see objects you have access to. Your administrator can
grant access to the objects or let someone with access map them.

• Assign you roles with access to the objects you want to map.

• Grant the Reports and Analytics Region Administration Duty to someone who already has access to the objects.
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Why can't I see analytics and reports when I edit settings for the
Reports and Analytics panel tab?  
In the Edit Settings window, you might not see a currently mapped report because you don't have access to it.

Similarly, when you're selecting an object to map, you can only see objects you have access to. Your administrator can
grant access to the objects or let someone with access map them.

• Assign you roles with access to the objects you want to map.

• Grant the Reports and Analytics Region Administration Duty to someone who already has access to the objects.

Set Up Reports as Scheduled Processes  

Create Job Definitions to Run Reports as Scheduled Processes  
Every job definition has a job type that reflects the executable for the job, such as Java or Oracle Analytics Publisher
reports. You can only create job definitions that are based on Analytics Publisher reports.

When there's a job definition for an Analytics Publisher report, users can run the report as a scheduled process in the
Scheduled Processes work area. Otherwise, they can open reports (which are set up to be run online) elsewhere, for
example in the Reports and Analytics work area.

CAUTION:  Make sure your user name doesn’t contain any spaces. If you create a custom job definition using a user
name that contains spaces, other users might get errors when they submit this custom job definition.

Create Job Definitions
Here's how you create a job definition for an Analytics Publisher report:

1. In the Setup and Maintenance work area, go to the Manage Enterprise Scheduler Job Definitions and Job
Sets task in the Application Extensions functional area. Or, depending on your offering, you might use a
different functional area.

Note:  If you don't see the task, make sure that the Enterprise Scheduler Job Definitions and Job Sets feature
is enabled at the offering level.

2. On the Manage Enterprise Scheduler Job Definitions and Job Sets page, click the Manage Job Definitions tab.
3. Click the Create icon.
4. Fill in the Job Definition section.

Field or Check Box What You Do

Display Name
 

Enter the name that users see and select to submit the scheduled process.
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Field or Check Box What You Do

Name
 

Enter a name with only alphanumeric characters, for example, AtkEssPrograms1. It can't have
spaces or any special characters.
 

Job Application Name
 

Select the application to associate the job definition with. What you select depends on the task
you're using.
 

◦ Manage Enterprise Scheduler Job Definitions and Job Sets for Customer Relationship
Management and Related Applications: Select CrmEss.

◦ Manage Enterprise Scheduler Job Definitions and Job Sets for Financial, Supply Chain
Management, and Related Applications: Select FscmEss.

◦ Manage Enterprise Scheduler Job Definitions and Job Sets for Human Capital
Management and Related Applications task: Select EarHcmEss.

Enable submission from Enterprise
Manager
 

Make sure you don't select this check box.
 

Job Type
 

Select BIPJobType. Don't select any other type.
 

Default Output Format
 

Select the output format users get by default when they submit the scheduled process.
 

Report ID
 

Enter the path to the report in the BI catalog, starting with the folder within Shared Folders, for
example: Custom/<Family Name>/<Product Name>/<Report File Name>.xdo.
 
Make sure to include the .xdo file extension for the report definition.
 

Enable submission from Scheduled
Processes
 

Leave the check box selected.
 

5. In the Parameters subtab, you can define parameters that are available to users when they submit the
scheduled process based on your job definition.

6. In the User Properties subtab, don't create or edit a user property unless you have the accurate information
that's required to create or edit one. The EXT_PortletContainerWebModule user property is automatically created.

7. Click Save and Close.

When you create a job definition, a privilege with the same name as the job definition is automatically created with a
Run prefix. For example, for a job definition named MyProcess1, with display name My Process, the privilege code is
RUN_MYPROCESS1, with Run My Process as the name. Make sure to use the Security Console to assign this privilege to
roles so that users who need to run the process can do so.
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Related Topics
• Define Parameters for Job Definitions

• Update Existing Setup Data

• Configure Offerings

• Manage List of Values Sources

• Edit Job Definitions

Define Parameters for Job Definitions  
A parameter controls which records are included or how they are affected when a job runs. Job definitions can have one
or more parameters or none at all.

You define parameters while creating or editing job definitions using the Manage Enterprise Scheduler Job Definitions
and Job Sets page. In the Setup and Maintenance work area, use the following:

• Functional Area: Application Extensions or a product-specific functional area

• Task: Manage Enterprise Scheduler Job Definitions and Job Sets

When users run the scheduled process for job definitions of type BIPJobType, the values they enter for the parameters
determine the data to be included in the report. Also, the values are passed to the data model that the report is using.

The parameters that you define must be in the same order as parameters in the data model for the report. For example,
the data model has parameters in this order:

• P_START_DATE

• P_END_DATE

• P_CURRENCY

You create parameters as follows:

• Start Date

• End Date

• Currency

Defining Parameters: Job Definitions
To define parameters while creating or editing job definitions:

1. On the Manage Job Definitions page, open the Parameters sub tab.
2. Click Create.
3. Enter the parameter prompt that users see when they submit the scheduled process.
4. Select a data type and configure how the parameter and the data entered are displayed, as described in this

table.

Data Type Fields

Boolean
 

Select this if you want the parameter to be a check box.
 
Select True or False to determine if the check box is selected or not.
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Data Type Fields

 

Date or time
 

Select Date and time or Date only option.
 
Select a value from the Default Date Format.
 

Note:  Make sure the format you select here is the same as the format used for the job. If the
job definition type is BIPJobType, select yyyy-MM-dd, and make sure the data model for the
corresponding Oracle Analytics Publisher report is using the same date format.

Number
 

Select a Number Format.
 
Select Left or Right for data alignment.
 

String
 

Select a Page Element.
 
Select Text box if you want the user to provide a text.
 
Select Choice list if you want a list with limited options (maximum 10). If there are more than
500 values, users will get an error when they try to set the parameter as part of submitting the
scheduled process.
 
Select List of values if you want a list with unlimited options with a search facility.
 

5. Select the Read Only check box if you don't want to enable users to set this parameter. When a parameter is set
as read only, the user is required to provide a default value to be passed to the job definition.

6. If you select list of values or choice list page element, select a List of Values Source and an Attribute. Use the
list of values sources from the Manage List of Values Sources tab. Don't define lists of values in the data model
that the report is using.

7. From the list of available attributes, select the attributes you want to appear in the list and move them to the
selected attributes section. These attributes determine the values that the user can see.

8. Define a Default Value for the parameter.
9. In the Tooltip Text field, provide additional information for the user to follow.

10. Select the Required check box if users must set this parameter to submit the scheduled process.
11. Select the Do not Display check box if users should not see this parameter while submitting the process.
12. Click Save and Create Another or Save and Close.

Dependent Parameters
The attributes of some parameters depend on the attributes or values of certain other parameters. The attributes of a
parameter would change if the value of its dependent parameter changes.

For example, you have three parameters, namely Country, State and, City. In this case, the value of the Country
parameter would determine the values available in the State parameter. The values in the State parameter would
determine the values available in the City parameter.
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Related Topics
• Create Job Definitions to Run Reports as Scheduled Processes

• Define Dependent Parameters in Job Definitions

Set Up Reports for Scheduling  
You can set up reports as scheduled processes so users can submit them from the Scheduled Processes and other work
areas.

If you want users to also submit these scheduled processes from the Reports and Analytics work area and panel tab,
then you need to configure properties for the corresponding reports.

Enable a Report for Scheduling
1. In the Reports and Analytics work area or panel tab, edit the report in the business intelligence catalog.
2. Click Properties.
3. In the General tab in the Properties dialog box, enter the field values as shown in this table and then click OK.

Field Value

Enterprise Scheduler Job Package Name
 

Enter the path for the job definition, for example: /oracle/apps/ess/<product family>/
<product>/<business area>/Jobs
 

Enterprise Scheduler Job Definition Name
 

Enter the job definition name (not display name), for example: ABCDEFG
 

Related Topics
• Set Up the Reports and Analytics Panel Tab

• How You Access and Modify Report Components

• Create Job Definitions to Run Reports as Scheduled Processes

Configure Deep Links  

Register Business Intelligence to Support Deep Linking  
Deep linking lets you to navigate from an analysis on the interface pages to specific attributes and objects in your work
areas so that you can work with them directly.

What does that mean? It means that if you're looking at an analysis on leads, for example, you can click a record on the
analytic and go edit the lead record on the edit object page. To support deep links, use the Setup and Maintenance work
area to register the Business Intelligence Server as a third-party application.
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Register Business Intelligence Server as a Third-Party Application
To register the BI Server:

1. Use the Manage Third Party Applications page.
2. Click Create.
3. Enter AnalyticsApp as the application name.
4. Enter the full URL for the BI Server (for example: http://host:port/analytics/saw.dll).
5. Enter Analytics Server as the Partner Name.
6. Click Save and Close.

Related Topics
• Manage Integration of Additional Applications

Create Deep Links  
Create deep links in your analytics that let you navigate from an analysis to specific attributes and objects in your
transactional pages to work with them directly.

1. In the Reports and Analytics work area, click Browse Catalog.
2. Create or edit an analysis. Use a subject area that includes the attribute you want to link to in the transactional

pages, and ensure that you include the object ID.
3. On the Criteria tab, click the Options icon for the attribute column on which you need a deep link and select

Column Properties.
4. Open the Interaction tab in the Column Properties dialog box.
5. In the Primary Interaction list in the Value section, select Action Links to display the Action Links table.
6. Select the Do not display in a pop-up if only one action link is available at runtime option.
7. Click Add Action Link.
8. In the New Action Link dialog box, enter the link text for the navigation.
9. Click the Create New Action icon and select Navigate to a Web Page.

10. In the Create New Action dialog box, enter the URL to navigate to, which references parameters you define in
the prompt. For shared analyses://<hostname>/fscmUI/faces/deeplink?objType=@{1}&objKey=<object
ID>=@{2}&action=@{3}&returnApp=AnalyticsApp&returnAppParams=PortalGo%26path=</shared/
Custom/<folder>/@{6}

Note:  If you don't click the Return icon, remove parameters 5 through 7. In this case, the
URL would be: //<hostname>/fscmUI/faces/deeplink?objType=@{1}&objKey=<object
ID>=@{2};searchInd=@{3}&action=@{4}

For personal analyses stored in My Folders: //<hostname>/fscmUI/faces/deeplink?
objType=@{1}&objKey=<object
ID>=@{2}&action=@{3}&returnApp=AnalyticsApp&returnAppParams=PortalGo%26pather=/users/
@{5}/@{6}

11. Click Define Parameters to add corresponding parameters for the URL.
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12. In the Define Parameters section, click Add Parameter to add the following mandatory parameters:

Name Prompt Type of Value Value Fixed Hidden Notes

1
 

Object Type
 

Value
 

<Object Type>
 

Selected
 

Selected
 

Used for shared
and personal
analyses.
 

2
 

<Prompt Name>
 

Column Value
 

Column Name in
"<table.name>"."<column.name>"

format
 

Selected
 

Selected
 

Used for shared
and personal
analyses.
 

3
 

Action
 

Value
 

edit
 

Selected
 

Selected
 

Used for shared
and personal
analyses.
 

4
 

returnApp
 

Value
 

AnalyticsApp
 

Selected
 

Selected
 

Used for shared
and personal
analyses.
 

5
 

Logged in User
 

Session Variable
 

USER
 

Selected
 

Selected
 

Session variable
parameter used
for personal
analysis
permissions.
 

6
 

Report Name
 

Value
 

Analysis Name
 

Selected
 

Selected
 

Used for shared
and personal
analyses. The
name of the
analysis to
return to after
working in the
transactional
page.
 

13. Click Options to set how the page opens.
14. In the Action Options dialog box, select Open in New Window to open the page in a new window.
15. Save your work.
16. If you have provided the Return Application name, a Return icon is available in the transactional page to return

to the analysis.

Related Topics
• Register Business Intelligence to Support Deep Linking

• Manage Analytics with Advanced Features
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FAQs for Deep Links  

Why did a deep link open to a blank page?  
You may not have access to the linked object, or the URL entered for the action is incorrect, for example lacking the
environment or the Object ID name.

• Check the URL you entered for the action. It may be missing the environment name or the Object ID name.

• Check the URL parameters, the spelling of the action, and that you're using the correct key in the object's
analysis.

Do I have to display the ID for my object?  
No, you can add it, format the column as a number with zero decimals, and then hide the column.

Can I display actions for some users and not others?  
Yes, you define conditions for the action to display.

Manage Permissions  

Manage Catalog Permission  
You may want to remove access to predefined catalog folders so that those associated with offerings you don't use
aren't displayed. You can hide the entire predefined catalog or selectively display root catalog folders for offerings.

To control which offerings are available, create a custom role based on the Custom BI Web cat Reporting Duty role and
its associated roles for each. Using custom roles, you can manage folder access in a number of ways, depending on
requirements and previous modifications you have made.

• Add duty roles for parent folders to the custom role so that all users see a subset of the predefined catalog. Add
roles only for the offerings you want to retain access for.

• Don't add any catalog reporting duty roles for any offerings to the custom role to hide the entire predefined
catalog and display only /Shared/Custom folders. For example, you can remove BI catalog access for external
users such as partners who have no access to reporting.

• Delete all catalog reporting duty roles from the custom role. Also, add catalog reporting duty roles to a new or
existing job role so that job roles with BI access get default access to the predefined catalog. For example, by
default, Financial job roles have access to Financial reporting content but Human Capital Management job roles
don't have access to the predefined HCM BI catalog. You can grant the Human Capital Management Folder
Reporting Duty role to new job roles to allow access to predefined HCM reports.
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Hide Predefined Catalog Folders
All authenticated users have the Custom BI Web cat Reporting Duty role, which inherits all of the folder reporting roles
that determine access and visibility of root level catalog folders. Administrators with IT Security Manager privileges can
hide predefined folders by creating custom roles based on this role and their associated roles from the duty role.

1. Open the Security Console.
2. Search for Custom BI Web cat Reporting Duty and review its duty roles to determine which to retain in your

custom role.
3. Create a custom role.
4. Click Actions > Add Role.
5. Click Next twice to navigate to the Role Hierarchy step.
6. To hide all folders, leave the hierarchy empty. Add any roles for offerings you want to retain access for.
7. Run the Import User and Role Application Security Data process to synchronize security changes.
8. Click Browse Catalog in the Reports and Analytics work area and click Administration. In the Maintenance and

Troubleshooting section, select Reload Files and Metadata to refresh the the BI cache.

BI Reporting Roles
This table shows the mapping between shared root catalog folders, folder reporting roles, and job roles.

Catalog Folder Duty Role Duty Role Name Associated Job Roles

/Shared/Common Content
 

BI_COMMON_CONTENT_
REPORTING_DUTY
 

Common Content Folder Reporting
Duty
 

None
 

/Shared/Customer Data
Management
 

BI_CDM_REPORTING_DUTY
 

Customer Data Management
Folder Reporting Duty
 

None
 

/Shared/Enterprise Contracts
 

BI_OKC_REPORTING_DUTY
 

Enterprise Contracts Folder
Reporting Duty
 

ORA_OKC_CUSTOMER_
CONTRACT_ADMINISTRATOR_
JOB, ORA_OKC_CUSTOMER_
CONTRACT_MANAGER_JOB, ORA_
OKC_CUSTOMER_CONTRACT_
TEAM_MEMBER_ABSTRACT, ORA_
OKC_ENTERPRISE_CONTRACT_
ADMINISTRATOR_JOB, ORA_
OKC_ENTERPRISE_CONTRACT_
MANAGER_JOB, ORA_OKC_
ENTERPRISE_CONTRACT_TEAM_
MEMBER_ABSTRACT, ORA_
OKC_SUPPLIER_CONTRACT_
ADMINISTRATOR_JOB, ORA_
OKC_SUPPLIER_CONTRACT_
MANAGER_JOB, ORA_OKC_
SUPPLIER_CONTRACT_TEAM_
MEMBER_ABSTRACT
 

/Shared/Extension
 

BI_EXT_REPORTING_DUTY
 

Extension Folder Reporting Duty
 

None
 

/Shared/Financials
 

BI_FIN_REPORTING_DUTY
 

Financials Folder Reporting Duty
 

ORA_AP_ACCOUNTS_PAYABLE_
INVOICE_SUPERVISOR_
JOB ORA_AP_ACCOUNTS_
PAYABLE_MANAGER_JOB, ORA_
AP_ACCOUNTS_PAYABLE_
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Catalog Folder Duty Role Duty Role Name Associated Job Roles

PAYMENT_SUPERVISOR_
JOB, ORA_AP_ACCOUNTS_
PAYABLE_SPECIALIST_JOB,
 ORA_AP_ACCOUNTS_PAYABLE_
SUPERVISOR_JOB, ORA_AR_
ACCOUNTS_RECEIVABLE_
MANAGER_JOB, ORA_AR_
ACCOUNTS_RECEIVABLE_
MANAGER_SOD_JOB, ORA_
AR_ACCOUNTS_RECEIVABLE_
SPECIALIST_JOB, ORA_AR_
ACCOUNTS_RECEIVABLE_
SPECIALIST_SOD_JOB, ORA_
AR_BILLING_MANAGER_JOB,
 ORA_AR_BILLING_SPECIALIST_
JOB, ORA_CE_CASH_MANAGER_
JOB, ORA_EXM_EXPENSE_
MANAGER_JOB, ORA_FA_ASSET_
ACCOUNTANT_JOB, ORA_FA_
ASSET_ACCOUNTING_MANAGER_
JOB, ORA_FUN_INTERCOMPANY_
ACCOUNTANT_JOB, ORA_GL_
FINANCIAL_ANALYST_JOB,
 ORA_VRM_REVENUE_ANALYST_
JOB, ORA_VRM_REVENUE_
MANAGER_JOB, ORA_XCC_
BUDGET_MANAGER_JOB
 

/Shared/Higher Education
 

BI_HED_REPORTING_DUTY
 

Higher Education Folder Reporting
Duty
 

ORA_HEQ_ADMISSIONS_
COORDINATOR_JOB, ORA_
HEQ_ADMISSIONS_MANAGER_
JOB, ORA_HER_ACADEMIC_
COORDINATOR_JOB, ORA_
HER_REGISTRAR_JOB, ORA_
HES_BURSAR_JOB, ORA_HEY_
STUDENT_SERVICES_MANAGER_
JOB, ORA_HEY_STUDENT_
SUPPORT_ADVISOR_JOB
 

/Shared/Human Capital
Management
 

BI_HCM_REPORTING_DUTY
 

Human Capital Management
Folder Reporting Duty
 

By default, predefined HCM job
roles have no access to the the
predefined content.
 

/Shared/Incentive
Compensation
 

BI_IC_REPORTING_DUTY
 

Incentive Compensation Folder
Reporting Duty
 

ORA_CN_INCENTIVE_
COMPENSATION_ANALYST_
JOB, ORA_CN_INCENTIVE_
COMPENSATION_MANAGER_
JOB, ORA_CN_INCENTIVE_
COMPENSATION_PARTICIPANT_
ABSTRACT, ORA_CN_INCENTIVE_
COMPENSATION_PARTICIPANT_
MANAGER_ABSTRACT, ORA_CN_
INCENTIVE_COMPENSATION_
PLAN_ADMINISTRATOR_JOB
 

/Shared/Loyalty
 

BI_LOY_REPORTING_DUTY
 

Loyalty Folder Reporting Duty
 

ORA_LOY_LOYALTY_MARKETING_
MANAGER_JOB, ORA_
LOY_LOYALTY_PROGRAM_
ADMINISTRATOR_JOB
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Catalog Folder Duty Role Duty Role Name Associated Job Roles

 

/Shared/Manufacturing
 

BI_MFG_REPORTING_DUTY
 

Manufacturing Folder Reporting
Duty
 

ORA_CSE_ASSET_
ADMINISTRATOR_JOB
 

/Shared/Marketing
 

BI_MKT_REPORTING_DUTY
 

Marketing Folder Reporting Duty
 

ORA_MKL_SALES_LEAD_
QUALIFIER_JOB, ORA_MKT_
CORPORATE_MARKETING_
MANAGER_JOB, ORA_MKT_
MARKETING_ANALYST_JOB, ORA_
MKT_MARKETING_MANAGER_
JOB, ORA_MKT_MARKETING_
OPERATIONS_MANAGER_JOB,
 ORA_MKT_MARKETING_VP_JOB
 

/Shared/Partner
 

BI_ZPM_REPORTING_DUTY
 

Partner Folder Reporting Duty
 

ORA_ZPM_CHANNEL_ACCOUNT_
MANAGER_JOB, ORA_ZPM_
CHANNEL_ADMINISTRATOR_
JOB, ORA_ZPM_CHANNEL_
OPERATIONS_MANAGER_JOB,
 ORA_ZPM_CHANNEL_PARTNER_
MANAGER_JOB, ORA_ZPM_
CHANNEL_PARTNER_PORTAL_
ADMINISTRATOR_JOB, ORA_ZPM_
CHANNEL_SALES_DIRECTOR_JOB,
 ORA_ZPM_CHANNEL_SALES_
MANAGER_JOB
 

/Shared/Procurement
 

BI_PRC_REPORTING_DUTY
 

Procurement Folder Reporting
Duty
 

ORA_AP_ACCOUNTS_PAYABLE_
MANAGER_JOB, ORA_AP_
ACCOUNTS_PAYABLE_
SPECIALIST_JOB, ORA_
AP_ACCOUNTS_PAYABLE_
SUPERVISOR_JOB, ORA_
PO_BUYER_JOB, ORA_PO_
PROCUREMENT_APPLICATION_
ADMIN_JOB, ORA_PO_
PROCUREMENT_INTEGRATION_
SPECIALIST_JOB, ORA_
PO_PURCHASE_ANALYSIS_
ABSTRACT, ORA_POQ_SUPPLIER_
QUALIFICATION_DISCRETIONARY,
 ORA_POR_PROCUREMENT_
REQUESTER_ABSTRACT, ORA_
POZ_SUPPLIER_ADMINISTRATOR_
ABSTRACT, ORA_POZ_SUPPLIER_
MANAGER_ABSTRACT
 

/Shared/Projects
 

BI_PRJ_REPORTING_DUTY
 

Projects Folder Reporting Duty
 

ORA_OKC_CUSTOMER_
CONTRACT_ADMINISTRATOR_
JOB, ORA_OKC_CUSTOMER_
CONTRACT_MANAGER_JOB, ORA_
OKC_CUSTOMER_CONTRACT_
TEAM_MEMBER_ABSTRACT, ORA_
OKC_ENTERPRISE_CONTRACT_
ADMINISTRATOR_JOB, ORA_
OKC_ENTERPRISE_CONTRACT_
MANAGER_JOB, ORA_OKC_
ENTERPRISE_CONTRACT_TEAM_
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Catalog Folder Duty Role Duty Role Name Associated Job Roles

MEMBER_ABSTRACT, ORA_
PJF_GRANTS_ACCOUNTANT_
JOB, ORA_PJF_GRANTS_
ADMINISTRATOR_JOB, ORA_
PJF_GRANTS_DEPARTMENT_
ADMINISTRATOR_JOB, ORA_
PJF_PROJECT_ACCOUNTANT_
JOB, ORA_PJF_PROJECT_
ADMINISTRATOR_JOB, ORA_PJF_
PROJECT_BILLING_SPECIALIST_
JOB, ORA_PJF_PROJECT_
EXECUTION_ABSTRACT, ORA_
PJF_PROJECT_EXECUTIVE_
JOB, ORA_PJF_PROJECT_
INTEGRATION_SPECIALIST_
JOB, ORA_PJF_PROJECT_
MANAGEMENT_DUTY_ABSTRACT,
 ORA_PJF_PROJECT_MANAGER_
JOB, ORA_PJF_PROJECT_TEAM_
MEMBER_ABSTRACT, ORA_
PJF_PROJECTS_APPLICATION_
ADMINISTRATOR_JOB, ORA_PJF_
RESOURCE_MANAGER_JOB, ORA_
PJF_TEAM_COLLABORATOR_
ABSTRACT
 

/Shared/Public Sector
 

BI_PSC_REPORTING_DUTY
 

Public Sector Folder Reporting
Duty
 

ORA_PSC_AGENCY_STAFF_
ABSTRACT, ORA_PSC_BUILDING_
INSPECTOR_JOB, ORA_PSC_
BUSINESS_ANALYST_JOB,
 ORA_PSC_CHIEF_BUILDING_
OFFICER_JOB, ORA_PSC_
ECONOMIC_DEV_OFFICER_JOB,
 ORA_PSC_FINANCE_ADMIN_
JOB, ORA_PSC_INSPECTIONS_
SUPERVISOR_JOB, ORA_PSC_
PERMIT_TECHNICIAN_JOB, ORA_
PSC_PERMITS_APPLICATION_
ADMINISTRATOR_JOB, ORA_PSC_
PERMITS_SUPERVISOR_JOB, ORA_
PSC_PLAN_COORDINATOR_JOB,
 ORA_PSC_PLAN_REVIEWER_
JOB, ORA_PSC_PRINCIPAL_
PLANNER_JOB, ORA_PSC_
SYSTEM_ADMINISTRATOR_JOB
 

/Shared/Risk Management
 

BI_GRC_REPORTING_DUTY
 

Risk Management Folder Reporting
Duty
 

ORA_GTG_APPLICATION_
ACCESS_AUDITOR_JOB, ORA_
GTG_APPLICATION_CONTROL_
MANAGER_JOB, ORA_GTG_
COMPLIANCE_MANAGER_JOB,
 ORA_GTG_ENTERPRISE_RISK_
AND_CONTROL_MANAGER_JOB,
 ORA_GTG_RISK_MANAGEMENT_
AUDITOR_JOB, ORA_GTR_
USER_ACCESS_CERTIFICATION_
MANAGER_JOB
 

/Shared/Sales
 

BI_ZBS_REPORTING_DUTY
 

Sales Folder Reporting Duty
 

ORA_ZBS_SALES_
ADMINISTRATOR_JOB, ORA_ZBS_
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Catalog Folder Duty Role Duty Role Name Associated Job Roles

SALES_MANAGER_JOB, ORA_
ZBS_SALES_REPRESENTATIVE_
JOB, ORA_ZBS_SALES_
RESTRICTED_USER_JOB, ORA_
ZBS_SALES_VP_JOB, ORA_
ZPM_CHANNEL_ACCOUNT_
MANAGER_JOB, ORA_ZPM_
CHANNEL_ADMINISTRATOR_
JOB, ORA_ZPM_CHANNEL_
OPERATIONS_MANAGER_JOB,
 ORA_ZPM_CHANNEL_PARTNER_
MANAGER_JOB, ORA_ZPM_
CHANNEL_PARTNER_PORTAL_
ADMINISTRATOR_JOB, ORA_ZPM_
CHANNEL_SALES_DIRECTOR_JOB,
 ORA_ZPM_CHANNEL_SALES_
MANAGER_JOB, ORA_ZSP_SALES_
ANALYST_JOB
 

/Shared/Service
 

BI_SVC_REPORTING_DUTY
 

Service Folder Reporting Duty
 

ORA_CSO_KNOWLEDGE_
ANALYST_JOB, ORA_CSO_
KNOWLEDGE_MANAGER_
JOB, ORA_SVC_CUSTOMER_
SERVICE_MANAGER_JOB, ORA_
SVC_CUSTOMER_SERVICE_
REPRESENTATIVE_JOB, ORA_
SVC_HUMAN_RESOURCE_HELP_
DESK_ADMINISTRATOR_JOB,
 ORA_SVC_HUMAN_RESOURCE_
HELP_DESK_AGENT_JOB, ORA_
SVC_HUMAN_RESOURCE_HELP_
DESK_MANAGER_JOB, ORA_
SVC_INTERNAL_HELP_DESK_
ADMINISTRATOR_JOB, ORA_SVC_
INTERNAL_HELP_DESK_AGENT_
JOB, ORA_SVC_INTERNAL_HELP_
DESK_MANAGER_JOB, ORA_
ZBS_SALES_ADMINISTRATOR_
JOB, ORA_ZCA_CUSTOMER_
RELATIONSHIP_MANAGEMENT_
APPLICATION_ADMINISTRATOR_
JOB
 

/Shared/Subscription
Management
 

BI_OSS_REPORTING_DUTY
 

Subscription Management Folder
Reporting Duty
 

ORA_OSS_SUBSCRIPTION_
SPECIALIST_JOB
 

/Shared/Supply Chain
Management
 

BI_SCM_REPORTING_DUTY
 

Supply Chain Management Folder
Reporting Duty
 

ORA_ACD_PRODUCT_DESIGN_
ENGINEER_JOB, ORA_ACD_
PRODUCT_DESIGN_MANAGER_
JOB, ORA_ACE_PRODUCT_
MANAGEMENT_VP_JOB, ORA_
ACE_PRODUCT_PORTFOLIO_
MANAGER_JOB, ORA_CMF_
FISCAL_DOCUMENT_SPECIALIST_
JOB, ORA_CMF_RECEIVING_
SPECIALIST_JOB, ORA_CMR_
RECEIPT_ACCOUNTING_
DISCRETIONARY, ORA_CSE_
ASSET_ADMINISTRATOR_JOB,
 ORA_CST_COST_ACCOUNTANT_
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Catalog Folder Duty Role Duty Role Name Associated Job Roles

JOB, ORA_DOO_ORDER_
ADMINISTRATOR_JOB, ORA_
DOO_ORDER_MANAGER_JOB,
 ORA_EGI_PRODUCT_DATA_
STEWARD_JOB, ORA_EGP_
PRODUCT_MANAGER_JOB, ORA_
ENQ_QUALITY_ANALYST_JOB,
 ORA_ENQ_QUALITY_ENGINEER_
JOB, ORA_FOS_SUPPLY_CHAIN_
CONTROLLER_JOB, ORA_
INV_INVENTORY_MANAGER_
JOB, ORA_INV_WAREHOUSE_
MANAGER_JOB, ORA_MNT_
MAINTENANCE_MANAGER_JOB,
 ORA_MNT_MAINTENANCE_
TECHNICIAN_JOB, ORA_MSC_
BACKLOG_MANAGER_JOB, ORA_
MSC_DEMAND_AND_SUPPLY_
PLANNER_JOB, ORA_MSC_
DEMAND_PLANNER_JOB, ORA_
MSC_MATERIALS_PLANNER_JOB,
 ORA_MSC_REPLENISHMENT_
PLANNER_JOB, ORA_MSC_SALES_
AND_OPERATIONS_PLANNER_
JOB, ORA_MSC_SUPPLY_CHAIN_
PLANNER_JOB, ORA_RCL_FIELD_
SERVICE_ADMINISTRATOR_
JOB, ORA_VCS_SUPPLY_CHAIN_
COLLABORATION_PLANNER_JOB,
 ORA_WSH_SHIPPING_MANAGER_
JOB
 

/Shared/Functional Setup
 

BI_FSM_REPORTING_DUTY
 

Functional Setups Folder Reporting
Duty *Not inherited by Custom BI
Web cat Reporting Duty
 

ORA_ASM_APPLICATION_
IMPLEMENTATION_CONSULTANT_
JOB
 

/Shared/Security
 

FBI_SECURITY_TRANSACTION_
ANALYSIS_DUTY
 

Security Transaction Analysis Duty
*Not inherited by Custom BI Web
cat Reporting Duty
 

ORA_FND_IT_SECURITY_
MANAGER_JOB
 

Predefined Catalog Lockdown
If you try to modify the predefined catalog content including folder permissions, you get an alert indicating that you're
not allowed to modify content and asking that you save your own content in the /Shared/Custom folder.

Here are a few things to know about catalog folders:

• You must save all modified content in the /Shared/Custom folder or in new folders in the /Shared folder.

• Existing modified content in the /Shared/Custom folder or custom folders in the /Shared folder and their
subfolders is preserved. If you have modified the content in the predefined catalog folders, all changes are lost
during any upgrade. To preserve content, archive your catalog content and unarchive it in the Shared/Custom
folder after upgrade.

• All existing content in parent folders in the /Shared folder is preserved.

• You can't change folder or object permissions on the predefined catalog folders or content. For example, you
can't change folder permissions to hide folders or objects.
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Related Topics
• Role Inheritance

• Archive and Move Analytics

• Submit Scheduled Processes and Process Sets

29

https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20050912
https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20056301
https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20048442


Oracle Fusion Cloud Financials
Creating and Administering Analytics and Reports for
Financials

Chapter 2
Setup and Management

30



Oracle Fusion Cloud Financials
Creating and Administering Analytics and Reports for
Financials

Chapter 3
Flexfields

3  Flexfields

Overview of Flexfield Use in Analyses  
Flexfields are extensible sets of placeholder fields associated with business objects that can be placed on application
pages. They're used to extend business objects and meet your data management requirements without changing the
data model or performing any database programming.

To include flexfields you have used for extension for use in analyses, you must enable them for business intelligence.

Extension of analyses using flexfields is available for Oracle Enterprise Resource Planning Cloud and Oracle Human
Capital Management Cloud.

Flexfield Types
The following types of flexfields are available and provide a means to modify application features without programming:

• Descriptive

• Extensible

• Key

Depending on the flexfield type, business intelligence enablement is performed differently and has different
requirements. Once they are enabled for business intelligence, you can import any changes made to flexfields
automatically using an import scheduled process.

Configure Key Flexfields for Transactional Business
Intelligence  

Enable Key Flexfields for Business Intelligence Reporting  
To include flexfields in your analyses, you must enable them for Business Intelligence. Extensibility of analysis using
flexfields is used for Enterprise Resource Planning and Human Capital Management. For Customer Relationship
Management, the Extensibility Framework supports this.

To designate key flexfields as BI-enabled:

1. In the Setup and Maintenance work area, go to the Manage Key Flexfields task.
2. On the Manage Key Flexfields page, enter your search value in Key Flexfield Code.
3. Click Manage Structure Instances.
4. Enter your search value in Structure Instance Code.
5. Click Edit to display the Edit Key Flexfield Structure Instance dialog box.
6. Select the BI Enabled option, then click OK.
7. For each flexfield segment instance, repeat steps 5 through 6.
8. Click Save.
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9. Populate the BI Object Name for each of the segment labels:

a. Query the Key Flexfield Code in the Manage Key Flexfields window.
b. From the Actions menu, select Manage Segment Labels.
c. Populate the BI Object Name for each segment label to be mapped. The BI Object Name for the following

qualified segment labels should not be modified:

Segment Label Code BI Object Name

FA_COST_CTR
 

Dim - Cost Center
 

GL_BALANCING
 

Dim - Balancing Segment
 

GL_ACCOUNT
 

Dim - Natural Account Segment
 

Before you deploy a flexfield, you must access the Chart of Accounts Instance and assign the newly
created segment label to the appropriate segment in the Chart of Accounts.

d. Click Deploy Flexfield.
e. Click Save and Close.

Related Topics
• Considerations for Enabling Key Flexfield Segments for Business Intelligence

• Update Existing Setup Data

Overview of Supported Financials Key Flexfields  
This table lists key flexfields that are used to store internally defined codes unique to a particular business, specifying
part numbers, general ledger accounts, and other business entities.

Product Area Key Flexfield Dimension

Fixed Assets Category (CAT#) Dim - Asset Category

Fixed Assets Location (LOC#) Dim - Asset Location

General Ledger Accounting (GL#) Dim - Balancing Segment
 
Dim - Cost Center
 
Dim - Natural Account
 

Budgetary Control Budgeting (XCC) Dim - XCC Segment
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Map Non-Qualified Segments to BI Objects  
To map non-qualified segments that must be mapped and used in analysis, create a new label and associate a BI object
with the label. Associate this new segment label with the segment code.

To map non-qualified segments to BI objects:

1. In the Setup and Maintenance work area, go to the Manage Key Flexfields task.
2. On the Manage Key Flexfields page, search for the appropriate key flexfield code.
3. From the Actions menu, select Manage Segment Labels.
4. Click the Add Row icon.
5. Enter the details for the Segment Label Code, including name, description, and BI Object name. Enter the BI

object names carefully and note whether there is a space between Segment and the number.
This table provides examples of Key Flexfields and associated BI object names.

Key Flexfield BI Object Name

Accounting (GL)
 

Dim - GL Segment1 through Dim - GL Segment10
 

Budgetary Control (XCC)
 

Dim - XCC Segment1 through Dim - XCC Segment10
 

Revenue Management (VRM)
 

Dim - VRM Segment 1 through Dim - VRM Segment 10
 

6. Complete the mapping by assigning unique segment labels to the key flexfields.

Set Up the GL Accounting Flexfields  
This topic describes the workflow for setting up Accounting key flexfields, but these steps also apply for other key
flexfields.

• Understanding Accounting Key Flexfields

• Identifying Accounting Key Flexfields

• Assigning Unique Segment Labels

• Performing Column Flattening

• Designating GL Accounting Segment Instances as BI-Enabled

• Deploying Accounting Key Flexfields

Understanding Accounting Key Flexfields
The Accounting Key Flexfield is used to identify GL accounts.

A chart of accounts segment is a component of the accounting key flexfield. Each segment has a value set attached
to it to provide formatting and validation of the set of values used with that segment. The combination of segments
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creates the account combination used for recording and analyzing financial transactions. You must set up your Chart of
Accounts (COA) as part of implementing Oracle Applications Cloud.

Examples of segments that may be found in a chart of accounts structure include Company, Cost Center, Department,
Division, Region, Account, Product, Program, and Location.

The Natural Account segment of the General Ledger Accounting Key Flexfield defines the account used in the account
combination to record transactions.

The logical segment dimensions in the Oracle BI metadata are Dim - Cost Center, Dim - Balancing Segment, Dim -
Natural Account Segment and all Dim - GL Segmentndimensions. These dimension tables are populated from a Tree
value object or from a Value Set value object. Which value is used depends on whether a tree was associated with the
segment in the Oracle Applications Cloud setup:

• For each segment associated with trees, two value objects are generated (Tree and TreeCode) with the following
naming structure:

FscmTopModelAM.AccountBIAM.FLEX_TREE_VS_segmentlabel_VI &

FscmTopModelAM.AccountBIAM.FLEX_TREECODE_VS_segmentlabel_VI

• For each segment without trees, one view object is generated with the following naming structure:

FscmTopModelAM.AccountBIAM.FLEX_VS_ XXX_VI

In addition to the segment dimension tables, the BI Extension process also extends Flex BI Flattened VO;
FscmTopModelAM.AccountBIAM.FLEX_BI_Account_VI. This view object has a pair of columns for each segment;
segmentlabel_ and segmentlabel_c.

For example, for your Cost Center segment which has the segment label FA_COST_CTR, there are two columns in this
view object, named FA_COST_CTR_ and FA_COST_CTR_c.

Identifying Accounting Key Flexfield Segments
Identify and map segments of the chart of accounts.

For each Chart of Accounts (Accounting Key Flexfield) used to analyze Transactional Business Intelligence facts, identify
the segments of the chart of accounts. Map them to the Transactional Business Intelligence GL Accounting Segment
logical dimensions.

Accounting Key Flexfield Segment Segment Label Transactional Business Intelligence GL
Accounting Segment Logical Dimension

Balancing
 

GL_BALANCING
 

Dim - Balancing Segment
 

Natural Account
 

GL_ACCOUNT
 

Dim - Natural Account Segment
 

Cost Center
 

FA_COST_CTR
 

Dim - Cost Center
 

Other segments to be equalized across the
charts of accounts
 

Other unique segment label
 

Dim - GL Segment n where n is an integer from
1 to 10
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Assigning Unique Segment Labels
You must assign a unique segment label to the charts of accounts segments that are the balancing segments or the
natural account segments. The segments must be also used for specific purposes.

For example, assign the Primary Balancing segment label to the segment used for your company or legal entities. That
label provides a correct recording of intercompany transactions and company analysis. You can assign other segment
labels when required.

To assign unique segment labels to charts of accounts segments:

1. In the Setup and Maintenance work area, go to the Manage Charts of Accounts task and then navigate to the
Manage Chart of Accounts page.

2. In the Search section, enter the GL# for the Key Flexfield Code and click the Search button.
3. In the Search Results section, select Accounting Flexfield and click the Manage Structures button to navigate

to Manage Key Flexfield Structures.
4. In the Search section, enter the chart of accounts code or the name for Structure Code or Name and click the

Search button.
5. In the Search Results section, select the chart of accounts and click Edit to navigate to the Edit Key Flexfield

Structure window
6. Select the Enabled check box to code-enable the Structure code.
7. In the Segments section, select the applicable segments and click Edit to navigate to the Edit Key Flexfield

Segment window.
8. Select the Enabled check box to enable the segments.
9. In the Segment Labels section, select the unique segment labels to equalize the segments across the charts of

accounts. Click theshuttle to move the segments to the selected list.
10. Click Save and Close to return to the Edit Key Flexfield Structure window.
11. Click Done to return to the Manage Key Flexfields window.

Performing Column Flattening

Column flattening of trees is required in order for OTBI hierarchy analyses to be populated with correct data.

To flatten columns for account hierarchies:

1. In the Setup and Maintenance work area, go to the Manage Trees and Tree Versions task and navigate to the
Manage Trees and Tree Versions window.

2. In the Search section, enter GL_ACCT_FLEX for the Tree Structure Code and the involved tree code or name,
and click Search.

3. In the Search Results section, select the tree version you want to flatten. If the status of the Tree Version is
Draft, to make the Tree Version active, select Actions, then Status, and then Active.

4. (Optional): After the tree version is specified, perform an audit on the Tree Version to ensure its integrity before
launching the flattening job. Select Actions and then Audit. See the section on working with Trees in the
Developer's Guide.

5. Choose Column Flattening from the Actions menu.
6. Click the Online Flattening button to launch the flattening job immediately. Or, click the Schedule Flattening

button to schedule the flattening job according to your requirements.

Designating GL Accounting Segment Instances as BI-Enabled
Specify the applicable chart of accounts segment instances that are BI-enabled to make them available for use in
Transactional Business Intelligence.
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To specify the chart of accounts segment instances as BI-enabled:

1. In the Search Results section of the Manage Key Flexfields window, select Accounting Flexfield and click the
Manage Structure Instances button to navigate to the Manage Key Flexfield Structure Instances window.

2. In the Search section, select the chart of accounts for Structure Name and click the Search button.
3. In the Search Results section, select the structure instance and click Edit to navigate to the Edit Key Flexfield

Structure Instance window.
4. Check the Enabled check box to code-enable the structure instance.
5. In the Segment Instances section, select the segment instances and click Edit to update. Each of the segment

instances must be selected individually.
6. Select the Business Intelligence enabled check box in the Edit Key Flexfield Segment pop-up window and click

OK to return to Edit Key Flexfield Structure Instance window.
7. After you have enabled all applicable segment instances for Business Intelligence, click Save and Close to save

the changes and return to the Edit Key Flexfield Structure Instance window.
8. Repeat steps 2 - 6 for each chart of accounts to enable all the applicable segment instances for Business

Intelligence.
9. Click Done to return to the Manage Key Flexfields window.

10. After you have configured all the charts of accounts, click the Deploy Flexfield button to deploy the
Accounting Flexfield and make the latest definition available for use.

Deploying Accounting Key Flexfields
After you have set up accounting key flexfields, you must deploy them.

Accounting key flexfields have one of the following deployment statuses:

• Edited: The flexfield definition has not been deployed or changes have been made to the structure, the
structure instances, or the value sets.

• Patched: The flexfield definition has been modified through an update, but the flexfield has not yet been
deployed so the updated definition is not reflected.

• Deployed to Sandbox: The flexfield is deployed and available in a flexfield-enabled sandbox.

• Deployed: The flexfield definition is deployed and available to end users.

• Error: The deployment attempt failed.

To deploy accounting key flexfields:

1. In the Setup and Maintenance work area, go to the Manage Chart of Accounts task.
2. Click Search.
3. Locate the Deployment Status column.
4. Click the icon.
5. Select Edited.
6. Click Deploy Flexfield.
7. Monitor the Deployment Status and when it reaches 100% click OK.
8. Verify that a check mark displays in the Deployment Status column.
9. Click Done.
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Configure Descriptive Flexfields for Transactional
Business Intelligence  

Overview of Transactional Business Intelligence Configuration of
Descriptive Flexfields  
Configure descriptive flexfields to track unique information not typically found on business forms.

Descriptive flexfields can store several important details on a form without cluttering it. For example, several details may
make an asset form heavy and unmanageable. However, the user still needs to access those details and therefore, they
must be present on the form. In such cases, descriptive flexfields are convenient to use and are easy to manage.

Descriptive flexfields provide a way for you to add attributes to entities and to define validation and display properties
for them. A descriptive flexfield is a logical grouping of attributes (segments) that are mapped to a set of extension
columns which are shipped as part of Oracle Applications Cloud tables.

Related Topics
• Configure Descriptive Flexfield Segments

• Set Descriptive Flexfields as BI-Enabled

Configure Descriptive Flexfield Segments  
If a descriptive flexfield is enabled for Oracle Business Intelligence, you can enable global and context segments for
Oracle Business Intelligence, and you can select segment labels. Not all descriptive flexfields are supported for Business
Intelligence.

Configuring a Descriptive Flexfield Segment
If a descriptive flexfield is enabled for Oracle Business Intelligence, you can enable global and context segments for
Oracle Business Intelligence, and you can select segment labels. Not all descriptive flexfields are supported for Business
Intelligence.

To configure available descriptive flexfield segments:

1. In the Setup and Maintenance work area, go to the Manage Descriptive Flexfields task.
2. If the BI Enabled option is cleared, select it.
3. Select the options for deployment of the descriptive flexfields.
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Related Topics

Set Descriptive Flexfields as BI-Enabled  
If a descriptive flexfield is already defined, you can enable it for use in Business Intelligence reports. Not all descriptive
flexfields are supported for Business Intelligence.

Setting a Flexfield as BI-Enabled

1. In the Setup and Maintenance work area, go to the Manage Descriptive Flexfields task.
2. Navigate to the Edit Descriptive Flexfields window.
3. Enter the descriptive flexfield name.
4. Check the BI Enabled option on the desired descriptive flexfields. If the option is unavailable, the flexfield is a

non-supported entity.
5. Click OK.
6. Click Save.

Configure Extensible Flexfields for Transactional
Business Intelligence  

Configure Extensible Flexfields  
You can use extensible flexfields to configure more segments.

An extensible flexfield is similar to a descriptive flexfield in that it provides an expansion space that you can use to
configure additional attributes (segments) without additional programming. As with descriptive flexfields, each segment
is represented in the database as a single column. However, with extensible flexfields, the context values and context-
sensitive segments are stored in an extension table.

Categories and Contexts

You can combine and arrange the segments into attribute groups that are tailored to your specific needs. For example,
you can group related segments so that they appear together on the page. The attribute groups are referred to as
contexts. You can optionally set up an extensible flexfield to enable categorization of contexts.

You can add contexts and segments to extensible flexfields just like the descriptive flexfields. To see the extensible
flexfields in analyses, you need to deploy them and then run the BI Extender Essbase scheduled process.

Configure Extensible Flexfields
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To configure extensible flexfields:

1. In the Setup and Maintenance work area, go to the Manage Extensible Flexfield task.
2. Search for the EFF you want to configure, then select it and click the Edit icon.
3. In the Edit Extensible Flexfield dialog, highlight the category Display Name, then select Manage Contexts.
4. In the Manage Context dialog, search for the context that contains the segment you want to configure,

highlight it, then click the Edit icon.
5. In the Edit Context dialog, click the Edit icon.
6. Edit the segment, as required, then click Save.

Related Topics
• Flexfield Usages

Set Extensible Flexfields as BI-Enabled  
Extensible flexfields are BI enabled if at least one segment in a context is BI enabled.

Setting Extensible Flexfields as BI-Enabled

To set extensible flexfields as BI-enabled:

1. In the Setup and Maintenance work area, go to the Manage Extensible Flexfields task.
2. Enter the extensible flexfield name; for example, Organization Information EFF.
3. Select the applicable extensible flexfield, and then click Edit.
4. Select the applicable Category. The category contexts are populated automatically.
5. Click Manage Contexts
6. In the Edit Context page, select the applicable Context, and then click Edit.
7. Select the applicable Segment, and then click Edit.
8. In the Edit Segment page, select the BI Enabled check box.
9. Click Save.

Related Topics
• Configure Extensible Flexfields

Overview of the Essbase Rule File and Cubes  
Generate the Essbase rule file by running the Create Rules XML File for BI Extender Automation scheduled process.

The Essbase rule file must be generated for all Oracle Essbase cubes mapped in the repository file (RPD).

Job Status Conditions
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The process status displays one of these conditions.

• INIT: The process has just begun and is waiting for the extender command line JAR to update the status with
more details.

• COMPLETED_NO_EXTENSION_NEEDED: No new Flexfield changes were detected in any of the Oracle
Applications Cloud sources; because the RPD is already synchronized with all Flexfield changes, no changes
were made in the RPD.

• COMPLETED: The RPD was successfully updated with Flexfield changes and uploaded into the Oracle Business
Intelligence server.

• FAILED: Error conditions exist which require manual intervention.

Related Topics
• Submit Scheduled Processes and Process Sets

Import Changes to Flexfields Automatically  

Overview of Flexfield Change Import  
You can use the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process to
import your flexfield changes.

Use the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process to
automatically import the following types of changes:

• Key Flexfield changes

• Descriptive Flexfield changes

• Extensible Flexfield changes

The Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process imports extensible
data, including data in descriptive flexfield segments, key flexfield segments, and General Ledger balances in Essbase
cubes.

If you have changes to key flexfields and descriptive flexfields, you can import all the changes in the same scheduled
process.

This is an Oracle Applications Cloud scheduled process; it's not related to BI Applications. Detailed information on this
process can be found in Oracle Applications Cloud documentation.

Note:  We strongly recommend that you backup the Oracle Transactional Business Intelligence prior to importing any
flexfield changes. Running the process disconnects all users from the server. You should not run this process when
maintenance operations or system updates are being performed on the server.
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Performance and Flexfields
Flexfield changes and additions increase the size of the metadata repository and over time can cause performance
issues or the repository size to exceed limitations. We recommend that you import and enable for BI only those
flexfields that are required. To preserve performance, the following guidelines should be kept in mind:

• Don't BI-enable extensible flexfield (EFF) attributes that aren't needed for analysis in OTBI.

• Disable EFF attributes that are no longer being used. Limit the number of attributes that are inherited by a large
number of classes to be BI enabled, as this results in increased repository size.

Run the Import Scheduled Process  
To import changes, run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled
process.

Run the Job
To run the process:

1. In the Scheduled Processes window, select Search and Select: Name.
2. Select Search and Select: Name.
3. Highlight Import Oracle Fusion Data Extensions for Transactional Business Intelligence.
4. Click OK.
5. Schedule the process.

Process Status Conditions
When the process is finished, the biExtenderCMDUtility.jar writes the status of the process into the JNDI file
ess_biExtenderEssJob_jobStatus, which can be viewed in Oracle WebLogic Server.

The process status displays one of the following conditions:

• INIT: The process has just begun and is waiting for the extender command line JAR to update the status with
more details.

• COMPLETED_NO_EXTENSION_NEEDED: No new Flexfield changes were detected in any of the Oracle
Applications Cloud sources; because the Oracle Business Intelligence is already synchronized with all Flexfield
changes, no changes were made in the Oracle Business Intelligence.

• COMPLETED: Oracle Business Intelligence was successfully updated with Flexfield changes and uploaded into
the Oracle Business Intelligence Server.

• COMPLETED: PROCESS_ERRORS: Oracle Business Intelligence was updated with the Flexfield changes but with
some warnings that require manual intervention.

• FAILED: Error conditions exist that require manual intervention.

Successful Import Process
If the import process is successful, you can perform the following actions:

• Query subject areas by segment dimensions such as Balancing Segment and Cost Center.

• Access DFF attributes for analyses.
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• Use the General Ledger - Balances Real Time subject area to query Oracle Essbase cubes.

Disable Flexfields as BI-Enabled  

Overview  
If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.

There may be times, such as during development phases, when you try using a flexfield and later determine it is no
longer needed.

Note:  If you are considering disabling flexfields, keep in mind that any flexfields created in Oracle Applications Cloud
must be designated as BI-enabled to be exposed in Transactional Business Intelligence. If you disable a flexfield, it
cannot be deployed. Also, error conditions may occur if you disable a descriptive flexfield that has been implemented
in BI Applications. If error conditions arise from disabling flexfields as BI-enabled, troubleshooting the errors can be
difficult and time-consuming.

Related Topics
• Disable Key Flexfields as BI-Enabled

• Disable Descriptive Flexfields as BI-Enabled

• Disable Extensible Flexfields as BI-Enabled

Disable Key Flexfields as BI-Enabled  
If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.

If you are considering disabling key flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must
be designated as BI-enabled to be exposed in Transactional Business Intelligence.

Disabling Key Flexfields

To disable key flexfields as BI-enabled:

1. In the Setup and Maintenance work area, go to the Manage Key Flexfields task.
2. Enter your search value in Key Flexfield Code.
3. Click Manage Structure Instances.
4. Enter your search value in Structure Instance Code.
5. Click Edit. The Edit Key Flexfield Structure Instance dialog box displays.
6. In Edit Key Flexfield Segment Instance, deselect the BI Enabled option.
7. Click OK, then Save.
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Disable Descriptive Flexfields as BI-Enabled  
If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.

If you are considering disabling descriptive flexfields, keep in mind that any flexfields created in Oracle Applications
Cloud must be designated as BI-enabled to be exposed in Transactional Business Intelligence.

Disabling Descriptive Flexfields

To disable descriptive flexfields as BI-enabled:

1. In the Setup and Maintenance work area, go to the Manage Descriptive Flexfields task.
2. Enter the Descriptive Flexfield Name.
3. Deselect the BI Enabled option on the desired descriptive flexfields.
4. Click OK, then Save.

Repository and Session Variables for Business Intelligence  
This table shows repository and session variables available for use in your analyses.

Variable Name Type Usage Offering

CURRENT_DAY
 

Session Variable
 

Returns the value of Current Date.
 

All
 

CURRENT_MONTH
 

Repository Variable
 

Returns the value of Current Month
in the YYYY/MM format.
 

All
 

CURRENT_WEEK
 

Repository Variable
 

Returns the value of the current
week in YYYY Weeknnn format.
 

All
 

CURRENT_QUARTER
 

Repository Variable
 

Returns the value of Current
Quarter in YYYY Q n format.
 

All
 

CURRENT_YEAR
 

Repository Variable
 

Returns the value of Current Year
in the YYYY format.
 

All
 

DISPLAYNAME Session Variable Returns the username displayed
to the user in the greeting, used as
the author field for catalog objects
when they're saved.

All

NEXT_MONTH
 

Repository Variable
 

Returns the value of Next Month in
the YYYY / MM format.
 

All
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Variable Name Type Usage Offering

NEXT_WEEK
 

Repository Variable
 

Returns the value of Next Week in
the YYYY Week nn format.
 

All
 

NEXT_QUARTER
 

Repository Variable
 

Returns the value of Next Calendar
Quarter in the YYYY Q nn format.
 

All
 

NEXT_YEAR
 

Repository Variable
 

Returns the value of Next Year in
the YYYY format.
 

All
 

PREVIOUS_MONTH
 

Repository Variable
 

Returns the value of Previous
Month in the YYYY/MM format.
 

All
 

PREVIOUS_WEEK
 

Repository Variable
 

Returns the value of Previous Week
in the YYYY Week nn format.
 

All
 

PREVIOUS_QUARTER
 

Repository Variable
 

Returns the value of Previous
Quarter in the YYYY Q nn format.
 

All
 

USER Session Variable Holds the value the user enters
when logging in.

All

Financials Descriptive Flexfields for Business Intelligence
 
This table shows the descriptive flexfields and the subject areas in which you can use these flexfields. To view the
descriptive flexfield columns, navigate to the appropriate folder within the relevant subject area.

Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

AP_CHECKS
 

Payables Payments -
Disbursements Real Time
 

Payment Information
 

Payment Header Details
 

AP_HOLDS
 

Payables Invoices - Transactions
Real Time
 

Invoice Hold Information
 

Invoice Details
 

AP_HOLDS
 

Payables Invoices - Transactions
Real Time
 

Invoice Line Details - Hold
Information
 

Invoice Lines
 

AP_INVOICE_DISTRIBUTIONS
 

Payables Invoices - Transactions
Real Time
 

Invoice Distribution Details -
General Information
 

Distributions
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

AP_INVOICE_DISTRIBUTIONS
 

Payables Invoices - Prepayment
Applications Real Time
 

Invoice Distribution Details -
General Information
 

Distributions
 

AP_INVOICE_LINES
 

Payables Invoices - Transactions
Real Time
 

Invoice Line Details - General
Information
 

Invoice Lines
 

AP_INVOICE_LINES
 

Payables Invoices - Prepayment
Applications Real Time
 

Invoice Line Details - General
Information
 

Invoice Lines
 

AP_INVOICES
 

Payables Invoices - Transactions
Real Time
 

General Information
 

Invoice Details
 

AP_INVOICES
 

Payables Invoices - Prepayment
Applications Real Time
 

General Information
 

Invoice Details
 

AP_INVOICES
 

Expenses - Cash Advances Real
Time
 

General Information
 

Invoice Details
 

AP_PAYMENT_SCHEDULES
 

Payables Invoices - Installments
Real Time
 

Invoices Installment Details
 

 

AR_ADJUSTMENTS
 

Receivables - Adjustments Real
Time
 

Adjustments Details
 

 

AR_APPROVAL_ACTION_HISTORY
 

Receivables - Adjustments Real
Time
 

Adjustments Details
 

 

AR_BATCHES
 

Receivables - Miscellaneous
Receipts Real Time
 

Miscellaneous Receipts Details
 

 

AR_BATCHES
 

Receivables - Standard Receipts
Application Details Real Time
 

Standard Receipt Details
 

 

AR_CASH_RECEIPTS
 

Receivables - Standard Receipts
Application Details Real Time
 

Standard Receipt Details
 

 

AR_CASH_RECEIPTS
 

Receivables - Miscellaneous
Receipts Real Time
 

Miscellaneous Receipts Details
 

 

AR_CUSTOMER_PROFILE_
AMOUNTS_HZ
 

Receivables - Customer Real Time
 

Profile Late Charges Rates And
Conditions
 

Customer Accounts - Customer
Account Profile
 

AR_CUSTOMER_PROFILE_
AMOUNTS_HZ
 

Receivables - Customer Real Time
 

Site Profile Late Charges and
Reductions
 

Customer Account Site - Customer
Account Site Profile
 

AR_CUSTOMER_PROFILE_
CLASSES_HZ

Receivables - Customer Real Time
 

Profile Class
 

Customer Accounts - Customer
Account Profile
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

  

AR_CUSTOMER_PROFILE_
CLASSES_HZ
 

Receivables - Customer Real Time
 

Site Profile Class
 

Customer Account Site - Customer
Account Site Profile
 

AR_CUSTOMER_PROFILES_HZ
 

Receivables - Customer Real Time
 

Profile Class
 

Customer Accounts - Customer
Account Profile
 

AR_CUSTOMER_PROFILES_HZ
 

Receivables - Customer Real Time
 

Site Profile Class
 

Customer Account Site - Customer
Account Site Profile
 

AR_MISC_CASH_DISTRIBUTIONS
 

Receivables - Miscellaneous
Receipts Real Time
 

Miscellaneous Receipt
Distributions Details
 

Miscellaneous Receipt
Distributions
 

AR_PAYMENT_SCHEDULES
 

Receivables - Payment Schedules
Real Time
 

Payment Schedules Details
 

 

AR_RATE_ADJUSTMENTS
 

Receivables - Receipt Conversion
Rate Adjustments Real time
 

Receipt Conversion Rate
Adjustments Details
 

 

AR_RECEIPT_CLASSES
 

Receivables - Standard Receipts
Application Details Real Time
 

Standard Receipt Details
 

 

AR_RECEIPT_METHODS
 

Receivables - Standard Receipts
Application Details Real Time
 

Standard Receipt Details
 

 

AR_RECEIVABLE_APPLICATIONS
 

Receivables - Standard Receipts
Application Details Real Time
 

Standard Receipt Application
Details
 

 

AR_RECEIVABLE_APPLICATIONS
 

Receivables - Credit Memo
Applications Real Time
 

Credit Memo Application Details
 

 

AR_REVENUE_ADJUSTMENTS
 

Receivables - Revenue
Adjustments Real Time
 

Revenue Adjustments Details
 

 

CE_BANK_ACCOUNTS
 

Cash Management - Bank
Statements Real Time
 

Bank Account
 

 

CE_BANK_ACCOUNTS
 

Receivables - Bills Receivable Real
Time
 

Bills Receivable Remittance
 

Bills Receivable Details
 

CE_EXTERNAL_TRANSACTIONS
 

Cash Management - External Cash
Transactions Real Time
 

External Cash Transaction Detail
 

External Cash Transaction Detail
 

CE_STATEMENT_HEADERS
 

Cash Management - Bank
Statements Real Time
 

Header Information
 

Bank Statement Detail
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

CE_STATEMENT_LINES
 

Cash Management - Bank
Statements Real Time
 

Line Information
 

Bank Statement Detail
 

EXM_CASH_ADVANCES
 

Expenses - Expense Transactions
Real Time
 

Cash Advance Details
 

Expense Information - Expense
Reports
 

EXM_CASH_ADVANCES
 

Expenses - Cash Advances Real
Time
 

Cash Advance Details
 

 

EXM_EXPENSES
 

Expenses - Expense Transactions
Real Time
 

Expense Line Details
 

Expense Information - Expense
Lines
 

EXM_EXPENSE_REPORT_HEADER
 

Expenses - Expense Transactions
Real Time
 

Expense Report Details
 

Expense Information - Expense
Reports
 

EXM_EXPENSE_REPORT_HEADER
 

Expenses - Cash Advances Real
Time
 

Expense Report Details
 

Cash Advance Application Details
 

EXM_EXPENSE_ATTENDEES
 

Expenses - Expense Transactions
Real Time
 

Expense Line Attendee Details
 

Expense Information - Expense
Lines
 

FA_ADDITIONS
 

Fixed Assets - Asset Transactions
Real Time
 

Descriptive Details
 

Fixed Asset
 

FA_ADDITIONS
 

Fixed Assets - Asset Balances Real
Time
 

Descriptive Details
 

Fixed Asset
 

FA_ADDITIONS
 

Fixed Assets - Asset Depreciation
Real Time
 

Descriptive Details
 

Fixed Asset
 

FA_BOOK_CONTROLS
 

Fixed Assets - Asset Transactions
Real Time
 

General Information
 

Asset Book
 

FA_BOOK_CONTROLS
 

Fixed Assets - Asset Balances Real
Time
 

General Information
 

Asset Book
 

FA_BOOK_CONTROLS
 

Fixed Assets - Asset Depreciation
Real Time
 

General Information
 

Asset Book
 

FA_CATEGORIES
 

Fixed Assets - Asset Transactions
Real Time
 

Asset Category
 

 

FA_CATEGORIES
 

Procurement - Spend Real Time
 

Asset Category
 

Invoice Details
 

FA_CATEGORIES
 

Project Costing - Assets Real Time
 

Project Asset
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

FA_CATEGORIES
 

Fixed Assets - Asset Balances Real
Time
 

Asset Category
 

 

FA_CATEGORIES
 

Fixed Assets - Asset Depreciation
Real Time
 

Asset Category
 

 

FA_CATEGORY_BOOK_DEFAULTS
 

Fixed Assets - Asset Transactions
Real Time
 

Asset Category Book Default
 

 

FA_CATEGORY_BOOK_DEFAULTS
 

Fixed Assets - Asset Depreciation
Real Time
 

Asset Category Book Default
 

 

FA_CATEGORY_BOOK_DEFAULTS
 

Fixed Assets - Asset Balances Real
Time
 

Asset Category Book Default
 

 

FA_CATEGORY_BOOKS
 

Fixed Assets - Asset Transactions
Real Time
 

Asset Category Book
 

 

FA_CATEGORY_BOOKS
 

Fixed Assets - Asset Balances Real
Time
 

Asset Category Book
 

 

FA_CATEGORY_BOOKS
 

Fixed Assets - Asset Depreciation
Real Time
 

Asset Category Book
 

 

FA_LOCATIONS
 

Fixed Assets - Asset Transactions
Real Time
 

Asset Location
 

 

FA_LOCATIONS
 

Project Costing - Assets Real Time
 

Project Asset
 

 

FA_LOCATIONS
 

Fixed Assets - Asset Balances Real
Time
 

Asset Location
 

 

FA_LOCATIONS
 

Fixed Assets - Asset Depreciation
Real Time
 

Asset Location
 

 

FA_RETIREMENTS
 

Fixed Assets - Asset Transactions
Real Time
 

Retirement Details
 

 

FA_TRANSACTION_HEADERS
 

Fixed Assets - Asset Transactions
Real Time
 

Asset Transaction Details
 

 

FUN_DIST_LINES
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Distribution Details
 

Intercompany Distributions
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

FUN_INTERCO_ORGANIZATIONS
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Transaction Details
 

Intercompany Transactions
 

FUN_TRX_BATCHES
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Batch Details
 

Intercompany Transactions
 

FUN_TRX_HEADERS
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Transaction Details
 

Intercompany Transactions
 

FUN_TRX_TYPES
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Intercompany Transaction Type
 

 

GL_CAPTURED_INFO
 

General Ledger - Journals Real
Time
 

Journal Line Details
 

Journal Lines
 

GL_CODE_COMBINATIONS
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Account
 

Intercompany Distributions
 

GL_CODE_COMBINATIONS
 

Receivables - Revenue
Adjustments Real Time
 

GL Account
 

Receivables Revenue Adjustment
Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Bills Receivable Real
Time
 

GL Account
 

Bills Receivable Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Adjustments Real
Time
 

GL Account
 

Receivables Adjustment
Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Credit Memo
Applications Real Time
 

GL Account
 

Receivables Credit Memo
Application Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Standard Receipts
Application Details Real Time
 

GL Account
 

Standard Receipt Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Miscellaneous
Receipts Real Time
 

GL Account
 

Miscellaneous Receipt Accounting
 

GL_CODE_COMBINATIONS
 

Subledger Accounting - Supporting
References Real Time
 

GL Account
 

 

GL_CODE_COMBINATIONS
 

Subledger Accounting - Payables
Summary Reconciliation Real Time
 

General Ledger Account
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

GL_CODE_COMBINATIONS
 

Subledger Accounting
- Receivables Summary
Reconciliation Real Time
 

General Ledger Account
 

 

GL_CODE_COMBINATIONS
 

Payables Invoices - Prepayment
Applications Real Time
 

Account
 

Prepayment Application
Accounting
 

GL_CODE_COMBINATIONS
 

Payables Invoices - Transactions
Real Time
 

Account
 

Accounting
 

GL_CODE_COMBINATIONS
 

Payables Payments -
Disbursements Real Time
 

Account
 

Accounting
 

GL_CODE_COMBINATIONS
 

General Ledger - Journals Real
Time
 

Account
 

Journal Lines
 

GL_CODE_COMBINATIONS
 

Subledger Accounting - Journals
Real Time
 

GL Account
 

 

GL_CODE_COMBINATIONS
 

Receivables - Receipts Details Real
Time
 

GL Account
 

Receipt Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Transactions Real
Time
 

GL Account
 

Receivables Transaction
Accounting
 

GL_CODE_COMBINATIONS
 

Payables Invoices - Trial Balance
Real Time
 

Account
 

 

GL_CODE_COMBINATIONS
 

General Ledger - Transactional
Balances Real Time
 

Account
 

 

GL_CODE_COMBINATIONS
 

Revenue Management - Customer
Contracts Real Time
 

GL Account
 

Promised Details - Accounting
 

GL_CODE_COMBINATIONS
 

Expenses - Expense Transactions
Real Time
 

Account
 

Expense Information - Expense
Distributions
 

GL_CODE_COMBINATIONS
 

Payables Invoices - Prepayment
Applications Real Time
 

Liability Account
 

Prepayment Applications -
Distribution Details
 

GL_CODE_COMBINATIONS
 

Payables Invoices - Transactions
Real Time
 

Liability Account
 

Distributions
 

GL_CODE_COMBINATIONS
 

Payables Invoices - Prepayment
Applications Real Time
 

Distribution Combination
 

Prepayment Applications -
Distribution Details
 

50



Oracle Fusion Cloud Financials
Creating and Administering Analytics and Reports for
Financials

Chapter 3
Flexfields

Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

GL_CODE_COMBINATIONS
 

Payables Invoices - Transactions
Real Time
 

Distribution Combination
 

Distributions
 

GL_CODE_COMBINATIONS
 

Payables Invoices - Transactions
Real Time
 

Invoice Self-Assessed Tax
Distribution Liability Account
 

 

GL_CODE_COMBINATIONS
 

Payables Invoices - Transactions
Real Time
 

Invoice Self-Assessed Tax Account
 

 

GL_CODE_COMBINATIONS
 

Receivables - Revenue
Adjustments Real Time
 

Distribution Combination
 

Receivables Revenue Adjustment
Distributions
 

GL_CODE_COMBINATIONS
 

Receivables - Adjustments Real
Time
 

Distribution Combination
 

Receivables Adjustment
Distributions
 

GL_CODE_COMBINATIONS
 

Receivables - Bills Receivable Real
Time
 

Distribution Combination
 

Bills Receivable Distributions
 

GL_CODE_COMBINATIONS
 

Receivables - Credit Memo
Applications Real Time
 

Distribution Combination
 

Receivables Credit Memo
Application Distributions
 

GL_CODE_COMBINATIONS
 

Receivables - Standard Receipts
Application Details Real Time
 

Distribution Combination
 

Standard Receipt Distributions
 

GL_CODE_COMBINATIONS
 

Receivables - Miscellaneous
Receipts Real Time
 

Distribution Combination
 

Miscellaneous Receipt
Distributions
 

GL_CODE_COMBINATIONS
 

Receivables - Receipts Details Real
Time
 

Distribution Combination
 

Receipt Distributions
 

GL_CODE_COMBINATIONS
 

Receivables - Transactions Real
Time
 

Distribution Combination
 

Receivables Transaction
Distributions
 

GL_CODE_COMBINATIONS
 

Fixed Assets - Asset Transactions
Real Time
 

Asset Depreciation Expense
Account
 

Account
 

GL_CODE_COMBINATIONS
 

Fixed Assets - Asset Depreciation
Real Time
 

Asset Depreciation Expense
Account
 

Account
 

GL_CODE_COMBINATIONS
 

Cash Management - External Cash
Transactions Real Time
 

Asset Account
 

 

GL_CODE_COMBINATIONS
 

Cash Management - External Cash
Transactions Real Time
 

Offset Account
 

 

GL_CODE_COMBINATIONS
 

Fixed Assets - Asset Transactions
Real Time

GL Account
 

Transaction Accounting Details
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

 

GL_CODE_COMBINATIONS
 

Fixed Assets - Asset Depreciation
Real Time
 

GL Account
 

Depreciation Accounting Details
 

GL_CODE_COMBINATIONS
 

Receivables - Transactions Real
Time
 

GL Overridden Account
 

Receivables Transaction
Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Adjustments Real
Time
 

GL Overridden Account
 

Receivables Adjustment
Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Miscellaneous
Receipts Real Time
 

GL Overridden Account
 

Miscellaneous Receipt Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Credit Memo
Applications Real Time
 

GL Overridden Account
 

Receivables Credit Memo
Application Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Receipts Details Real
Time
 

GL Overridden Account
 

Receipt Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Revenue
Adjustments Real Time
 

GL Overridden Account
 

Receivables Revenue Adjustment
Accounting
 

GL_CODE_COMBINATIONS
 

Receivables - Standard Receipts
Application Details Real Time
 

GL Overridden Account
 

Standard Receipt Accounting
 

GL_CODE_COMBINATIONS
 

Payables Invoices - Transactions
Real Time
 

Overridden Account
 

Accounting
 

GL_CODE_COMBINATIONS
 

Payables Invoices - Prepayment
Applications Real Time
 

Overridden Account
 

Prepayment Application
Accounting
 

GL_CODE_COMBINATIONS
 

Payables Payments -
Disbursements Real Time
 

Overridden Account
 

Accounting
 

GL_CODE_COMBINATIONS
 

Fixed Assets - Asset Transactions
Real Time
 

Overridden Account
 

Transaction Accounting Details
 

GL_CODE_COMBINATIONS
 

Subledger Accounting - Journals
Real Time
 

GL Overridden Account
 

 

GL_CODE_COMBINATIONS
 

Receivables - Bills Receivable Real
Time
 

GL Overridden Account
 

Bills Receivable Accounting
 

GL_CODE_COMBINATIONS
 

Fixed Assets - Asset Balances Real
Time
 

Asset Account
 

Account
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

GL_ENCUMB_TYPES
 

General Ledger - Journals Real
Time
 

Balance Subtype
 

Journal Header
 

GL_ENCUMB_TYPES
 

Subledger Accounting - Journals
Real Time
 

Journal Details
 

 

GL_ENCUMB_TYPES
 

General Ledger - Transactional
Balances Real Time
 

Scenario
 

 

GL_JE_BATCHES
 

General Ledger - Journals Real
Time
 

Journal Batch Details
 

Journal Batches
 

GL_JE_CATEGORIES
 

General Ledger - Journals Real
Time
 

Journal Category
 

Journal Header
 

GL_JE_HEADERS
 

General Ledger - Journals Real
Time
 

Header Details
 

Journal Header
 

GL_JE_LINES
 

General Ledger - Journals Real
Time
 

Journal Line Details
 

Journal Lines
 

GL_JE_SOURCES
 

General Ledger - Journals Real
Time
 

Journal Source
 

Journal Batches
 

GL_LEDGERS
 

Fixed Assets - Asset Transactions
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Fixed Assets - Asset Depreciation
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Fixed Assets - Asset Source Lines
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Fixed Assets - Asset Financial
Information Real Time
 

Ledger
 

 

GL_LEDGERS
 

Fixed Assets - Asset Balances Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Fixed Assets - Asset Retirements
and Reinstatements Real Time
 

Ledger
 

 

GL_LEDGERS
 

Fixed Assets - Asset Transfer Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Revenue
Adjustments Real Time

Ledger
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

 

GL_LEDGERS
 

Receivables - Credit Memo
Requests Real Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Payment Schedules
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Adjustments Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Bills Receivable Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Credit Memo
Applications Real Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Receipt Conversion
Rate Adjustments Real Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Standard Receipts
Application Details Real Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Miscellaneous
Receipts Real Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Receipts Details Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Receivables - Transactions Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Payables Invoices - Prepayment
Applications Real Time
 

Ledger
 

 

GL_LEDGERS
 

Payables Payments - Payment
History Real Time
 

Ledger
 

 

GL_LEDGERS
 

Payables Invoices - Holds Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Payables Invoices - Trial Balance
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Payables Invoices - Installments
Real Time
 

Ledger
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Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

GL_LEDGERS
 

Payables Invoices - Transactions
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Payables Payments -
Disbursements Real Time
 

Ledger
 

 

GL_LEDGERS
 

General Ledger - Journals Real
Time
 

Ledger
 

Journal Header
 

GL_LEDGERS
 

General Ledger - Transactional
Balances Real Time
 

Ledger
 

 

GL_LEDGERS
 

General Ledger - Period Status Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Subledger Accounting - Journals
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Subledger Accounting - Supporting
References Real Time
 

Ledger
 

 

GL_LEDGERS
 

Costing - Cost Accounting Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Costing - COGS and Gross Margin
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Costing - Receipt Accounting Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Project Costing - Actual Costs Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Project Billing - Revenue Real Time
 

Ledger
 

 

GL_LEDGERS
 

Revenue Management -
Standalone Selling Price Real Time
 

Ledger
 

Standalone Selling Price Source
Document - Source Document
 

GL_LEDGERS
 

Revenue Management - Customer
Contracts Real Time
 

Ledger
 

 

GL_LEDGERS
 

Budgetary Control - Transactions
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Budgetary Control - Balances Real
Time
 

Ledger
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GL_LEDGERS
 

Expenses - Expense Transactions
Real Time
 

Ledger
 

 

GL_LEDGERS
 

Expenses - Employee Expense
Overview Real Time
 

Ledger
 

 

GL_LEDGERS
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Initiating Ledger
 

 

GL_LEDGERS
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Receiving Ledger
 

 

GL_LEDGERS
 

Expenses - Cash Advances Real
Time
 

Ledger
 

 

GL_LEDGERS
 

Cash Management - Bank
Statement Balances Real Time
 

Ledger
 

 

GL_LEDGERS
 

Cash Management - Bank
Statement Line Charges Real Time
 

Ledger
 

 

GL_LEDGERS
 

Cash Management - Bank
Statements Real Time
 

Ledger
 

 

GL_LEDGERS
 

Cash Management - External Cash
Transactions Real Time
 

Ledger
 

 

GL_PERIOD_STATUSES
 

General Ledger - Period Status Real
Time
 

Period Statuses
 

 

GL_PERIODS
 

Receivables - Revenue
Adjustments Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Receivables - Credit Memo
Requests Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Receivables - Payment Schedules
Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Receivables - Adjustments Real
Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Receivables - Bills Receivable Real
Time
 

Fiscal Calendar
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GL_PERIODS
 

Receivables - Credit Memo
Applications Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Receivables - Receipt Conversion
Rate Adjustments Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Receivables - Standard Receipts
Application Details Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Receivables - Miscellaneous
Receipts Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Receivables - Receipts Details Real
Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Receivables - Transactions Real
Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Payables Invoices - Prepayment
Applications Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Payables Payments - Payment
History Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Payables Invoices - Holds Real
Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Payables Invoices - Trial Balance
Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Payables Invoices - Installments
Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Payables Invoices - Transactions
Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Payables Payments -
Disbursements Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

General Ledger - Journals Real
Time
 

Time
 

 

GL_PERIODS
 

General Ledger - Transactional
Balances Real Time
 

Time
 

 

GL_PERIODS
 

General Ledger - Period Status Real
Time

Time
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GL_PERIODS
 

Subledger Accounting - Journals
Real Time
 

Time
 

 

GL_PERIODS
 

Subledger Accounting - Supporting
References Real Time
 

Time
 

 

GL_PERIODS
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Time
 

 

GL_PERIODS
 

Revenue Management - Customer
Contracts Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Budgetary Control - Transactions
Real Time
 

Time
 

 

GL_PERIODS
 

Budgetary Control - Balances Real
Time
 

Time
 

 

GL_PERIODS
 

Expenses - Expense Transactions
Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Expenses - Cash Advances Real
Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Payables Invoices - Prepayment
Applications Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Prepayment Applications -
Distribution Details
 

GL_PERIODS
 

Payables Invoices - Transactions
Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Distributions
 

GL_PERIODS
 

Payables Payments -
Disbursements Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Payment Details
 

GL_PERIODS
 

Cash Management - Bank
Statement Balances Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Cash Management - Bank
Statement Line Charges Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Cash Management - Bank
Statement Real Time
 

Fiscal Calendar
 

 

GL_PERIODS
 

Cash Management - External Cash
Transactions Real Time
 

Transaction Date (Fiscal)
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GL_PERIODS
 

Fixed Assets - Asset Depreciation
Real Time
 

GL Accounting Date Fiscal
Calendar
 

Depreciation Accounting Details
 

GL_PERIODS
 

Fixed Assets - Asset Transactions
Real Time
 

GL Accounting Date Fiscal
Calendar
 

Transaction Accounting Details
 

GL_PERIODS
 

Payables Invoices - Prepayment
Applications Real Time
 

Accounting Date Fiscal Calendar
 

Prepayment Application
Accounting
 

GL_PERIODS
 

Payables Invoices - Transactions
Real Time
 

Accounting Date Fiscal Calendar
 

Accounting
 

GL_PERIODS
 

Payables Payments -
Disbursements Real Time
 

Accounting Date Fiscal Calendar
 

Accounting
 

GL_PERIODS
 

Receivables - Adjustments Real
Time
 

GL Accounting Date Fiscal
Calendar
 

Receivables Adjustment
Accounting
 

GL_PERIODS
 

Receivables - Bills Receivable Real
Time
 

GL Accounting Date Fiscal
Calendar
 

Bills Receivable Accounting
 

GL_PERIODS
 

Receivables - Credit Memo
Applications Real Time
 

GL Accounting Date Fiscal
Calendar
 

Receivables Credit Memo
Application Accounting
 

GL_PERIODS
 

Receivables - Miscellaneous
Receipts Real Time
 

GL Accounting Date Fiscal
Calendar
 

Miscellaneous Receipt Accounting
 

GL_PERIODS
 

Receivables - Receipts Details Real
Time
 

GL Accounting Date Fiscal
Calendar
 

Receipt Accounting
 

GL_PERIODS
 

Receivables - Revenue
Adjustments Real Time
 

GL Accounting Date Fiscal
Calendar
 

Receivables Revenue Adjustment
Accounting
 

GL_PERIODS
 

Receivables - Standard Receipts
Application Details Real Time
 

GL Accounting Date Fiscal
Calendar
 

Standard Receipt Accounting
 

GL_PERIODS
 

Receivables - Transactions Real
Time
 

GL Accounting Date Fiscal
Calendar
 

Receivables Transaction
Accounting
 

GL_PERIODS
 

Revenue Management - Customer
Contracts Real Time
 

GL Accounting Date Fiscal
Calendar
 

Promised Details - Accounting
 

GL_PERIODS
 

Receivables - Adjustments Real
Time
 

Distribution Accounting Date Fiscal
Calendar
 

Receivables Adjustment
Distributions
 

GL_PERIODS
 

Receivables - Bills Receivable Real
Time

Distribution Accounting Date Fiscal
Calendar

Bills Receivable Distributions
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GL_PERIODS
 

Receivables - Credit Memo
Applications Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Receivables Credit Memo
Application Distributions
 

GL_PERIODS
 

Receivables - Miscellaneous
Receipts Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Miscellaneous Receipt
Distributions
 

GL_PERIODS
 

Receivables - Receipts Details Real
Time
 

Distribution Accounting Date Fiscal
Calendar
 

Receipt Distributions
 

GL_PERIODS
 

Receivables - Revenue
Adjustments Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Receivables Revenue Adjustment
Distributions
 

GL_PERIODS
 

Receivables - Standard Receipts
Application Details Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Standard Receipt Distributions
 

GL_PERIODS
 

Receivables - Transactions Real
Time
 

Distribution Accounting Date Fiscal
Calendar
 

Receivables Transaction
Distributions
 

GL_PERIODS
 

Revenue Management -
Standalone Selling Price Real Time
 

Document Fiscal Calendar
 

Standalone Selling Price Source
Document - Source Document
 

GL_PERIODS
 

Revenue Management - Customer
Contracts Real Time
 

Document Fiscal Calendar
 

Promised Details - Promised
Detail Source Document - Source
Document
 

GL_PERIODS
 

Expenses - Cash Advances Real
Time
 

Fiscal Calendar
 

 

HZ_CONTACT_POINTS
 

Receivables - Customer Real Time
 

Contact User Details
 

Customer Accounts - Customer
Account Contacts
 

HZ_CONTACT_POINTS
 

Receivables - Customer Real Time
 

Site Contact User Details
 

Customer Account Site - Customer
Account Site Contacts
 

HZ_CUST_ACCOUNT_ROLES
 

Receivables - Customer Real Time
 

Contact Details
 

Customer Accounts - Customer
Account Contacts
 

HZ_CUST_ACCOUNT_ROLES
 

Receivables - Customer Real Time
 

Site Contact Details
 

Customer Account Site - Customer
Account Site Contacts
 

HZ_CUST_ACCOUNTS
 

Receivables - Customer Real Time
 

Customer Account Details
 

Customer Accounts
 

HZ_CUST_ACCOUNTS
 

Receivables - Customer Account
Site Tax Profile Real Time
 

Customer Account Details
 

Customer Accounts
 

HZ_CUST_ACCT_RELATE_ALL Receivables - Customer Real Time Customer Account Relationships Customer Accounts
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HZ_CUST_ACCT_SITES_ALL
 

Receivables - Customer Real Time
 

Site Address
 

Customer Account Site - Customer
Account Site Details
 

HZ_CUST_ACCT_SITES_ALL
 

Receivables - Customer Account
Site Tax Profile Real TIme
 

Site Address
 

Customer Account Site - Customer
Account Site Details
 

HZ_CUST_SITE_USES_ALL
 

Receivables - Customer Real Time
 

Site Address Purpose
 

Customer Account Site - Customer
Account Site Details
 

HZ_CUST_SITE_USES_ALL
 

Receivables - Customer Account
Site Tax Profile Real TIme
 

Site Address Purpose
 

Customer Account Site - Customer
Account Site Details
 

HZ_LOCATIONS
 

Receivables - Customer Real Time
 

Site Address
 

Customer Account Site - Customer
Account Site Details
 

HZ_LOCATIONS
 

Receivables - Customer Account
Site Tax Profile Real TIme
 

Site Address
 

Customer Account Site - Customer
Account Site Details
 

HZ_ORG_CONTACTS
 

Receivables - Customer Real Time
 

Contact User Responsibilities
 

Customer Accounts - Customer
Account Contacts
 

HZ_ORG_CONTACTS
 

Receivables - Customer Real Time
 

Site Contact User Responsibilities
 

Customer Account Site - Customer
Account Site Contacts
 

HZ_ORGANIZATION_PROFILES
 

Receivables - Customer Real Time
 

Customer Information
 

Customer
 

HZ_ORGANIZATION_PROFILES
 

Receivables - Customer Tax Profile
Real TIme
 

Customer Information
 

Customer
 

HZ_ORGANIZATION_PROFILES
 

Receivables - Customer Account
Site Tax Profile Real Time
 

Customer Information
 

Customer
 

HZ_ORIG_SYS_REFERENCES
 

Receivables - Customer Real Time
 

Customer Information
 

Customer
 

HZ_ORIG_SYS_REFERENCES
 

Receivables - Customer Tax Profile
Real TIme
 

Customer Information
 

Customer
 

HZ_ORIG_SYS_REFERENCES
 

Receivables - Customer Account
Site Tax Profile Real Time
 

Customer Information
 

Customer
 

HZ_PARTY_SITES
 

Receivables - Customer Real Time
 

Site Address
 

Customer Account Site - Customer
Account Site Details
 

HZ_PARTY_SITES
 

Receivables - Customer Account
Site Tax Profile Real TIme
 

Site Address
 

Customer Account Site - Customer
Account Site Details
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HZ_ROLE_RESPONSIBILITY
 

Receivables - Customer Real Time
 

Contact User Responsibilities
 

Customer Accounts - Customer
Account Contacts
 

HZ_ROLE_RESPONSIBILITY
 

Receivables - Customer Real Time
 

Site Contact User Responsibilities
 

Customer Account Site - Customer
Account Site Contacts
 

IBY_EXT_BANK_ACCOUNTS
 

Receivables - Customer Real Time
 

Customer Account Bank Account
Details
 

Customer Accounts
 

IBY_EXT_BANK_ACCOUNTS
 

Receivables - Customer Real Time
 

Customer Account Site Bank
Account Details
 

Customer Account Site
 

JE_POZ_SUPPLIERS
 

Payables Invoices - Holds Real
Time
 

Supplier
 

 

JE_POZ_SUPPLIERS
 

Payables Invoices - Installments
Real Time
 

Supplier
 

 

JE_POZ_SUPPLIERS
 

Payables Invoices - Prepayment
Applications Real Time
 

Supplier
 

 

JE_POZ_SUPPLIERS
 

Payables Invoices - Transactions
Real Time
 

Supplier
 

 

JE_POZ_SUPPLIERS
 

Payables Invoices - Trial Balance
Real Time
 

Supplier
 

 

JE_POZ_SUPPLIERS
 

Payables Invoices - Withholding
Real Time
 

Supplier
 

 

JE_POZ_SUPPLIERS
 

Payables Payments -
Disbursements Real Time
 

Supplier
 

 

JE_POZ_SUPPLIERS
 

Payables Payments - Payment
History Real Time
 

Supplier
 

 

JE_POZ_SUPPLIERS
 

Subledger Accounting - Journals
Real Time
 

Supplier Profile
 

Supplier
 

JE_POZ_SUPPLIERS_SITES
 

Payables Invoices - Holds Real
Time
 

Supplier Site
 

 

JE_POZ_SUPPLIERS_SITES
 

Payables Invoices - Installments
Real Time
 

Supplier Site
 

 

JE_POZ_SUPPLIERS_SITES
 

Payables Invoices - Prepayment
Applications Real Time

Supplier Site
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JE_POZ_SUPPLIERS_SITES
 

Payables Invoices - Transactions
Real Time
 

Supplier Site
 

 

JE_POZ_SUPPLIERS_SITES
 

Payables Invoices - Trial Balance
Real Time
 

Supplier Site
 

 

JE_POZ_SUPPLIERS_SITES
 

Payables Payments -
Disbursements Real Time
 

Supplier Site
 

 

JE_POZ_SUPPLIERS_SITES
 

Payables Payments - Payment
History Real Time
 

Supplier Site
 

 

JE_RA_CUSTOMER_TRX
 

Receivables - Transactions Real
Time
 

General Information
 

Transactions Details
 

JG_AP_CHECKS
 

Payables Payments -
Disbursements Real Time
 

Payment Information
 

Payment Header Details
 

JG_AP_INVOICE_LINES
 

Payables Invoices - Transactions
Real Time
 

Invoice Line Details - General
Information
 

Invoice Lines
 

JG_AP_INVOICE_LINES
 

Payables Invoices - Prepayment
Applications Real Time
 

Invoice Line Details - General
Information
 

Invoice Lines
 

JG_AP_INVOICES
 

Payables Invoices - Transactions
Real Time
 

General Information
 

Invoice Details
 

JG_AP_INVOICES
 

Payables Invoices - Prepayment
Applications Real Time
 

General Information
 

Invoice Details
 

JG_AP_INVOICES
 

Expenses - Cash Advances Real
Time
 

General Information
 

Invoice Details
 

JG_AP_PAYMENT_SCHEDULES
 

Payables Invoices - Installments
Real Time
 

Invoices Installment Details
 

 

JG_AR_CASH_RECEIPTS
 

Receivables - Standard Receipts
Application Details Real Time
 

Standard Receipt Details
 

 

JG_AR_PAYMENT_SCHEDULES
 

Receivables - Payment Schedules
Real Time
 

Payment Schedules Details
 

 

JG_AR_RECEIPT_CLASSES
 

Receivables - Standard Receipts
Application Details Real Time
 

Standard Receipt Details
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JG_AR_RECEIVABLE_
APPLICATIONS
 

Receivables - Standard Receipts
Application Details Real Time
 

Standard Receipt Application
Details
 

 

JG_AR_RECEIVABLE_
APPLICATIONS
 

Receivables - Credit Memo
Applications Real Time
 

Credit Memo Application Details
 

 

JG_CE_BANK_ACCOUNTS
 

Cash Management - Bank
Statements Real Time
 

Bank Account
 

 

JG_CE_BANK_ACCOUNTS
 

Receivables - Bills Receivable Real
Time
 

Bills Receivable Remittance
 

Bills Receivable Details
 

JG_FA_ADDITIONS
 

Fixed Assets - Asset Transactions
Real Time
 

Fixed Asset
 

 

JG_FA_CATEGORY_BOOKS
 

Fixed Assets - Asset Transactions
Real Time
 

Asset Category Book
 

 

JG_GL_JE_HEADERS
 

General Ledger - Journals Real
Time
 

Header Details
 

Journal Header
 

JG_GL_JE_LINES
 

General Ledger - Journals Real
Time
 

Journal Line Details
 

Journal Lines
 

JG_HZ_CUSTOMER_PROFILES
 

Receivables - Customer Real Time
 

Profile Class
 

Customer Accounts - Customer
Account Profile
 

JG_HZ_CUSTOMER_PROFILES
 

Receivables - Customer Real Time
 

Site Profile Class
 

Customer Account Site - Customer
Account Site Profile
 

JG_RA_CUSTOMER_TRX_LINES
 

Receivables - Transactions Real
Time
 

Line Information
 

Transaction Line Details
 

JGxAPInvoiceDistributions
 

Payables Invoices - Transactions
Real Time
 

Invoice Distribution Details -
General Information
 

Distributions
 

JGxAPInvoiceDistributions
 

Payables Invoices - Prepayment
Applications Real Time
 

Invoice Distribution Details -
General Information
 

Distributions
 

JGxFAAssetInvoices
 

Fixed Assets - Asset Transactions
Real Time
 

Source Lines General Information
 

Asset Source Lines Details
 

JGxFABookControls
 

Fixed Assets - Asset Depreciation
Real Time
 

General Information
 

Fixed Asset
 

JGxFABookControls
 

Fixed Assets - Asset Transactions
Real Time

General Information
 

Fixed Asset
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JGxFABookControls
 

Fixed Assets - Asset Balances Real
Time
 

General Information
 

Fixed Asset
 

JGxFABooks
 

Fixed Assets - Asset Transactions
Real Time
 

General
 

Fixed Asset - Financial Details
 

JGxFABooks
 

Fixed Assets - Asset Depreciation
Real Time
 

General
 

Fixed Asset - Financial Details
 

JGxFABooks
 

Fixed Assets - Asset Balances Real
Time
 

General
 

Fixed Asset - Financial Details
 

JGxFATransactionHeaders
 

Fixed Assets - Asset Transactions
Real Time
 

Asset Transaction Details
 

 

JGxGLPeriods
 

Receivables - Revenue
Adjustments Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Receivables - Credit Memo
Requests Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Receivables - Payment Schedules
Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Receivables - Adjustments Real
Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Receivables - Bills Receivable Real
Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Receivables - Credit Memo
Applications Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Receivables - Receipt Conversion
Rate Adjustments Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Receivables - Standard Receipts
Application Details Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Receivables - Miscellaneous
Receipts Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Receivables - Receipts Details Real
Time
 

Fiscal Calendar
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JGxGLPeriods
 

Receivables - Transactions Real
Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Payables Invoices - Prepayment
Applications Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Payables Payments - Payment
History Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Payables Invoices - Holds Real
Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Payables Invoices - Trial Balance
Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Payables Invoices - Installments
Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Payables Invoices - Transactions
Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Payables Payments -
Disbursements Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

General Ledger - Journals Real
Time
 

Time
 

 

JGxGLPeriods
 

General Ledger - Transactional
Balances Real Time
 

Time
 

 

JGxGLPeriods
 

General Ledger - Period Status Real
Time
 

Time
 

 

JGxGLPeriods
 

Subledger Accounting - Journals
Real Time
 

Time
 

 

JGxGLPeriods
 

Subledger Accounting - Supporting
References Real Time
 

Time
 

 

JGxGLPeriods
 

Revenue Management - Customer
Contracts Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Budgetary Control - Transactions
Real Time
 

Time
 

 

JGxGLPeriods
 

Budgetary Control - Balances Real
Time

Time
 

 

66



Oracle Fusion Cloud Financials
Creating and Administering Analytics and Reports for
Financials

Chapter 3
Flexfields

Descriptive Flexfield Subject Area Folder Parent Folder (If Applicable)

 

JGxGLPeriods
 

Expenses - Expense Transactions
Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Expenses - Cash Advances Real
Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Payables Invoices - Prepayment
Applications Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Prepayment Applications -
Distribution Details
 

JGxGLPeriods
 

Payables Invoices - Transactions
Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Distributions
 

JGxGLPeriods
 

Payables Payments -
Disbursements Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Payment Details
 

JGxGLPeriods
 

Cash Management - Bank
Statement Balances Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Cash Management - Bank
Statement Line Charges Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Cash Management - Bank
Statement Real Time
 

Fiscal Calendar
 

 

JGxGLPeriods
 

Cash Management - External Cash
Transactions Real Time
 

Transaction Date (Fiscal)
 

 

JGxGLPeriods
 

Fixed Assets - Asset Depreciation
Real Time
 

GL Accounting Date Fiscal
Calendar
 

Depreciation Accounting Details
 

JGxGLPeriods
 

Fixed Assets - Asset Transactions
Real Time
 

GL Accounting Date Fiscal
Calendar
 

Transaction Accounting Details
 

JGxGLPeriods
 

Payables Invoices - Prepayment
Applications Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Prepayment Applications -
Distribution Details
 

JGxGLPeriods
 

Payables Invoices - Transactions
Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Distributions
 

JGxGLPeriods
 

Payables Payments -
Disbursements Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Payment Details
 

JGxGLPeriods
 

Receivables - Adjustments Real
Time
 

GL Accounting Date Fiscal
Calendar
 

Receivables Adjustment
Accounting
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JGxGLPeriods
 

Receivables - Bills Receivable Real
Time
 

GL Accounting Date Fiscal
Calendar
 

Bills Receivable Accounting
 

JGxGLPeriods
 

Receivables - Credit Memo
Applications Real Time
 

GL Accounting Date Fiscal
Calendar
 

Receivables Credit Memo
Application Accounting
 

JGxGLPeriods
 

Receivables - Miscellaneous
Receipts Real Time
 

GL Accounting Date Fiscal
Calendar
 

Miscellaneous Receipt Accounting
 

JGxGLPeriods
 

Receivables - Receipts Details Real
Time
 

GL Accounting Date Fiscal
Calendar
 

Receipt Accounting
 

JGxGLPeriods
 

Receivables - Revenue
Adjustments Real Time
 

GL Accounting Date Fiscal
Calendar
 

Receivables Revenue Adjustment
Accounting
 

JGxGLPeriods
 

Receivables - Standard Receipts
Application Details Real Time
 

GL Accounting Date Fiscal
Calendar
 

Standard Receipt Accounting
 

JGxGLPeriods
 

Receivables - Transactions Real
Time
 

GL Accounting Date Fiscal
Calendar
 

Receivables Transaction
Accounting
 

JGxGLPeriods
 

Revenue Management - Customer
Contracts Real Time
 

GL Accounting Date Fiscal
Calendar
 

Promised Details - Accounting
 

JGxGLPeriods
 

Receivables - Adjustments Real
Time
 

Distribution Accounting Date Fiscal
Calendar
 

Receivables Adjustment
Distributions
 

JGxGLPeriods
 

Receivables - Bills Receivable Real
Time
 

Distribution Accounting Date Fiscal
Calendar
 

Bills Receivable Distributions
 

JGxGLPeriods
 

Receivables - Credit Memo
Applications Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Receivables Credit Memo
Application Distributions
 

JGxGLPeriods
 

Receivables - Miscellaneous
Receipts Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Miscellaneous Receipt
Distributions
 

JGxGLPeriods
 

Receivables - Receipts Details Real
Time
 

Distribution Accounting Date Fiscal
Calendar
 

Receipt Distributions
 

JGxGLPeriods
 

Receivables - Revenue
Adjustments Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Receivables Revenue Adjustment
Distributions
 

JGxGLPeriods
 

Receivables - Standard Receipts
Application Details Real Time
 

Distribution Accounting Date Fiscal
Calendar
 

Standard Receipt Distributions
 

JGxGLPeriods
 

Receivables - Transactions Real
Time

Distribution Accounting Date Fiscal
Calendar

Receivables Transaction
Distributions
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JGxGLPeriods
 

Revenue Management -
Standalone Selling Price Real Time
 

Document Date Fiscal Calendar
 

Standalone Selling Price Source
Document - Source Document
 

JGxGLPeriods
 

Revenue Management - Customer
Contracts Real Time
 

Document Date Fiscal Calendar
 

Promised Details - Promised
Detail Source Document - Source
Document
 

JGxGLPeriods
 

Expenses - Cash Advances Real
Time
 

Fiscal Calendar
 

 

POZ_SUPPLIERS
 

Payables Invoices - Holds Real
Time
 

Supplier
 

 

POZ_SUPPLIERS
 

Payables Invoices - Installments
Real Time
 

Supplier
 

 

POZ_SUPPLIERS
 

Payables Invoices - Prepayment
Applications Real Time
 

Supplier
 

 

POZ_SUPPLIERS
 

Payables Invoices - Transactions
Real Time
 

Supplier
 

 

POZ_SUPPLIERS
 

Payables Invoices - Trial Balance
Real Time
 

Supplier
 

 

POZ_SUPPLIERS
 

Payables Invoices - Withholding
Real Time
 

Supplier
 

 

POZ_SUPPLIERS
 

Payables Payments -
Disbursements Real Time
 

Supplier
 

 

POZ_SUPPLIERS
 

Payables Payments - Payment
History Real Time
 

Supplier
 

 

POZ_SUPPLIERS
 

Subledger Accounting - Journals
Real Time
 

Supplier Profile
 

Supplier
 

POZ_SUPPLIERS_SITES
 

Payables Invoices - Holds Real
Time
 

Supplier Site
 

 

POZ_SUPPLIERS_SITES
 

Payables Invoices - Installments
Real Time
 

Supplier Site
 

 

POZ_SUPPLIERS_SITES
 

Payables Invoices - Prepayment
Applications Real Time
 

Supplier Site
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POZ_SUPPLIERS_SITES
 

Payables Invoices - Transactions
Real Time
 

Supplier Site
 

 

POZ_SUPPLIERS_SITES
 

Payables Invoices - Trial Balance
Real Time
 

Supplier Site
 

 

POZ_SUPPLIERS_SITES
 

Payables Payments -
Disbursements Real Time
 

Supplier Site
 

 

POZ_SUPPLIERS_SITES
 

Payables Payments - Payment
History Real Time
 

Supplier Site
 

 

RA_CUST_TRX_LINE_SALESREPS
 

Receivables - Transactions Real
Time
 

Sales Credits Details
 

Receivables Transaction Sales
Credits
 

RA_CUST_TRX_TYPES
 

Receivables - Transactions Real
Time
 

Reference Information
 

Transactions Details
 

RA_CUST_TRX_TYPES
 

Receivables - Bills Receivable Real
Time
 

Reference Information
 

Bills Receivable Details
 

RA_CUSTOMER_TRX
 

Receivables - Transactions Real
Time
 

General Information
 

Transactions Details
 

RA_CUSTOMER_TRX
 

Receivables - Standard Receipts
Application Details Real Time
 

Standard Receipt Application
Details
 

 

RA_CUSTOMER_TRX
 

Receivables - Credit Memo
Applications Real Time
 

Credit Memo Application Details
 

 

RA_CUSTOMER_TRX
 

Receivables - Bills Receivable Real
Time
 

Bills Receivable Application
Information
 

Bills Receivable Application Details
 

RA_CUSTOMER_TRX
 

Receivables - Credit Memo
Requests Real Time
 

Credit Memo Requests Details
 

 

RA_CUSTOMER_TRX_LINE_GL_
DIST
 

Receivables - Transactions Real
Time
 

Transaction Distribution Details
 

Receivables Transaction
Distributions
 

RA_CUSTOMER_TRX_LINE_GL_
DIST
 

Receivables - Revenue
Adjustments Real Time
 

Revenue Adjustments Details
 

 

RA_CUSTOMER_TRX_LINES
 

Receivables - Transactions Real
Time
 

Line Information
 

Transaction Line Details
 

RA_CUSTOMER_TRX_LINES
 

Receivables - Revenue
Adjustments Real Time

Revenue Adjustments Details
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RA_RULES
 

Receivables - Transactions Real
Time
 

Line Information
 

Transaction Line Details
 

RA_TERMS
 

Receivables - Payment Schedules
Real Time
 

Payment Schedules Details
 

 

RA_TERMS_LINES
 

Receivables - Payment Schedules
Real Time
 

Payment Schedules Details
 

 

VRM_CONTRACT_RULES_B
 

Revenue Management - Customer
Contracts Real Time
 

Contract Identification Rules
 

Customer Contracts
 

VRM_CUSTOMER_CONTRACT_
HEADERS
 

Revenue Management - Customer
Contracts Real Time
 

Contract Details
 

Customer Contracts
 

VRM_FMV_LINES
 

Revenue Management -
Standalone Selling Price Real Time
 

Standalone Selling Price Details
 

Standalone Selling Price
 

VRM_FMV_LINES
 

Revenue Management -
Standalone Selling Price Real Time
 

Standalone Selling Price History
Details
 

Standalone Selling Price
 

VRM_FMV_LINES
 

Revenue Management - Customer
Contracts Real Time
 

Promised Detail SSP Details
 

Promised Details - Promised
Details Standalone Selling Price
 

VRM_FMV_LINES
 

Revenue Management - Customer
Contracts Real Time
 

Performance Obligation SSP
Details
 

Performance Obligations
- Performance Obligation
Standalone Selling Price
 

VRM_FMV_TEMPL_ASSIGNMENTS
 

Revenue Management -
Standalone Selling Price Real Time
 

Standalone Selling Price Profile
 

 

VRM_FMV_TEMPL_ASSIGNMENTS
 

Revenue Management - Customer
Contracts Real Time
 

Performance Obligation SSP Profile
 

Performance Obligations
- Performance Obligation
Standalone Selling Price
 

VRM_FMV_TEMPL_ASSIGNMENTS
 

Revenue Management - Customer
Contracts Real Time
 

Promised Detail SSP Profile
 

Promised Details - Promised
Details Standalone Selling Price
 

VRM_FMV_TEMPLATES_B
 

Revenue Management -
Standalone Selling Price Real Time
 

Standalone Selling Price Profile
 

 

VRM_FMV_TEMPLATES_B
 

Revenue Management - Customer
Contracts Real Time
 

Performance Obligation SSP Profile
 

Performance Obligations
- Performance Obligation
Standalone Selling Price
 

VRM_FMV_TEMPLATES_B
 

Revenue Management - Customer
Contracts Real Time

Promised Detail SSP Profile
 

Promised Details - Promised
Details Standalone Selling Price
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VRM_ITEM_GROUPS_VL
 

Revenue Management -
Standalone Selling Price Real Time
 

Item Group
 

 

VRM_ITEM_GROUPS_VL
 

Revenue Management - Customer
Contracts Real Time
 

Item Group
 

Promised Details
 

VRM_PERF_OBLIG_TEMPLATES_B
 

Revenue Management - Customer
Contracts Real Time
 

Performance Obligation Template
Details
 

Performance Obligations -
Performance Obligation Template
 

VRM_PERF_OBLIGATION_LINES
 

Revenue Management - Customer
Contracts Real Time
 

Promised Detail Lines
 

Promised Details
 

VRM_PERF_OBLIGATIONS
 

Revenue Management - Customer
Contracts Real Time
 

Performance Obligation Details
 

Performance Obligations
 

VRM_PRICE_EFF_PERIODS_VL
 

Revenue Management -
Standalone Selling Price Real Time
 

Effective Price Period
 

 

VRM_PRICE_EFF_PERIODS_VL
 

Revenue Management - Customer
Contracts Real Time
 

Effective Price Period
 

Promised Details
 

VRM_PRICE_EFF_PERIODS_VL
 

Revenue Management - Customer
Contracts Real Time
 

Performance Obligation Effective
Price Period
 

Performance Obligations
 

VRM_SOURCE_DOC_LINES
 

Revenue Management -
Standalone Selling Price Real Time
 

Source Document Line Details
 

Standalone Selling Price Source
Document - Source Document Line
 

VRM_SOURCE_DOC_LINES
 

Revenue Management - Customer
Contracts Real Time
 

Source Document Line Details
 

Promised Details - Promised
Details Source Document - Source
Document Line
 

VRM_SOURCE_DOCUMENTS
 

Revenue Management -
Standalone Selling Price Real Time
 

Source Document Details
 

Standalone Selling Price Source
Document - Source Document
 

VRM_SOURCE_DOCUMENTS
 

Revenue Management - Customer
Contracts Real Time
 

Source Document Details
 

Promised Details - Promised
Details Source Document - Source
Document
 

XLA_AE_HEADERS
 

Subledger Accounting - Journals
Real Time
 

Journal Details
 

 

XLA_AE_LINES
 

Subledger Accounting - Journals
Real Time
 

Journal Details
 

 

XLE_LE_ADD_INFO
 

Cash Management - Bank
Statement Balances Real Time
 

Legal Entity
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XLE_LE_ADD_INFO
 

Cash Management - Bank
Statement Line Charges Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Cash Management - Bank
Statements Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Cash Management - External Cash
Transactions Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Costing - Cost Accounting Real
Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Payables Invoices - Holds Real
Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Payables Invoices - Installments
Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Payables Invoices - Prepayment
Applications Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Payables Invoices - Transactions
Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Payables Invoices - Trial Balance
Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Payables Payments -
Disbursements Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Payables Payments - Payment
History Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Project Billing - Revenue Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Project Costing - Actual Costs Real
Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Adjustments Real
Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Bills Receivable Real
Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Credit Memo
Applications Real Time
 

Legal Entity
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XLE_LE_ADD_INFO
 

Receivables - Credit Memo
Requests Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Miscellaneous
Receipts Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Payment Schedules
Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Receipt Conversion
Rate Adjustments Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Receipts Details Real
Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Revenue
Adjustments Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Standard Receipts
Application Details Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Receivables - Transactions Real
Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Revenue Management -
Standalone Selling Price Real Time
 

Legal Entity
 

Standalone Selling Price Source
Document - Source Document
 

XLE_LE_ADD_INFO
 

Revenue Management - Customer
Contracts Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Expenses - Expense Transactions
Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Expenses - Employee Expense
Overview Real Time
 

Legal Entity
 

 

XLE_LE_ADD_INFO
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Initiating Legal Entity
 

 

XLE_LE_ADD_INFO
 

Financials Common Module -
Intercompany Transactions Real
Time
 

Receiving Legal Entity
 

 

XLE_LE_ADD_INFO
 

Expenses - Cash Advances Real
Time
 

Legal Entity
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XLE_LE_INFO_DEV
 

Cash Management - Bank
Statement Balances Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Cash Management - Bank
Statement Line Charges Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Cash Management - Bank
Statements Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Cash Management - External Cash
Transactions Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Payables Invoices - Holds Real
Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Payables Invoices - Installments
Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Payables Invoices - Prepayment
Applications Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Payables Invoices - Transactions
Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Payables Invoices - Trial Balance
Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Payables Payments -
Disbursements Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Payables Payments - Payment
History Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Adjustments Real
Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Bills Receivable Real
Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Credit Memo
Applications Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Credit Memo
Requests Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Miscellaneous
Receipts Real Time

Legal Entity
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XLE_LE_INFO_DEV
 

Receivables - Payment Schedules
Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Receipt Conversion
Rate Adjustments Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Receipts Details Real
Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Revenue
Adjustments Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Standard Receipts
Application Details Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Receivables - Transactions Real
Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Revenue Management -
Standalone Selling Price Real Time
 

Legal Entity
 

Standalone Selling Price Source
Document - Source Document
 

XLE_LE_INFO_DEV
 

Revenue Management - Customer
Contracts Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Expenses - Expense Transactions
Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Expenses - Employee Expense
Overview Real Time
 

Legal Entity
 

 

XLE_LE_INFO_DEV
 

Expenses - Cash Advances Real
Time
 

Legal Entity
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4  Analyses, Reports, and Dashboards
Modification

Introduction to Oracle Transactional Business
Intelligence for Financials  
In this example, you view an analysis called the Payables Aging Summary. This analysis was created using Oracle
Transactional Business Intelligence, an ad hoc reporting tool. You can use the tool to create analyses, dashboards, and
infolets using information from your Oracle Financials Cloud

Viewing an Analysis
1. Let's start from the Financial Reporting Center and search for the Payables Aging Summary.
2. Click the Expand icon to see details like type and location.

In this example, the type is Analysis. The location shows you where the analysis is stored.
3. Click the title.

Now you can see the analysis. The information here is real time and based on the latest transaction
information.This analysis has bars and a table that show totals by aging categories like Current, Overdue 21 - 60
days, and so on. You can use different views like time series lines, bars, tables, and heat maps in your analyses.
An analysis can use more than one type of view to help arrange information in a way that's useful for your
audience.

4. Click the Overdue 91-180 Days bar.

A table shows the invoices that make up the total for this category. You can see invoice details like supplier
name, invoice due date, invoice number, and unpaid amount.

5. Click the Buckets drop-down list to change categories.

Now you see the details that make up another aging total.
6. Go back to the previous page.
7. Click the Analysis icon after the title.
8. Click the Edit link to open the layout.

You can make changes here and save them in the same location, or you can save them in another area that you
have access to. You can also create another analysis. Just click the New menu to get started.
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Overview of Oracle Analytics Publisher Best Practices for
SaaS Environments  
Oracle Analytics Publisher is an enterprise reporting solution for creating highly formatted, pixel perfect reports. It
offers a single solution environment to author, manage, and deliver a variety of business documents. Oracle Analytics
Publisher is available to customers with Oracle BI Suite Plus

Often the reports process large amounts of data, which requires product teams and end customers to understand
the best practices of Oracle Analytics Publisher. This white paper provides a detailed list of best practices that are
recommended by Oracle when using Oracle Analytics Publisher in a Software-as-a-Service (SaaS) environment. For
more information, see Oracle BI Publisher Best Practices for SaaS Environments document ID 2145444.1 on My Oracle
Support at https://support.oracle.com.

Explore Financial Subject Areas in Oracle Transactional
Business Intelligence  
In this example, you examine Financial subject areas in Oracle Transactional Business Intelligence. Here's the list
of Financial products with subject areas: Assets, Budgetary Control, Cash Management, Expenses, General Ledger,
Intercompany, Payables, Receivables, Revenue Management, and Subledger Accounting.

1. Start from the Financial Reporting Center.
2. Click Tasks.
3. Click Open Workspace for Financial Reports.
4. Select Navigate > Applications > BI Catalog.
5. You have to create an analysis to see the subject areas you have access to:

a. Click the New icon.
b. Click Analysis.

Subject areas are organized in folders and the information they contain varies based upon reporting
requirements. General Ledger subject areas cover account balances, journals, and period statuses.

6. Select the General Ledger Transactional Balances - Real Time subject area. The term Real Time in the
subject area name indicates the information is up-to-date as of the latest general ledger journal posting. You
can use this subject area to create trial balances and general queries to review changes in account balances
over time. Here are some of the folders that appear in the Subject Area pane.

◦ Balancing Segment

◦ Cost Center Segment

◦ Currency

◦ Time

◦ Ledger

◦ Ledger Set
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You can expand folders to see their components. For example, the Time folder contains accounting period and
year. If you have more than one ledger, you can create an analysis that filters by ledger and ledger set. You can
query a specific general ledger balance, or groups of general ledger balances.

7. Click the Add or Remove Subject Areas  icon in the Subject Areas toolbar to view more subject areas and the
type of information they hold.

For example, with the Payables subject areas you can examine information about suppliers, supplier balances,
and invoices, including freight and tax charges. You can also see how invoices and payments affect the general
ledger. An analysis can show which invoices were paid on time and whether checks have cleared.

The Receivables subject areas include customer information, customer balances, and invoice details such
as terms and receipts, credit memos, and revenue adjustments. Similar to Payables, you could analyze how
receipts affect general ledger account balances.

Analyses and Dashboards  

How Data Is Structured for Analytics  
The business intelligence (BI) repository contains the metadata that defines which columns you can include in analyses,
and the source of that data. The repository is organized into subject areas, which contain folders with the columns.

Note:  You can also use the BI repository as a data source for reports.

Columns
This table describes the three types of columns available when you create or edit analyses.

Column Type Description Example

Fact
 

Provides a measure of something, meaning
that the values are numbers.
 

Total
 

Attribute
 

Represents a piece of information about a
business object, with values that are dates, IDs,
 or text.
 

Note:
Attribute columns can be flexfield segments
imported into the BI repository.
 

Start Date
 

Hierarchy
 

Holds data values that are organized in a
hierarchical manner.
 

Time, with sublevels:
 

• Year

• Quarter
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Column Type Description Example

• Month

Subject Areas
When you create an analysis, you first select a subject area, which contains columns related to a specific business object
or area. Then, open folders within the subject area to find the columns to include.

For product families that use Application Composer, you can create custom subject areas to accommodate custom
objects or to add new facts for analysis.

Folders
Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders.

• Fact folders:

◦ Contain fact columns.

◦ Are usually the last in a list of folders and are usually named after the subject area.

• Dimension folders:

◦ Contain attribute and hierarchical columns.

◦ Are joined to the fact folder within a subject area.

For example, if your analysis has the Currency attribute from a dimension folder, you see currencies in
the results. If you also add the Total fact, then your analysis includes only records with both a currency
and a total amount. The more columns you add, the smaller the query set for your analysis.

◦ Can be common folders, or common dimensions, that appear in more than one subject area.

If your analysis has columns from multiple subject areas, then you:

- Should include columns only from dimension folders that are common to all of those subject areas.
At least one such column is required.

- Must include one column from the fact folder in each of those subject areas.

Related Topics
• Create and Edit Analyses Using a Wizard

• Create and Modify Analyses and Dashboards

• Manage Analytics with Advanced Features

• About Custom Subject Areas

Create and Edit Analyses Using a Wizard  
Use the wizards to quickly create and edit your analyses. You can use a wizard to create and edit most of your analytics,
for example to select columns, add filters or views.
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You can also use advanced business intelligence features to create or edit dashboards or manage analyses and other
objects in the catalog.

1. Start the wizard from the Reports and Analytics work area or the Reports and Analytics panel tab (if available).

◦ To create a new analysis click Create and select Analysis. Select a subject area for your analysis and click
theContinue button.

◦ To edit an existing analysis, in the Reports and Analytics work area, select it in a folder or the favorites list,
click its ellipsis icon and select Edit. In the Reports and Analytics panel tab, click the analysis, then click
Edit.

2. In the Select Columns page, optionally, click Add/Remove Subject Areas and, in the Add/Remove Subject
Areas dialog box, select more subject areas or remove any that you no longer need, and click OK. You can't
remove the original subject area selected for the analysis. To remove any other subject area, first remove its
columns from the analysis.

3. From here on, make selections in a series of analysis-definition pages, selecting Next or Back to navigate
among them.

◦ In the Select Columns page, expand your subject area and folders within it to choose the columns to
include in your analysis. Also set options for those columns.

◦ In the Select Views page, determine whether your analysis is to include a table, a graph, or both. For
either, select among several types. If you include both, select the order in which they appear.

◦ In Edit Table and Edit Graph pages, select options that apply to your table and graph layouts. Each of
these pages is active only if you selected the item it applies to in the Select Views page.

◦ In the Sort and Filter page, optionally apply filters to columns to refine the selection of records in your
analysis, and apply sorts to them to order your results.

◦ In the Highlight page, optionally add color highlights based on numeric thresholds you set.

◦ In the Save page, enter a name for the analysis, select a catalog folder to save it in, and click Submit.

In general, these pages are designed so that procedures for using them are readily apparent. Even so, here are some
things you will want to know.

Select Columns Page
For each column in your analysis, you select an Interaction option.

• Two of the options, Default and Drill, do the same thing: If you click on a column header, the analysis adds a
column displaying values at the next hierarchical level. (For example, if you click on Control Name, the analysis
adds a Control ID column.) If you click on a column value, the analysis adds the subordinate column, but also
filters to display only records containing the value you clicked.

• Navigate to Transaction: If you click on a value from a column for which this option is set, the analysis presents
a link to the record of an object the value applies to.

For such links to work, however, further configuration is required: You need to define paths to the records
that are to be opened. If you want to use this option, you're probably better off creating the analysis in the BI
Catalog. However, you can create it in the wizard, then edit it in the BI Catalog. See the topic titled Link Analyses
to Application Pages.

• None: This option in effect turns the Default option off and turns nothing on. Nothing happens if you click on a
value in a column for which this option is set.

For each column, you can also select a Hidden option. This prevents the analysis from displaying the column, but leaves
its values available for use behind the scenes, for example in filters.

81



Oracle Fusion Cloud Financials
Creating and Administering Analytics and Reports for
Financials

Chapter 4
Analyses, Reports, and Dashboards Modification

Select Views Page
You can add a graph to your analysis only if it includes at least one column from a fact folder. (You can include a table
in your analysis no matter what columns you select for it.) A fact column contains numeric values, such as counts of
incidents returned by advanced controls. Other columns contain attributes of objects, such as names of advanced
controls. Without numeric values, there's nothing to base a graph on.

You can create a title for the analysis in this page, but doing so is optional. You also create a name for the analysis in the
Save page, and that one is required. If you create both, the analysis displays both; they don't have to be the same.

You can use a Preview option to ensure the analysis returns data you expect. Turn it on or off in this page or in
subsequent wizard pages. Once it's on, the preview remains on in other wizard pages you navigate to, unless you turn it
off.

Edit Table Page
Here are the layout options you can select for tables:

• Columns: This is the default. Each column you assign this value to appears as a column in the table.

• Prompt For: In a prompt field, you select among values from the column you're configuring. For example, you
would select a date if the column were Calendar Month Start Date. The table would then display only rows
containing the value you selected.

• Section By: The table is divided into sections. Each value of the column you're configuring becomes a header,
and the section beneath each header includes rows containing that value.

• Excluded: The column you select is no longer available to the view you're configuring. The column is hidden,
and its values are unavailable for behind-the-scenes tasks such as filtering. However, the column remains
available to other views in your analysis.

Edit Graph Page
You can't apply layout options to fact columns. For other columns, graph layout options include Prompt For, Section By,
and Excluded, which have the same effect as they do in tables. You can also apply these options in graphs:

• Vary Color By: Each value in the column you're configuring is represented by a distinct color in the graph.

• Group By: Values in the columns you assign this option to are combined in the graph. For example, if you select
this option for the State and Calendar Month Start Date columns in a bar graph, each bar represents a particular
status on a particular date.

Highlight Page
You can use this feature only if your analysis includes at least one fact column, and you can apply it only to fact
columns.

Related Topics
• View Analytics, Reports, and Dashboards

• Where to Save Analytics and Reports

• How Data Is Structured for Analytics

• Manage Analytics with Advanced Features
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Create and Edit a Financial Analysis Using a Wizard  
You can use a wizard that guides you through creating and editing analyses. Even though the wizard doesn't give you all
available features, you can still use it to make typical changes, for example, adding views and filters.

Note:  The wizard isn't available for dashboards and you can't use it to delete analyses.

Creating an Analysis

1. Navigator > Tools: Reports and Analytics.
2. Click Create and select Analysis.
3. Select a subject area that you want to analyze, for example, the General Ledger - Journals Real Time subject

area.
4. Select the columns to include:

◦ Journal Batches: Batch Details: Journal Batch

◦ Journal Headers: Header Details: Journal Header Description

◦ Journal Lines: Line Details: Line

◦ Journal Lines:
- Accounted Debit
- Accounted Credit

◦ Time: Accounting Period Name
5. Set these options:

◦ Interaction: Default

◦ Hidden: Leave unchecked
6. Click Next
7. Enter a title of Journal Report to appear at the beginning of the analysis.
8. Select the type of table and click Next.

Tip:  At any point after this step, you can click Submit to go to the last step, to save your analysis.

9. Enter the name of your analysis By Cost Center and select the My Folder.
10. Click Submit.

Editing an Analysis

1. Navigator > Tools: Reports and Analytics.
2. Select your analysis By Cost Center in the pane and click Edit.
3. Add Posting Status: Posting Status Meaning.
4. Click Submit: Save your analysis with the same name in the same folder.

Tip:  You can create a copy of the analysis, whether you edited it or not, just by saving it either with a new
name or in a new folder.
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Financials Data Structure for Analytics  
The BI repository contains metadata that defines which columns (or slices of data) are available to be included in
analyses. The repository also shows where the data for each column comes from. The repository is organized into
subject areas which contain folders with columns.

Columns
The following table describes the three types of columns.

Column Type Description Example Icon for Column Type

Fact
 

Provides a measure of values that
are numbers.
 

Credit Amount on Journal Line
 

Ruler
 

Attribute
 

Represents information about a
business object with values that
are dates, IDs, or text. Attribute
columns can be flexfield segments
imported into the BI repository.
 

Approval Status Code on a journal
entry.
 

Piece of paper
 

Hierarchy
 

Holds data values that are
organized in a hierarchical manner.
 

Accounting Period
 

• Year

• Quarter

• Month

Column: Hierarchy of squares
 
Sublevel: Single square
 

Subject Areas

When you create an analysis, you:

• First select a subject area which contains columns related to a specific business object or business area. For
example, General Ledger - Balances Real Time.

• Then open folders within the subject area to find the columns to include in your analysis. For example, you can
open the Approval Status folder and select the columns within it.

Folders

Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders. For example, the
Journal Lines folder in General Ledger - Journals Real Time subject area has multiple subfolders like Account, Line
Details, and Lines.

The definitions of Fact and Dimension folders are:

• Fact: A measure or metric. A fact consists of numbers. A report more often than not contains at least one fact
and not more than a few facts.
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• Dimension: Provides the context for the fact. A dimension is descriptive.

Note:  Facts and dimensions make up the report columns.

• Fact folders:

◦ Contain fact columns.

◦ Are usually last in the list of folders and are usually named after the subject area.

• Dimension folders:

◦ Contain attribute and hierarchical columns.

◦ Are joined to the fact folder within a subject area.

For example, if your analysis has Currency attribute from a dimension folder, you see currencies in the
results. If you also add the Total fact, then your analysis includes only records with both a currency and a
total amount. The more columns you add, the smaller the query set for your analysis becomes.

◦ Can be common folders or common dimensions that appear in more than one subject area. If your
analysis has columns from multiple subject areas then you:

- Must include columns only from dimension folders that are common to all those subject areas. At
least one such column is required.

- Must include one column from the fact folder in each of those subject areas.

Note:  For more information, see Financials Cloud OTBI Release 11: Subject Area Document
on Customer Connect.at:https://appsconnect.oracle.com/files/8164acf4e9/
FINS_OTBI_Subject_Area_Documentation_R_11_FINAL.pdf

Related Topics

Copy the Payables Invoice Audit Listing Dashboard  
This example shows how to copy a predefined dashboard so that you can edit the copy and not the original. If you have
appropriate roles, then you can (only if necessary) create dashboards or edit predefined ones directly. If not, then you
must

The following table summarizes key decisions for this scenario.

Decisions to Consider In This Example

Which predefined dashboard are you
copying?
 

Payables Invoice Audit Listing
 

Is the copied version for yourself only or
for multiple users?
 

Multiple users
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To copy the dashboard and get it working:

• Make a copy of the Payables Invoice Audit Listing dashboard.

• Copy the components of the dashboard, the analysis and prompt.

• Edit the copied dashboard so that it contains the copied analysis and prompt instead of the predefined ones.

Save your copies under Shared Folders > Custom in the business intelligence (BI) catalog. You must create folders
within Custom so that the copies have a folder path similar to the originals.

Copying the Dashboard
1. Open the Reports and Analytics work area.
2. In the Contents pane, select Shared Folders > Financials > Payables > Invoices > Payables Invoice Audit

Listing > Invoice Audit Listing, and click the More link.
3. With the Payables Invoice Audit Listing dashboard selected in the Folders pane, click the Copy button on the

toolbar.
4. In the Folders pane, select Shared Folders > Custom > Financials.
5. On the toolbar, click the New button and select Folder.
6. Enter Payables in the Name field and click OK.
7. Create an Invoices subfolder within the new Payables folder.
8. Click Paste on the toolbar to copy the dashboard into the Invoices folder.

Copying the Prompt and Analysis
1. With the Invoices folder still open, click New on the toolbar and select Folder.
2. Enter Prompts in the Name field and click OK.
3. Create another folder with the name Report Components. (In this context, report refers to the dashboard.)
4. In the Folders pane, select Shared Folders > Financials > Payables > Invoices > Prompts.
5. For the Payables Invoice Audit Listing dashboard prompt, click the More link and select Copy.
6. In the Folders pane, select Shared Folders > Custom > Financials > Payables > Invoices > Prompts, and click

Paste on the toolbar.
7. In the Folders pane, select Shared Folders > Financials > Payables > Invoices > Report Components.
8. For the Payables Invoice Audit Listing analysis, click the More link and select Copy.
9. In the Folders pane, select Shared Folders > Custom > Financials > Payables > Invoices > Report

Components, and click Paste on the toolbar.

Editing the Copied Dashboard
1. In the Folders pane, select Shared Folders > Custom > Financials > Payables > Invoices > Payables Invoice

Audit Listing.
2. Click the Edit link for the Invoice Audit Listing dashboard.
3. Click the Delete button for the Payables Invoice Audit Listing dashboard prompt within the Search region.
4. In the Catalog pane, select Shared Folders > Custom > Financials > Payables > Invoices > Prompts >

Payables Invoice Audit Listing and move it into the Search region.
5. Delete the Payables Invoice Audit Listing compound view within the Section 1 region.
6. In the Catalog pane, select Shared Folders > Custom > Financials > Payables > Invoices > Report

Components > Payables Invoice Audit Listing and move it into the Section 1 region.
7. Click Save.

Related Topics
• Create and Edit Dashboards
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Reports  

Overview of Analytics Publisher  
Oracle Analytics Publisher enables you to author, generate, and deliver all types of highly formatted documents and
operational reports.

You can use familiar office desktop tools to create rich text format (.rtf) documents and reports against any data source.
You can view reports, schedule them to run, and distribute them to predefined destinations.

Reports consist of one or more .rtf layouts, a reference to a data model, and a set of properties. A report may also
include style templates and subtemplates, which allow reusability of functionality and maintain consistency of design. In
the logical architecture depicted in the figure, the report includes a data model and a layout, and the layout references
two style templates in the catalog which in turn reference subtemplates.

In the Analytics Publisher logical architecture, the data model accesses data sources and the layout
and its optional style template and subtemplates determine the formatting of the report output,
which can include email, print, fax, or files, and others. The layout is designed using common office
applications, for example Microsoft Word and Excel and Adobe Acrobat and Flash, among others.

How You Access and Modify Report Components  
To create or edit reports, you must access the business intelligence (BI) catalog. In the catalog, objects of type Report
represent the report definition, which includes report properties and layouts.
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Data models are separate objects in the catalog, usually stored in subfolders called Data Models.

Accessing the BI Catalog
You can access the BI catalog in any of the following ways:

• In the Reports and Analytics work area, click Browse Catalog to open the BI catalog, and find your report or
data model in the Folders pane.

• In the Reports and Analytics work area, find your report and select More to go to the report directly in the
catalog. The data model associated with the report should be in the Data Models subfolder within the same
folder as the report.

• Sign in to the application directly (for example: http://host:port/analytics/saw.dll) to open the catalog.

• Sign in to the Analytics Publisher server directly (for example: http://hostname.com:7001/xmlpserver) to open
the catalog.

◦ Alternatively, once you are in the catalog using another method, for example, through the Reports
and Analytics work area, change the final node of the URL. For example, change (http://host:port/
analytics/saw.dll) to xmlpserver. So the URL you use would be: http://host:port/xmlpserver.

Predefined Reports
A special Customize option is available only:

• For predefined reports, not data models.

• Through direct access to the server using the /xmlpserver URL. When you find your report in the BI catalog,
select Customize from the More menu.

The Customize option automatically creates a copy of a predefined report and stores it in the Shared Folders > Custom
folder within the catalog. The new report is linked to the original, so that when users open or schedule the original, they
are actually using the copied version.

If you don't have access to the Customize option or don't want the original version linked to the new report, make a copy
of the predefined report and save it in the Custom folder.

Predefined Data Models
Don't edit predefined data models. Instead, copy the data model into the Custom folder and edit the copy. You can't
create a new data model based on the transactional tables.

Related Topics
• Where to Save Analytics and Reports

• What happens to modified analytics and reports when a release update is applied?

Reflect Changes from Edited Reports Sooner  
When you use the Customize option to edit a predefined report, your changes won't be reflected until a refresh that
happens every 24 hours. For changes to take effect sooner, use profile options to change the refresh interval.

The refresh applies your changes to Oracle Fusion Cloud Applications, but you can immediately see your changes in
Microsoft Word and Oracle Analytics Publisher. For example, you download a predefined .rtf layout template and edit
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the file in Word. You can see the modified output using the preview in Word. After you upload the .rtf file to the catalog,
you can open the report in Analytics Publisher and see your changes. But, if you're accessing the report from Fusion
Applications, you see the updated output only after the refresh.

When you're done configuring and testing reports, use the same profile options to turn the refresh back to every 24
hours. But even if you don't, the refresh automatically resets to 24 hours when it's been more than 8 hours since you set
the profile options. The 24-hour refresh interval helps optimize performance.

Create Profile Options to Control the Refresh
Your profile options can apply to all workflow tasks, a product family, or a product. Based on the scope you want, your
profile option must have a profile option code that follows a certain format.

Scope Profile Option Code Examples

Global
 

BIP_CLIENT_REFRESH_TIME
 

BIP_CLIENT_REFRESH_TIME
 

Product Family
 

BIP_CLIENT_REFRESH_TIME_<FAMILY>
 

• BIP_CLIENT_REFRESH_TIME_FIN

• BIP_CLIENT_REFRESH_TIME_HCM

• BIP_CLIENT_REFRESH_TIME_PRC

• BIP_CLIENT_REFRESH_TIME_PRJ

• BIP_CLIENT_REFRESH_TIME_SCM

Product
 

BIP_CLIENT_REFRESH_TIME_<FAMILY>_
<PRODUCT>
 

• BIP_CLIENT_REFRESH_TIME_FIN_AP

• BIP_CLIENT_REFRESH_TIME_HCM_PER

• BIP_CLIENT_REFRESH_TIME_PRC_PON

• BIP_CLIENT_REFRESH_TIME_PRJ_PJE

• BIP_CLIENT_REFRESH_TIME_SCM_EGO

The profile options with a smaller scope take precedence. For example, you have profile option A with a global scope
and profile option B with a product scope. If you're currently configuring notifications for a particular product, use
profile option B to adjust the refresh time just for that product. But based on profile option A, the refresh is still at 24
hours for all other configurable notifications in all other products. Profile option B takes precedence over profile option
A only for that one product.

Tip:  To find the product family or product code, go to the Setup and Maintenance work area. Use the Manage
Taxonomy Hierarchy task in the Application Extensions functional area for any offering. In the hierarchy, expand
the root node and then the Oracle Fusion node. Find the row for the family or product and look in the Module Key
column for the code.

Now you're ready to create your profile options!

1. In the Setup and Maintenance work area, go to the Manage Applications Core Profile Options task in the
Application Extensions functional area for your offering.

2. On the Manage Applications Core Profile Options page, click the New icon.
3. On the Create Profile Option page, enter the profile option code in the format that corresponds to the scope

you want.
4. Enter a display name that you can easily remember to help you find the profile option later.
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5. From the Application list, select Oracle Middleware Extensions for Applications.
6. From the Module list, select Application Core.
7. Specify a start date.
8. Click Save and Close.
9. On the Manage Applications Core Profile Options page, make sure that your new profile option is selected in

the Search Results: Profile Options subsection.
10. In the <Profile Option>: Profile Option Levels subsection, select the Enabled and Updatable check boxes for

the Site level.
11. Save your work.

Set the Refresh Interval
In the Setup and Maintenance work area, go to the Manage Applications Core Administrator Profile Values task in
the Application Extensions functional area. Set your profile option at the Site level and enter 15 or higher for the refresh
interval in minutes. If you enter 15, your changes are reflected in Fusion Applications 15 minutes after they're saved
in the BI catalog. For example, 15 minutes after you upload an edited .rtf layout template to the catalog, or after you
update report properties in Analytics Publisher.

CAUTION:  Make sure to enter a whole number.

When you're done making and testing your changes, set the profile option back to 1440, which is 24 hours in minutes. If
you forget and leave your profile option as is for longer than 8 hours, don't worry! At that point, the profile option resets
itself back to 1440 minutes.

Related Topics
• Update Existing Setup Data

• Set Profile Option Values

• Modules in Application Taxonomy

Where to Save Analytics and Reports  
You save analyses, dashboards, and reports in the catalog, along with other objects like prompts and filters.

Besides the hierarchy of folders organized by product family, another important folder is Custom, found in Shared
Folders. This is where you save the analytics and reports you create or edit for others to use.

Shared Folders and the Custom Subfolder
Anyone with the correct access can get to objects stored in Shared Folders. If you have the appropriate roles, you
can save in Shared Folders so that your objects are available for other users. You should save objects in the Custom
subfolder, and use the product family subfolders to organize and publish analytics and objects for the correct audiences.

Here are a few things to know while working with analytics in the catalog. Keep all modified analyses and reports in
the Custom folder. Directly edit predefined analytics only when it's necessary to make sure that any references to the
analysis or dashboard still work properly.

• Preserve modified predefined objects during updates, which can make changes to predefined analytics,
reports, and other objects outside the Custom folder. You might lose changes saved outside the Custom folder
during updates.
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• You can easily find modified objects if they're not spread around the catalog.

• You can edit objects in the Custom folder without compromising security on the original objects.

• For predefined reports only, you can use a special Customize option to copy the report and also the folder
structure and permissions. The copy is linked to the original, so editing the copy is like directly editing the
original.

When you copy an object into the Custom folder, the copied object inherits the permission settings of the Custom
folder. An administrator can reset the permissions on the object and the folder that it's in.

Note:  When you create folders in the catalog, don't use special characters (~, !, #, $, %, ^, &, *, +, `, |, :, ", \\, <, >, ?, ,, /)
in their names.

My Folders
My Folders is your personal storage; you're the only one who can access anything that you save there. What you save
there is available in the Reports and Analytics work area, but not in My Folders in the Reports and Analytics panel tab on
any other work area. But an exception is when you create an analysis using the wizard in the Reports and Analytics work
area. If you save a wizard analysis in My Folders, it's available in any panel tab that appears in any work area.

Note:  Don't store analyses or reports in the predefined Temp folder in My Folders. That folder is used by Analytics
Publisher and purged automatically every 24 hours.

Create Folders
Create folders in Custom or My Folders.

To create folders:

1. In the catalog, navigate to the desired location of the new folder in the Folders pane.
2. In the catalog toolbar, click New, and select Folder.
3. In the New Folder dialog box, enter the folder name, and click OK.

Automatically Created Folders
If conflicts are detected during upgrade, folders named backup_nnn are automatically created in the catalog. After
reviewing and resolving any conflicts, Oracle recommends that you manually delete the backup folders from the
catalog. You can contact your help desk to request an automated removal if you have many folders to delete.

Related Topics
• What happens to modified analytics and reports when a release update is applied?

What happens to modified analytics and reports when a
release update is applied?  
Updates don't affect the Custom folder or My Folder in the catalog, anything saved there is preserved in updates.
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This includes analytics and reports you edited or created. But anything saved outside those folders, in the predefined
catalog, is preserved only if the update doesn't include doesn't include a new version of those objects.

If an update includes a new version of a predefined object that you edited outside the Custom folder, the changes you
made are saved as a new object. The new version from the update overwrites the existing predefined object. And a copy
of the existing object (with your edits) is automatically created in the same folder, with a new name that indicates it's a
new version.

If the update includes a new version of both the predefined object and a folder in its file path, the new folder name,
along with the new version of the object, overwrites the existing predefined folder and object. And a copy of the existing
folder (along with your edited object) is automatically created. The folder is renamed to indicate that it's a new version,
but your edited object isn't renamed.

If folders named backup_nnn are automatically created in the catalog due to conflicts, after reviewing and resolving any
conflicts, Oracle recommends that you manually delete the backup folders from the catalog. You can contact your help
desk to request an automated removal if you have many folders to delete.

Note:  Future updates won't affect renamed objects or anything within a renamed folder.
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5  Infolets

Overview of Infolets  
An infolet is a small interactive widget that gives you key information and shows you what's going on in the areas you
work on. You might also find something in an infolet that you need to follow up on.

You can use infolets arranged in tabs in the Analytics section of your home page. If you're using a panel or banner
layout, use the page control icons to use the infolets.

Here are a few things to know about infolets.

• Infolets have a front view, and might have a back and expanded view. Use the Back View, Front View, and
Expanded View icons at the bottom corners of an infolet to open these views.

• Your current infolet view persists as the default view the next time you sign in. For example, if you viewed a
back view of the infolet in your last session, you will see the same infolet view by default in your next session.

• Some infolets might also contain links to detailed reports. You can click anywhere in the infolet area to drill
down to the detailed report.

• You can also personalize the infolets. For example, you can move or hide them on the infolets page.

• If you don't see infolet pages on your home page, then your administrators must have disabled them to show
on the home page.

Note:  Some SCM or Procurement Cloud infolets might function differently from other infolets.

Here's how an infolet page looks.
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Personalize Infolets  
You can personalize the infolets on your infolets page, such as you can edit their titles and views, move them, or hide or
show specific infolets on the infolets page.

Edit Infolet Titles and Views

1. Click the Actions icon on the top right corner of the infolet, and select Edit Title and Views.
2. Edit the infolet title, and enable or disable the infolet views.
3. Click Save and Close.

Reorder Infolets
You can change the position of an infolet within an infolet page.

1. Click the Infolet Repository icon, and select Reorder Infolets.
2. In the Reorder Infolets dialog box, select the infolets, and use the arrows to reorder them.

Tip:  To select multiple infolets, press the Ctrl key, and then select them.

3. Click Apply.
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Hide or Show Infolets
To hide an infolet from an infolet page, click the Infolet Repository icon, and deselect the infolet from the list of
infolets.

Tip:  Alternatively, click the Actions icon on the top right corner of the infolet, and select Hide.

To show a hidden infolet on an infolet page, click the Infolet Repository icon, and select the infolet from the list of
infolets.

Related Topics
• Configure Infolet Display

Configure Infolets  

Overview of Configuring Infolets  
You can configure infolets that aggregate key information for a specific area, for example, personal profile.

Your users use infolets arranged in tabs in the Analytics section of the home page. Or, if it's a home page with a panel or
banner layout, they use the page control icons.

If your users don't find infolet pages on the home page, you can enable them by using the Home Configuration tab in
the Structure work area. Let's look at some tasks you can do to configure infolets.

• Create infolets.

• Add content to infolets. For example, you can add a task flow or a performance tile report, and if an infolet
contains a performance tile report, then you can add a link to a detailed report in the same infolet.

Note:  In the context of infolets, a report is an analysis, not an Analytics Publisher report.

• Edit infolets. For example, edit infolet content and add, change, or remove link to detailed report.

• Delete infolets.

But before you start creating and editing infolets, here are a few things to keep in mind:

• You can add analyses from the catalog to an infolet, but not Analytics Publisher reports, or other objects like
filters or prompts.

• To create or edit infolets, you must first either create and activate a sandbox, or activate an existing one. But
make sure the sandbox has the Page Composer tool selected. If you want to make changes in a context layer
that isn't the default layer, Site, you must create a separate sandbox just to use Page Composer in it. You can
then change the context layer from Site to the other layer. For example, to create or edit infolets for a user with
a specific job role, you must select the Job Role context layer.

• You can validate your changes in the sandbox in preview mode before you publish it.
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Related Topics
• Configure Infolet Display

• Best Practices for Using Page Composer in Sandboxes

Create Infolets  

Watch video
 

Use infolet pages to create infolets. You can create an infolet, add content to it, and link detailed reports. For some
product-specific infolet pages, you can't create infolets.

1. Activate a sandbox that has the Page Composer tool in it.
2. Open an infolet page.
3. Click your user image or name in the global header, and on the Settings and Actions menu, select Edit Pages.
4. Click the Infolet Repository icon, and select Create Infolet.

Note:  If you can't find the Create Infolet menu item, it means you can't create infolets for this page.

5. Enter a title for the infolet and set its views.

◦ Specify the dimensions for the front view.

◦ Enable or disable the back view.

◦ Enable or disable the expanded view, and specify its dimensions. The dimensions of the front and the
back views must be the same, but the expanded view must be bigger because it displays more details.

6. Click Save and Close. You can now add content to infolets.

Add Content to Infolets
You can add content to the infolet's front, back, or expanded view. You can't add a business intelligence dashboard to an
infolet because a dashboard report is generally bigger than an infolet.

1. Select the infolet's view that you want to add content to.

Note:  To open infolet's back view, click the Back View icon on the bottom right corner of the infolet. And to
open expanded view, click the Expanded View icon on the bottom right corner of the infolet's back view.

2. Click Add Content on the infolet. You can find this button on any of the infolet's views, but only if you don't
have any existing content in that view.

3. Search and select a performance tile or a task flow, and click Add. You can browse the business intelligence (BI)
catalog to find the analytics and reports that you want to add.

4. Close the Add Content dialog box. You can now add detailed reports to the infolet.

Link Detailed Reports to Infolets
To provide detailed information about a subject matter on an infolet, you can add a link to a detailed report. After you
add the link, your users can click anywhere in the infolet area to drill down to that detailed report. The detailed report
doesn't replace the existing infolet content.
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First, add a performance tile report to the infolet content, and then follow these steps:

1. Click the Actions icon on the top right corner of the infolet, and select Link Detailed Report.
2. On the Detailed Report page, click Add Content.
3. Search and select a report, and click Add to add it to the infolet.
4. Close the Add Content dialog box.
5. Click Done. You can now publish the sandbox.

Publish the Sandbox

1. Preview the infolet's front view, drill down to the detailed report, and then preview the back and the expanded
views.

2. After you made changes, click Close to leave Page Composer.
3. Test your changes and publish the sandbox to make the new infolet available to your users.

Related Topics
• Why don't I see infolets in the Analytics section of the home page?

• Overview of Sandboxes

• Create and Activate Sandboxes

• Best Practices for Using Page Composer in Sandboxes

• Why can't I see application changes made in previously published sandboxes in my current sandbox?

Edit and Delete Infolets  
On the infolet page, use the options available on each infolet to edit infolet content and delete infolets.

1. Activate a sandbox that has the Page Composer tool in it.
2. Open an infolet page.
3. Click your user image or name in the global header, and on the Settings and Actions menu, select Edit Pages.

Note:  After you're done making changes, click Close to leave Page Composer, test your changes, and publish
the sandbox.

Edit Infolet Content

1. Click the Actions icon on the top right corner of the infolet, and select Edit Content.

Note:  To edit the infolet content of the back or expanded view, open the view and use the Actions icon on
that view.

2. Click Add Content to replace the existing content of the infolet.
3. Search and select a performance tile or a task flow, and click Add. You can browse the business intelligence (BI)

catalog to find the analytics and reports that you want to add.
4. Close the Add Content dialog box.
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Edit Title and Views
To edit title and views of an infolet, click the Actions icon on the top right corner of the infolet, and select Edit Title and
Views.

Edit or Remove Detailed Report
You can edit or remove the detailed report.

1. Click the Actions icon on the top right corner of the infolet, and select Edit Detailed Report.
2. On the Detailed Report page, you can edit or remove the detailed report.

◦ To edit, click Edit Report and make changes to the detailed report.

◦ To remove, click Remove Report.

3. Click Done.

Edit Infolet Visibility
You can show or hide an infolet on the infolet page. To edit the visibility settings of an infolet, do these steps:

1. Click the Actions icon on the top right corner of the infolet, and select Edit Visibility.
2. Select one of these options:

◦ Yes: The infolet appears on the infolet page.

◦ No: The infolet doesn't appear on the infolet page.

◦ EL Expression: The evaluation of the EL expression decides whether the infolet appears on the infolet
page.

Delete Infolets
To delete an infolet, click the Actions icon on the top right corner of the infolet, and select Delete.

CAUTION:  You can't easily retrieve an infolet once you delete it. But if you have accidentally deleted any infolet, don't
worry. Contact My Oracle Support at https://support.oracle.com.

Related Topics
• Overview of Sandboxes

• Create and Activate Sandboxes

Examples of EL Expressions  
You can use EL expressions to configure the visibility settings of various elements like groups, page entries, infolets, or
announcements on the UI for users with specific roles.

For example, you can use EL expressions to show or hide a group or page entry on the Navigator and the home page, or
show or hide an infolet or an announcement on the home page. The evaluation of the EL expression decides whether
these elements are displayed for users with specific roles.
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Scenario
This table shows examples of how you can use EL Expressions to show or hide specific UI elements for specific users.

Who can see the group or page entries EL Expression and Example

Only users having any of the specific roles
 

#{securityContext.userInRole['<Role_Name>']}
 
#{securityContext.userInRole['CUSTOM_FND_APPLICATION_ADMINISTRATOR_JOB,
CUSTOM_SVC_INTERNAL_HELP_DESK_MANAGER_JOB']}
 

Only users not having any of the specific
roles
 

#{!(securityContext.userInRole['<Role_Name>']}
 
#{!(securityContext.userInRole['CUSTOM_FND_APPLICATION_ADMINISTRATOR_JOB,
CUSTOM_SVC_INTERNAL_HELP_DESK_MANAGER_JOB'])}
 

Only users having all of the specific roles
 

#{securityContext.userInAllRoles['<Role_Name>']}
 
#{securityContext.userInAllRoles['CUSTOM_FND_APPLICATION_ADMINISTRATOR_JOB,
CUSTOM_SVC_INTERNAL_HELP_DESK_MANAGER_JOB']}
 

Only users not having all of the specific
roles
 

#{!(securityContext.userInAllRoles['<Role_Name>']}
 
#{!(securityContext.userInAllRoles['CUSTOM_FND_APPLICATION_ADMINISTRATOR_JOB,
CUSTOM_SVC_INTERNAL_HELP_DESK_MANAGER_JOB'])}
 

Here are a few things to keep in mind when you use EL expressions.

• Use an EL expression that can be evaluated from any page because the Navigator is used on all pages. So, don't
use product-specific EL expressions.

• Don't include spaces or double quotes in EL expressions.

• Don't copy EL expressions from a word document and paste directly in the expression editor. Doing so might
introduce hidden characters in your EL expression, causing formatting issues and unexpected action. Instead,
use a text editor or manually type the EL expression in the editor.

Related Topics
• Configure the Navigator and Page Entries on the Home Page for Navigation

• Create Roles in the Security Console

FAQs for Infolets  

Why don't I see infolets in the Analytics section of the home page?
 
That's probably because the infolet page is hidden.
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Change the visibility setting of the infolet page using the Home Configuration page of the Structure work area. To open
this page, click Navigator >  Configuration >  Structure, and then click the Home Configuration tab.

Related Topics
• Configure Infolet Display

How can I rename an icon for an infolet page in the page control
on the home page?  
You can rename an icon for an infolet page using the Home Configuration page of the Structure work area. To open this
page, select Configuration >  Structure from the Navigator menu, and then click the Home Configuration tab.

Related Topics
• Configure Infolet Display

What's the difference between a performance tile report and a
detailed report added to the infolets content?  
Performance tile report shows data in the small infolet format. When you add a performance tile report to an infolet,
users can see only the summary information about the subject matter. But this report doesn't provide detailed
information.

To provide detailed information about the subject matter on the same infolet, add a link to a detailed report. Users can
click this link to gather more information.
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6  General Ledger Reports

Considerations for Implementing Financial Reporting
Center  
The Financial Reporting Center adds self-service functionality for the Oracle Fusion Cloud Applications and Oracle
Accounting Hub. The financial reports are available immediately on both computers and mobile devices, which leads to
quicker decision making.

Note:  To access the reports in Financial Reporting Center, store the reports in the My Folder or Shared Custom
directories.

Job Roles and Duty Roles
The following table shows the predefined job roles and their associated duty roles.

Predefined Job Role Duty Roles

General Accountant
 

• Financial Reporting Management

• Account Balances Review

General Accounting Manager
 

• Financial Reporting Management

• Account Balances Review

Financial Analyst
 

• Financial Reporting Management

• Account Balances Review

Business Process Model Information
The features are part of the Manage Financial Reporting and Analysis detailed business process.

The following table shows the activities and tasks for that business process.

Activity Task

Prepare Financial Reports
 

Generate Financial Statements
 

Analyze Financial Performance
 

Inquire and Analyze Balances
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Set Up Financial Reporting Center and Smart View  
The Financial Reporting Center is a powerful tool for reviewing, designing, and presenting financial reports and analytic
data. The critical choices required to configure and install the components in Financial Reporting Center consist of:

• Configuring the Financial Reporting Center

• Installing Smart View, performed by your end users

• Configuring Workspace Database Connection, performed by your administrator

Configuring Financial Reporting Center
You have access to the reports in the Financial Reporting Center and Workspace installed with Oracle Fusion Cloud
Financials. Your Oracle Fusion Business Intelligence (BI) administrator defines the folder structure in Workspace. The
administrator considers your company's security requirements for folders and reports, as well as report distribution
requirements for financial reporting batches.

• Security can be set on folders and reports from Workspace.

• You are granted access to the folders and reports you want to view by your BI administrator.

Installing Smart View
Smart View is an Excel add-in that must be loaded on each client. To download Smart View, click Navigator  > Financial
Reporting Center > Tasks panel drawer > Open Workspace for Financial Reports. Once the workspace is started, click
Tools > Install > Smart View.

Note:  Since Smart View is an add-in to Microsoft Office products, you can install Smart View only on a Windows
operating system.

Once Smart View is installed, you must configure the connection using the Smart View Shared Connections URL. You
can derive the Shared Connections URL by following these steps:

1. From the Financial Reporting Center task panel, select Open Workspace for Financial Reporting.
2. Edit the workspace URL by removing index.jsp and adding SmartViewProviders at the end.

Note:  The following URL is an example for a Cloud-based environment. If the workspace URL is https://
efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/index.jsp, the Shared
Connections URL is https://efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/
SmartViewProviders.

3. Copy the URL.
4. Open Excel.
5. From the Smart View menu, click Options > Advanced.
6. Paste the URL in the Shared Connections URL field.
7. Click OK.

To connect Oracle General Ledger balances cubes in Smart View:

1. Open Smart View from your Start menu > Programs > Microsoft Office > Microsoft Excel 2007.

102



Oracle Fusion Cloud Financials
Creating and Administering Analytics and Reports for
Financials

Chapter 6
General Ledger Reports

2. Navigate to the Smart View menu > Open. On the Start on the ribbon, click Smart View Panel that appears in
the list of values from the ribbon. The task pane opens.

3. Click Shared Connections on the task pane.
4. Sign in with your user name and password.
5. Click the  Select Server to proceed list of values.

Note:  If the Essbase Server isn't there, then it has to be added. Use the following steps:
a. Click the Add Essbase Server link.
b. Specify the Essbase Server login and password.
c. Expand the Essbase server and locate the cube in it.

6. Select Oracle Essbase from the list of shared connections.
7. Click the Expand to expand the list of cubes.
8. Expand your cube (name of your chart of accounts).
9. Click db.

10. Click the analysis link.

Note:  You must perform these steps only once for a new server and database.

To set how the name and alias of the Essbase database appears:

1. Click Options on the ribbon > select the Member Options > select Member Name Display.
2. Set one of these three options:

◦ Distinct Member Name. Only shows the full Essbase distinct path.

◦ Member Name and Alias: Shows both the member name and the alias.

◦ Member Name Only. Shows only the member name.

Note:  The Smart Slice feature isn't supported in General Ledger. For all other documentation, refer to the Oracle
Smart View for Office User's Guide.

Configuring Workspace Database Connections
Administrators must create database connections from Workspace so users can access the cubes from Workspace and
Financial Reporting Web Studio.

Note:  Ledger setup has to be completed before the database connection can be created. General Ledger balances
cubes are created as part of ledger setup. A separate cube is created for each combination of chart of accounts and
accounting calendar. A database connection is needed for each cube.

Steps to define a database connection are:

1. Start at the Navigator by selecting Financial Reporting Center.
2. From the Financial Reporting Center task panel, select Open Workspace for Financial Reporting.
3. From within Workspace select the Navigator menu > Applications >BI Catalog.
4. Select Tools menu > Database Connection Manager.
5. Select New button.
6. Enter a user-friendly name for the Database Connection Name.
7. Enter Essbase as the Type, your server, user name, and password.
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8. Select Application (cube) and Database from the list of values. Expand the Application name to see the
related Database.

9. Click the OK button twice to save your selections.
10. Click Close button in the Database Connection Manager window to save your connection.

Note:  The database connection is available in both Workspace and Financial Reporting Web Studio. Optionally, it
can be set up in Financial Reporting Web Studio when putting grids on a report. This should only be done by an
administrator.

For more detailed information about Smart View and Financial Reporting Web Studio, refer to the Using EPM with
Oracle Fusion Cloud Financials link on the Oracle Financials All Books page of the Oracle Help Center at https://
docs.oracle.com.

Smart View  

Overview of Smart View  
Oracle Hyperion Smart View provides common Word, PowerPoint, and Excel interfaces designed specifically for Oracle
Hyperion Enterprise Performance Management, Oracle Transactional Business Intelligence, and Oracle General Ledger.

Using Smart View, you can view, import, manipulate, distribute, and share data in Excel, Word, and PowerPoint
interfaces. Smart View is a comprehensive tool for accessing and integrating Enterprise Performance Management,
Business Intelligence, and General Ledger content from Microsoft Office products.

Smart View provides the ability to create and refresh spreadsheets to use real-time account balances and activity. You
can use Smart View for:

• Analysis

• Predefined form interaction

• Report design

Analysis
Smart View uses the Excel environment to interactively investigate the data contained in the sources. You start with
templates that begin the process or a blank sheet where you begin shaping and altering the grids of data.

Predefined Form Interaction
Use Smart View to work in the Excel environment either for a consistent experience or to tie other spreadsheet-based
models into your process. For example, use Smart View with Oracle Hyperion Planning to incorporate data that is still
housed in spreadsheet and workbook-based models.

Report Design
Report design is another dimension of Smart View, which uses the capabilities of Oracle General Ledger data. Once
the data is available within Smart View you can create reports as needed based on a combination of data sources. For
example, planning and financial management data can be used to compare actual to budget. Reports can be made
more complex by providing the ability to compare multiple scenarios for different periods. The power of Smart View is
used to create reports and is refreshed periodically, as needed.
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Smart View provides the ability to create and refresh spreadsheets to use real-time account balance information. You
can use Smart View to:

• Perform ad hoc multidimensional pivot analysis with full spreadsheet functionality

• Drill down from any parent value to the next parent or child value

• Perform drill down from any child value to detail balances, journal lines, and subledger transactions

• Analyze actual, budget, and forecast information

• Increase visibility with charts and graphs

• Apply date effective hierarchies to past, present, or future hierarchies to change the financial data reported in
your financial reports. For example, to compare 2014 to 2015 results, realign the data in your 2014 reports by
applying the 2015 organization hierarchy.

Tip:  Best practice when using Smart View is to always turn on row suppression in the Smart View options. You can't
suppress columns in Smart View.  For more information about Smart View suppression, see the Smart View Options
chapter in the Oracle Smart View for Office User's Guide at http://docs.oracle.com/cloud/latest/epm-common/
SVPBC/opt_data.htm#SVPBC-options_202.

For more detailed information about Smart View, refer to the Using EPM with Oracle Fusion Cloud Financials link on the
Oracle Financials All Books page of the Oracle Help Center at https://docs.oracle.com.

Creating an Ad Hoc Analysis in Smart View  
This example shows how to create an ad hoc analysis in Smart View.

Creating an Ad Hoc Analysis
This example includes steps for configuring the Smart View connection, selecting dimension members, creating
separate reports, and formatting amounts.

1. Navigate to the Financial Reporting Center.
2. Open the Tasks panel and click the Open Workspace for Financial Reports task.
3. Remove /index.jsp from the end of the workspace URL and copy the rest of the URL. For example, copy

https://adc-fapXXXX-bi.oracledemos.com, where XXXX is the unique instance ID.
4. Open Excel.
5. Navigate to the Smart View ribbon and click Options.
6. In the Shared Connections URL field on the Advanced tab, replace everything before workspace with the

copied URL. For example, https://adc-fapXXXX-bi.oracledemos.com/workspace/SmartViewProviders
7. Click OK.
8. On the Smart View ribbon, click Panel. The Smart View panel opens.
9. On the Smart View panel, click Shared Connections.

10. Sign in with your user name and password.
11. On the Smart View panel, select the drop-down list for the Select Server to proceed field.
12. Select Oracle@Essbase from the list of shared connections.
13. Expand the list of cubes for Essbase_FA_Cluster.
14. Expand the USChartofAccounts cube.
15. Select db. Don't expand the selection.
16. On the Smart View panel, click Connect, and then click Ad hoc analysis.
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17. On the Essbase ribbon, click POV. The Point of View window enables you to select data dimension values, so
you can pinpoint the information you want for the Excel analysis.

18. On the Point of View window, click the drop-down list for each dimension and select the ellipsis (...) to open the
member selector. On the Member Selection window, remove the default selection for each dimension using
the Remove icon. Select the dimension value and add it using the Add icon. Click OK. Complete the member
selection, as shown in this table.

Field Value

Company
 

[All Company Values].[101]
 

Line of Business
 

10
 

Account
 

11200-Cash
 

Cost Center
 

All Cost Center Values
 

Product
 

All Product Values
 

Intercompany
 

All Intercompany Values
 

Scenario
 

Actual
 

Balance Amount
 

Period Activity
 

Amount Type
 

Period-to-date
 

Currency
 

USD
 

Currency Type
 

Total
 

19. On the worksheet, click the Accounting Period dimension in row 3, column A.
20. Right-click and select Smart View, Member Selection.
21. On the Member Selection window, remove the default selection. Expand the Accounting Period dimension

and add the period 12-16.
22. Click OK.
23. Double-click Ledger in row 2, column B, to zoom in. You can also zoom in by selecting the dimension,

navigating to the Essbase ribbon, and clicking Zoom In
24. Click All Ledgers in row 2, column B, and click Zoom Out on the Essbase ribbon.
25. Right-click Ledger in row 2, column B, and select Smart View, Member Selection.
26. On the Member Selection window, remove the default selection of Ledger.
27. Select US Ledger Set and click the Add icon.
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28. Click OK.
29. On the Point of View window, click Refresh.
30. Double-click US Ledger Set in row 2, column B, to zoom in.
31. Click the [US Ledger Set].[US Primary Ledger] cell.
32. On the Essbase ribbon, click Keep Only to remove the other Ledger members and keep only the selected

member.
33. To create a separate report based on the Company dimension, on the Essbase ribbon, click Cascade and select

Same Workbook. The Member Selection window opens.
34. On the Member Selection window, select [All Company Values].[102] and click the Add icon.
35. Click OK. A worksheet opens for company 102.
36. Click the All Company Values.101 worksheet.
37. Click the amount cell in row 3, column B.
38. Navigate to the Home ribbon and set the Accounting Number Format option to the dollar sign.
39. Navigate to the Essbase ribbon and click Preserve Format.
40. On the Point of View window, click Refresh.

Define a Report in Smart View with the Query Designer  
This example shows how to define a report using the Query Designer in Smart View.

Defining a Report with the Query Designer
1. Open Excel and navigate to the Smart View ribbon. Click Panel.
2. Click Shared Connections.
3. Sign in with your user name and password.
4. Click the Select Server to proceed drop-down list.
5. Select Oracle Essbase.
6. Expand the Essbase_FA_Cluster  and expand USChartofAccounts.
7. Highlight db. Don't expand db.
8. Click Connect.
9. Click the analysis link.

10. Navigate to the Essbase ribbon and click Point of View.
11. In the spreadsheet, click cell A2.
12. On the Essbase ribbon, click Query and select Query Designer. A new sheet named, Sheet1-Query is created

and the Query Designer displays.
13. On the Point of View panel, move:

a. Account to the Rows section.
b. Accounting Period to the Columns section.
c. Ledger to the Point of View section.
d. Company to the Rows section, as the first dimension.

Note:  You can also select the dimensions cells on the worksheet and use the Pivot command on the Essbase
ribbon to perform these steps.

14. Open the Amount Type dimension by clicking the drop-down list and selecting the Member Selection link.
Remove the default placeholder using the Remove icon. Select the period-to-date value and add it to the panel
of selected values using the Add icon.

15. On the Member Selection window, click the drop-down list next to the Amount Type dimension to toggle to
each Point of View dimension. Complete the fields, as shown in this table.
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Field Value

Ledger
 

US Ledger Set > [US Ledger Set].[Us Primary Ledger]
 

Line of Business
 

All Line of Business Values
 

Cost Center
 

All Cost Center Values
 

Product
 

All Product Values
 

Intercompany
 

All Intercompany Values
 

Scenario
 

Actual
 

Balance Amount
 

Period Activity
 

Currency
 

USD
 

Currency Type
 

Total
 

16. From the POV Sheet1-Query_1 panel, click AccountingPeriod to open the Member Selection window. You can
also open the Member Selection window from the worksheet by right-clicking the AccountingPeriod cell, and
selecting Smart View, Member Selection.

17. Remove the default selection. Expand 2016. Select all four quarters and add the quarters to the selected panel.
18. Click OK.

Note:  The four quarters become separate columns on the worksheet.

19. Click the Company dimension.
20. Expand All Company Values.
21. Select [All Company Values].[101] and [Company]@[941] and add them. Remove the default value.
22. Click OK.
23. On the POV Sheet1-Query_1 panel, click Account in the Rows section.
24. Expand All Corporate Accounts-V1 > Account@[T] > 95001 - Net Income Current Year.
25. Expand 95011-Revenue and 95021-Expenses.
26. Remove the default value. Select the following values and add them to the selected panel:

◦ 95011-Revenue

◦ 40000-Revenues

◦ 95021-Expenses

◦ 50000-Material and Goods
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◦ 60000-Operating Expenses

◦ 70000-Extra Charges and Tax

27. Click OK.
28. On the POV Sheet1-Query_1 panel, click Apply Query.
29. Save your report to the desktop as your initials Smart View Financial Report.
30. Insert 7 rows at the beginning of the spreadsheet.
31. Click in cell A3. Click the Insert tab and select Picture.
32. Select WINNT (D) > Labs > Fin_reporting > Vision Logo.
33. Click Refresh.

Note:  You must refresh periodically to maintain the connection to the database.

34. From the Insert tab, click Text Box.
35. Click cell C4 and type your initials Income Statement for Companies 101 and 941. Use excel formatting to

format the text however you want.
36. Click Refresh.
37. Click Save.
38. Highlight all the cells that contain amounts.
39. Navigate to the Home ribbon, and from the Number section, select dollar sign.
40. On the Home ribbon, in the Cells section, select Format > AutoFit Column Width.
41. Navigate to the Essbase ribbon and select Preserve Format.
42. Click Refresh.
43. Click Save.
44. Insert three rows between the data for company 101 and 941.
45. On the first new blank row in Column B, type Total Income.
46. Add the following formula for the first column with data Qtr1-14: =C10+C15 where C10 is 95001-Revenue and

C15 is 95021-Expenses.
47. Copy and paste that formula to the other columns.
48. Do the same formula for totals of Company 941.
49. Format all the total cells as Accounting. On the Essbase ribbon, select Preserve Format.
50. Click Save.
51. Insert 10 more rows between the data for Company 101 and 941.
52. Highlight all four rows of the expense data for all four quarters, including Material and Goods.
53. Navigate to the Insert ribbon and select the Line chart from the Chart section.
54. Select the first 2-D Line chart layout.
55. On the line chart, click the Legend that reads Series1, Series2, Series3, and Series4.
56. From the Chart Tools ribbon, select Select Data.
57. In the Legend Entries (Series) pane, select Series2 and click Remove. Series2 is a total of expenses and not

appropriate for this chart.
58. In the Legend Entries (Series) pane, select each series individually and click Edit. Complete the series and

names fields, as shown in this table.

Series Name

Series1
 

Material and Goods
 

Series3
 

Operating Expenses
 

Series4 Extra Charges and Tax
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Series Name

  

59. In the Horizontal (Category) Axis Labels panel click the first one and click Edit.
60. Click the icon next to the Axis label range: field.
61. On the spreadsheet, highlight the four quarter headers and click the icon next to the Axis Labels field.
62. Click OK twice.
63. Move and resize the line chart to fit inside the blank lines.
64. Click Save.
65. Navigate to: Financial Reporting Center > Tasks panel tab > Open Workspace for Financial Reports.
66. Click Navigate > Applications > BI Catalog.
67. Expand Shared Folders > Custom > highlight Financial Reports.
68. From the Tasks panel, select Upload.
69. Click Browse and from your Desktop, select your Smart View Financial Report.
70. Click Open.
71. Click OK.
72. Close the EPM Workspace tab.
73. From the Financial Reporting Center, click the Search icon.
74. Enter Smart and click Search.

Note:  Your report may not be found immediately. Wait a few minutes and try again.

Create a Financial Report  

Define a Basic Financial Report Using the Reporting Web Studio  
This is the first of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

You can use Financial Reporting Web Studio to design traditional financial report formats such as balance sheets, profit
and loss statements, and cash flow reports. You can also design nontraditional reports for financial or analytic data that
include text and graphics.

In this example, you're designing a basic financial report.

1. From the Financial Reporting Center work area, select the Tasks panel tab and click Open Workspace for
Financial Reports.

2. On the Tools menu, select Launch Financial Reporting Web Studio.
3. On the File menu, select New, Report.
4. On the toolbar, click the Grid icon. Grids are tables that contain data from external database connections.
5. In the design canvas, draw a box to create the grid. The Database Connection Properties dialog box opens.

Tip:  When creating a grid, best practice is to leave space in the design canvas for other objects, such as a
company logo and report title.
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6. Select the Data Sources list and select the data source for the chart of accounts that the report is based on. A
unique cube exists for each combination of chart of accounts and accounting calendar.

Tip:  Best practice is to always turn on suppression in financial reports at the Database Connection Server
level. You can verify the setting by highlighting the grid, and then selecting Data Query Optimization
Settings on the Task menu. For most reports, best practice is to turn on suppression for the entire grid. Then
turn suppression off for columns and rows that must always display. For more information about suppression
settings, refer to the Defining Basic Conditional Suppression section in the Financial Reporting Web Studio
User's guide.

7. Click OK. The Dimension Layout dialog box opens.

Arrange the Dimensions
Use the Dimension Layout dialog box to arrange the dimensions on your report. For this report, the accounting periods
display on the columns and the revenue and expense account information displays on the rows. The company appears
on each page and can be selected at runtime.

1. Drag the Accounting Period dimension to the Columns axis.
2. Drag the Account dimension to the Rows axis.
3. Drag the Company dimension to the Page axis.
4. Click OK to close the Dimension Layout dialog box.

Define the Rows
Use the Select Members dialog box to define the revenue and expense account rows.

1. Select the revenue parent account.

a. Double-click the Account cell. The Select Members dialog box opens with a default member selected.
b. Remove the default Account selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
c. In the Search field, enter the value for the account that represents total revenue and click the Search

icon.
d. Select the account from the search results and click OK. The account moves to the Selected area.
e. Click OK. The Select Members dialog box closes.

2. Now insert a text row to add space between the revenue and expense accounts.

a. Select the last row in the grid by clicking the row header.
b. On the Insert menu, select Row, then Text.

3. Insert a row for the expense accounts.

a. Right-click the last row header.
b. On the Insert Row menu, select Data. Notice the default value for the new row is the revenue parent

account.
4. Select the expense parent accounts.

a. Double-click the account value in the new expense account row. The Select Members dialog box opens
with the revenue parent account selected.

b. Remove the revenue parent account selection from the Selected area by clicking to select it and then
clicking the Remove from Selected icon.

c. In the Available area, expand the Account member, and continue expanding until you find the expense
parent accounts for the report.
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d. Select the accounts and click the Add to Selected icon to move them to the Selected area.
e. Select the Place selections into separate rows option so each account appears in its own row on the

report.
f. Click OK. The Select Members dialog box closes.

Save and Preview the Report
Save the report and leave it open for the next topic, which is adding a formula to a financial report.

1. Click the Save icon.
2. Select the folder with your name and enter the report name and description.
3. Click Save.
4. Optionally preview the report in HTML or PDF format using the File menu or toolbar.

Add Formulas to a Financial Reporting Report  
This is the second of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you define a formula to summarize the expense account balances on your financial report.

Before you start, do the steps described in the Define a Basic Financial Report Using the Reporting Web Studio topic,
then follow these steps.

1. Right-click the last row header, select Insert Row and select Formula.
2. Click in the empty cell in the new row.
3. In the Heading Row Properties pane, select the Custom Heading option, enter Total Expenses and click the

Update icon. The new heading appears in the report.
4. Select the row header for the formula row. The SUM function appears in the design canvas.
5. In the Formula bar, click the Sum(0) button and enter the formula and cell references in the formula text box.

Because the expense rows appear one after the other, you can use the first row number and the last row
number with a colon in between. For example, Sum([3:5]). If the rows weren't contiguous, you could put
brackets around each row number and separate them with commas. For example, Sum([3], [5], [6]).

6. Validate the formula syntax by clicking the check mark icon in the toolbar. Validation checks the validity of the
formula, not if the data is available.

7. Save the report and leave it open for the next topic, which is defining a range function. Optionally preview the
report.

Define Range Functions for a Financial Reporting Report  
This is the third of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you define a range function to report across multiple accounting periods. You configure the range to
present balances for the last 12 months from the period selected at runtime.
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Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report

Now follow these steps.

1. Double-click the Accounting Period cell. The Select Members dialog box opens.
2. Remove the default accounting period from the Selected area by clicking it to select it and then clicking the

Remove from Selected icon.
3. Click the Functions tab.
4. Select Range from the list.
5. Click the Add to Selected icon. The Range dialog box opens.
6. Define the starting member for the range.

a. On the Start Member row, click the Lookup Selection icon in the Value column.
b. Click the Functions tab.
c. Select the Relative Member function to define the periods that display on the report relative to the

period specified at runtime.
d. Click OK. The Relative Member dialog box opens.
e. On the Member row, click the Lookup Selection icon in the Value column.
f. Select Current Point of View for Accounting Period so you can enter the starting period for the report.

g. Click OK.
h. On the Offset row, enter -11 in the Value field.

The offset determines the first period of the range. The starting period in the range function is always
the oldest period. Because this is a rolling 12 period report, enter -11 to include the 11 periods prior to the
period you enter at runtime. The member selection for the End Member parameter determines period 12.

i. Click OK.
7. Define the ending member for the range.

a. On the End Member row, click the Lookup Selection icon in the Value column.
b. Select Current Point of View for Accounting Period.
c. Click OK.
d. Click OK to close the Range dialog box.
e. Click OK to close the Select Members dialog box.

8. Save the report and leave it open for the next topic, which is defining a grid point of view. Optionally preview
the report.

Set User and Grid Points of View for a Financial Reporting Report  
This is the fourth of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you set a user point of view and a grid point of view for a financial report.

All financial reporting reports have a user point of view and a grid point of view. Best practice is to use a combination of
both.
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If you want users to select certain dimension members at runtime, then those dimensions should be set in the
user point of view. Selections for user point of view members are global for a user and data source. This means the
application saves and applies them to any other report that has the same dimensions set to the user point of view. By
default, all dimensions are set to the user point of view and must be selected at runtime. If you want your report to
always use certain dimension selections, then select the specific members in the grid point of view.

Note:  Members of a grid point of view only display in HTML.

In this example you set the Ledger, Scenario, Balance Amount and Currency dimensions to use the grid point of view.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report

Now follow these steps.

1. Select the cell in the grid that represents the intersection of the rows and columns. The Grid Properties pane
opens.

2. In the Grid Properties pane, click the Grid Point of View check box.
3. In the design canvas, click the Ledger: User Point of View for Ledger button. The Select Members dialog box

opens.
4. Expand the Ledger member and continue to expand until you find the ledger to include on the report. Select

the ledger.
5. Click Apply Selection.
6. Select Scenario from the Dimension list to select the type of balance to use on the report.
7. Expand the Scenario member and select Actual.
8. Click Apply Selection.
9. Select Balance Amount  from the Dimension list.

10. Expand the Balance Amount member and select Period Activity.
11. Click Apply Selection.
12. Select Currency from the Dimension list.
13. Search for USD.
14. Click OK to accept the search result.
15. Click Apply Selection.
16. Click OK to close the Select Members dialog box.
17. Save the report and leave it open for the next topic, which is setting page and grid properties. Optionally,

preview the report.

Work with Grid Point of View Setup and Page Axis for a Financial
Reporting Report  
This is the fifth of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you change the grid point of view setup and set the page member selection to a prompt on your
financial report.
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Before you start, do the tasks described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report
4. Set User and Grid Points of View for a Financial Reporting Report

Now follow these steps.

1. Click the first cell in the grid to select all of the rows and columns.
2. Right-click and select Grid Point of View Setup from the list. The Setup Grid Point of View dialog box opens.

a. To prevent the Balance Amount dimension from being changed at runtime, select the Lock Member
Selection option.

b. Click OK. The Setup Grid Point of View window closes.
3. In the Grid Properties pane:

a. Click the Drill Through option to allow drilling from the report to the General Ledger transaction data.
b. Click the Suppression section to view the suppression settings.
c. Enter 0 in the Zero Values field to set the text option for rows with zero values. If necessary, you could

also suppress the display of rows with zero values, rows with missing data, and rows with errors.
4. Set a runtime prompt for the Company dimension so you have the flexibility of selecting any company or

combination of companies at runtime. In this example, you want to restrict the valid list of companies that can
be selected at runtime.

a. On the grid, click the Pages label. The Company dimension appears in the design canvas.
b. Click the Company button. The Select Members dialog box opens.
c. Remove the default Company selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
d. Select Prompt for Company.
e. Click the Add to Selected icon to move the selection to the Selected area.
f. Click OK. The Define Prompts dialog box opens.

g. Click the Lookup icon in the Choices List field. The Select Members dialog box opens.
h. Remove the default Company selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
i. Expand the Company member, and continue expanding until you find and select the default companies

you want to display in the prompt.
j. Click the Add to Selected icon to move the companies to the Selected area.

k. Click OK. The Select Members window closes.
l. On the Define Prompts dialog box, click in the Member Name field and select Alias. The actual company

label displays in the prompt list of values instead of a numeric company value, making the prompt more
user-friendly.

m. Click OK. The Define Prompts window closes.
5. Click the Pages label on the grid. The Page Properties pane opens.

a. In the Page Properties pane, select the Alias: Default option so each page of the report shows the name
of the company instead of the number.
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6. Select the four data rows in the grid so all of the rows have the same settings.

a. In the Heading Row Properties pane, select the Alias: Default option in the Heading Row Properties pane
to display the revenue and expense account names instead of the accounts.

b. In the Heading Row Properties pane, select the Allow Expansion option so you can expand the parent
account values to view the detail child values.

7. Save the report and leave it open for the next topic, which is formatting your financial report and adding a
graph. Optionally, preview the report.

Add Formats and Graphs to a Financial Reporting Report  
This is the sixth and final topic in a series of topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you add formats and graphs to a financial report.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report
4. Set User and Grid Points of View for a Financial Reporting Report
5. Work with Grid Point of View Setup and Page Axis for a Financial Reporting Report

Now follow these steps.

1. In the report object browser, select the name of the report, which is the first object.
2. Add a logo.

a. In the report layout, drag the header line to make space for the logo and title.
b. In the Header section, click the Add Report Object icon and select Image.
c. In the Image Properties pane, click Browse and select your company logo.

3. Add a title.

a. Select the name of the report in the report object browser.
b. In the Header section, click the Add Report Object and select Text. As an alternative, you can click the

Text icon in the toolbar and draw the text box. The text box opens.
c. Enter the report title.
d. Select the title text and use the format toolbar to adjust the font size, center the text, and change the font

style to bold.
4. Change the page orientation.

a. Select the name of the report in the report object browser.
b. On the File, menu, select Page Setup.
c. In the Page Setup dialog box, select the Landscape option.
d. Click OK.

5. Add a chart.

a. In the Body section, click the Add Report Object icon and select Chart.
b. In the Chart Properties pane, select the Line chart type.
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c. To show only the expense account rows, deselect row 1, and select rows 3, 4, and 5 in the Data Range
section.

d. Click the Format Chart button. The Format Chart dialog box opens.
e. In the Appearance tab, enter the title for the chart. For example, Expenses by Period.
f. Click the Legend tab and enter a title for the legend. For example, Type of Expenses.

g. Click the Axes tab and enter a title for the Metadata axis. For example, Period. Enter a title for the
Primary Axis. For example, Dollars.

h. Click the Refresh Chart button to preview the chart on the Format Chart dialog box.
i. Click OK. The Format Chart dialog box closes.

6. Save the report and optionally, preview it.
For more information about Financial Reporting Web Studio, select the Using EPM with Oracle Financials Cloud link
from the All Books for Oracle Financials Cloud page of the Oracle Help Center at https://docs.oracle.com.

Configure an Account Group  
Configuration of an account group enables you to create self-monitoring accounts that help you eliminate the surprise
of account anomalies during your close process.

Scenario
You have been given the task to set up account groups. Follow these steps to define account groups that track key
account balances by purpose, category, and comparison criteria.

1. Navigate to the General Accounting Dashboard page.
2. In the Account Monitor section, select View > Account Group > Create. Other Account Group options include:

◦ Manage to create, edit, or delete account groups. You can also enable sharing of account groups with
other users.

◦ Edit to change an existing account group or to make a copy of an existing account group to which you
have access, whether it's an account group that you own, that's shared with you, or that's public. You're
marked as the owner of the copied account group, which is automatically set to private access, but can be
changed to the access setting that you like.

3. Enter the account group name and description. The name is used by default on the infolet that the account
group displays in, but can be changed using the infolet Actions menu.

4. Select a value for the Display In option to determine if the account group appears in one of the infolets
(Allocations, Expenses, Revenues), the Account Monitor, or the Close Monitor. The display option that
you select can affect the other account group settings. For example, account groups that display in the
Close Monitor must have public access, and account groups that display in infolets must have the option to
dynamically derive the ledger enabled.

Note:  Regardless of its display setting, any account group can be viewed from within the Account Monitor
and Financial Reporting Center.
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5. For each infolet and Account Monitor display setting, you can specify a default account group by selecting the
Set as default option. The default account group setting is user-specific, determining which account groups
appear to you when you view the infolets and the Account Monitor.

Note:  The default setting doesn't affect account groups that are set to display in the Close Monitor. The
account group that displays in the Close Monitor is determined by the ledger set definition.

6. Select the Dynamically derive ledger option to apply the account group to any ledger in the same balances
cube. The ledger derived is based on your given data access set selection. You must enable this option for
account groups that display in the Revenues, Expenses, and Allocations infolets.

Note:  If you don't select this option, enter a ledger on each account row.

7. Select a Time Option and Comparison Option as shown in the following table.

Time Option Comparison Option

Accounting Period
 

◦ Budget PTD

◦ Budget QTD

◦ Budget YTD

◦ Prior period PTD

◦ Prior year PTD

◦ Prior year QTD

◦ Prior year YTD

Quarter
 

◦ Budget QTD

◦ Budget YTD

◦ Prior quarter QTD

◦ Prior year QTD

◦ Prior year YTD

Year
 

◦ Budget YTD

◦ Prior year YTD

Tip:  If you're using a budget comparison option, select the budget name in the Scenario field.
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8. Set the access.

Note:  Regardless of the access setting, only the person who owns the account group can modify it. However,
for account groups that you have access to, you can share with others even if you're not the owner.

◦ Private: For your use only.

◦ Public: For use by all users who have access to the same balance cube of that account group. Account
groups that display in the Close Monitor must be set to Public.

◦ Shared: For use by users you specify and who have access to the same balance cube of that account
group.

Note:  To set shared access, navigate to the Manage Account Group page.

9. In the Accounts section, enter the accounts to monitor. The accounts must be defined to be consistent with the
particular infolets targeted to track revenues, expenses, or allocations pools.

◦ Accounts included in an account group for display in the Expenses infolet must be of the account type
Expense.

◦ Accounts included in an account group for display in the Revenues infolet must be of the account type
Revenue.

◦ Close Monitor account groups must only have two account rows. The first row must represent total
revenues and the second row must represent total expenses.

a. Give each account a short name that's easily recognizable. The name displays in infolets and in the Name
column of the Account Monitor. For account groups that display in infolets, you must provide a name for
each account.

b. If the Dynamically Derive Ledger option isn't enabled, you must enter a ledger.
c. Enter either parent or child values for each segment of the account.
d. Select when to display the account in the Change field.

- Always Display
- Decrease by Less than Amount
- Decrease by Less than Percentage
- Decrease by More than Amount
- Increase by More than Amount
- Increase by Less than Amount
- Increase by Less than Percentage
- Increase by More than Percentage
- Decrease by More than Percentage
- Not Equal
- Equal

e. Enter a value in the Threshold field, which is the criteria that's being measured against. The threshold is
used in conjunction with the Change field selection.

10. Click Save and Close or Save and Create Another.

Related Topics
• Account Groups
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FAQs  

How can I apply permissions to objects from Financial Reporting in
Workspace?  
Open the Permission dialog box from the Tasks list to set permissions for a catalog object.

Permissions determine which user, group, or role can view, open, or modify the object. If you display this dialog box
while working in the catalog in Workspace, any permission changes that you specify are applied immediately. If you
display this dialog box as part of the Batch Scheduler wizard, then the permission changes aren't applied until you run
the batch.

How can I store and edit Financial Reporting objects?  
First install Oracle Transactional Business Intelligence as part of Oracle Fusion Cloud Applications. Then store and edit
new objects that you create for Oracle Hyperion Financial Reporting in Workspace in the Oracle BI Presentation Catalog.

Perform operations on those objects in the catalog similarly to how you work with other objects, such as copying and
modifying properties. See the documentation for Hyperion Financial Reporting for complete information on working
with objects. Financial Reporting report designers can also access the Financial Reporting objects in the Financial
Reporting Web Studio.

How can I migrate Financial Reports from one environment to
another?  
You can export your financial reports from a source environment and import them to a target environment using
implementation projects.

Only the financial reports in the /shared/Custom/Financials folder are exported, so make sure to copy all the
financial reports, or the folders containing them, to this folder. In the Setup and Maintenance work area, create an
implementation project that includes only the Create Financial Statements task. Then use the Manage Configuration
Packages task to export and import the reports.

Note:  For the Financial Reporting report definition migration service, from a source to a target environment,
references to version IDs of dimension members hierarchies are synced to their version IDs in the target environment.
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Related Topics
• How You Use Implementation Projects to Manage Setup

• Setup Data Export and Import Using Implementation Project

• Export Setup Data Using Implementation Project

• Import Setup Data Using Implementation Project
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